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Introduction

What is WIRES-X?

WIRES (Wide-coverage Internet Repeater Enhancement System) is an Internet communication system which expands the range of
amateur radio communication.

WIRES-X uses local nodes (stations connected to the Internet via PCs) as access points to relay communications of conventional
amateur radio stations. Mobile stations using WIRES-X can communicate with amateur stations all over the world by using a local
node operating within an amateur band.

WIRES-X supports the new C4FM digital communications mode, enabling C4FM digital signals to be repeated without deterioration
of the communication quality. In addition, several new functions making use of digital formats are also made available.
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® Features

» Supports C4FM digital communications

» Adopted the user ID system using alphanumeric characters

+ Supports user ID search and connection functions using the digital communication system

+ Stores and reads digital data such as text, images and audio data (News function)

+ Allows establishing a dedicated channel to search a local node (Preset-search-channel function)

» Repeats signals from stations operating in the GM (Group Monitoring) function

» Supports FM analog communications similar to WIRES-II (access with a DTMF command)

» Allows communications between C4FM digital stations and FM analog stations via WIRES-X

» More useful and additional functions when compared to WIRES-II:
The connection kit (HRI-200) and your PC can be connected with a USB cable. Power the device from the PC through the USB
connection. Installation is completed in a few simple steps.
The connection kit (HRI-200) has a built-in USB audio device that optimizes the analog audio level and sound quality.
The kit is equipped with the port check function to verify the Internet connection status, i.e. port opening status.

Caution

Since the WIRES-X and the WIRES-II are different network systems, connections or communications are not possible between these two systems.
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What is WIRES-X?

J| How WIRES-X works
The WIRES-X system is composed of the following components:

* WIRES-X server
YAESU manages and operates the WIRES-X server for Internet connection of the WIRES-X system and for managing users
(nodes).
* WIRES-X nodes
This refers to stations which serve as access points and are connected to the Internet through use of a PC and a WIRES-X
connection kit.
The customer selects and sets up either a C4FM digital operating station or an FM analog operating station.
A node also enables the user to open and operate a communication space (room) that can connect simultaneously with
multiple nodes.
Also, if a digital transceiver is used, the users can utilize a data exchange feature (News function) with both nodes and rooms.
+ Station (mobile or fixed)
Stations may accesses a local node within communication range and establish contacts with stations worldwide via WIRES-X
nodes on the Internet.
» Adigital transceiver compatible with WIRES-X is required in order to access a C4FM digital operating node station.
* A FM analog transceiver capable of transmitting DTMF signals is required in order to access an analog FM operating node
station.

W4 Internet connection \ // node 5 v
// Local node ‘ PC PC Local node
\
HRI-200 D gz@ HRI-200
s server LI\, ‘_@ l

\ M
Local
node

Local _ Local

node -------- node

WA =see— = N

As long as local nodes
connect to the Internet, stations
can communicate each other
when stations connect to a
local node

With the WIRES-X system, voice communication is carried out in the following manner:

Set up an amateur radio station and WIRES-X node

Use a mobile or fixed station to search for a node station

The mobile or fixed station indicates a connectable destination on the Internet and establishes a connection
The mobile or fixed station transmits an audio voice signal

The WIRES-X node receives the transmission and repeats it to the connected destination node

The connected destination node transmits the repeated data by means of the amateur radio transceiver

The mobile or fixed station receiving on the channel of the connected destination node station, receives the data

NOoO AL, WN-=-
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What is WIRES-X?

Opening a WIRES-X node station

J] Establishing a WIRES-X node station
Obtain the following:

® Transceiver

Caution

Update to the latest software and firmware on YAESU website.

» To set up a C4FM digital node station
C4FM digital transceiver (FTM-500DR/DE, FTM-400XDR/XDE/DR/DE, FTM-300DR/DE, FTM-200DR/DE or FTM-100DR/DE
(as of Apr 2023)) with a 10 Pin Mini DIN DATA jack

» To set up an FM analog node station
Either a transceiver with a 10 Pin Mini DIN DATA jack (use of a FTM-500DR/DE, FTM-400XDR/XDE/DR/DE, FTM-300DR/DE,
FTM-200DR/DE, FTM-100DR/DE or FTM-6000R/E is recommended (as of Apr 2023)), or an FM analog transceiver with a 6 Pin
(8 Pin) Mini DIN DATA jack

 Station-related components such as an antenna, power source, etc

e PC
» OS: Microsoft Windows 8.1/ 10/ 11
» Processor Clock Frequency: 2.0GHz or faster
» HDD: 1 GB or more of available space
* RAM: 2 GB or more
» USB port: Full-speed USB
+ Display resolution: 1366 x 768 or higher
16-bit high color or higher (32-bit true color is recommended)
* LAN port: 100BASE-TX/1000BASE-T

® [nternet connection
+ ADSL 8 Mbps or faster (high-speed connection recommended)
* Global IP address (dynamic or static address usable)
A unique IP address is necessary for each WIRES node
 All of the following 6 UDP (user datagram protocol) ports must be connectable:
46100, 46110, 46112, 46114, 46120 and 46122
* When using a router: a network address and port translation (NAPT) is necessary
» One of the TCP ports must be connectable (when using the remote control function)
* When using a router: a network address and port translation (NAPT) is necessary

Cautions
@® \When running a firewall on your router, it is necessary to open the above ports to allow communication with the WIRES-X server.
® When using an Internet connection for multiple concurrent applications, you may experience audio interruptions or an unstable connection with WIRES-X.

® WIRES-X connection kit
This product

I Opening and running a WIRES-X node station

Perform the following procedures.

® Register the node with the WIRES-X server (apply to obtain an ID number)
Register the WIRES-X node with YAESU. Once registration is completed, you will be issued an ID number from YAESU. For details,
refer to page 9.

©® WIRES-X software installation
Use the supplied CD-R to install the software onto your PC. For details, refer to page 10.



Introduction

About WIRES-X Connection Kit

Before use

The WIRES-X software can be used only by the purchaser under the end-user license agreement.
Specifications, functions, contents and information of this manual are subject to change without notice.

WIRES™ is a trademark of YAESU MUSEN.

Microsoft® and Windows® are either registered trademarks or trademarks of Microsoft Corporation in the United States and/or other
countries.

All other product and company names mentioned in this manual are trademarks or registered trademarks of their respective holders.

Caution
WIRES-X software is protected by copyright law and international copyright treaties. Unauthorized reproduction or distribution of this software and this
manual, whether full or partial, is strictly prohibited.

Safety precautions (make sure to read these)

Note beforehand that the company shall not be liable for any damages suffered by the customer or any third parties in using this
product, or for any failures and faults that occur during the use or misuse of this product, unless otherwise provided for under the
law.

Type and meaning of the marks

A DANGER This symbol indicates the possibility of death or serious injury being inflicted on the user and the
surrounding people when these instructions are ignored and the product is mishandled.

é WARNING This symbol indicates the possibility of death or serious injury being inflicted on the user and the
surrounding people when these instructions are ignored and the product is misused.

& CAUTION This symbol indicates the possibility of physical impediments occurring or impediments being inflicted
on the user and the surrounding people when these instructions are ignored and the product is misused.

Type and meaning of symbols

® Prohibited actions, these must be avoided in order to use this radio safely.
For example, ® signifies that disassembly is prohibited.

o Precautions that must be adhered to in order to use this radio safely. For example, % signifies that the power supply is
to be disconnected.

T TR RN R & DANGER T e e e

Do not use the device in “regions or aircraft and vehicles Do not use this device where flammable gases occur.
® where its use is prohibited” such as in hospitals and Doing so may result in fire and explosion.
airplanes.

This may impact the operation of electronic and medical devices.
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About WIRES-X Connection Kit

T e e e e e e e e e e e e ey & WARNING e e e e

voltage.

® Do not use voltages other than the specified power supply
Doing so may result in fire and electric shock.

Do not dismantle or modify the device.
This may result in injury, electric shock or equipment failure.

Do not pull on the cable when plugging and unplugging the

connection cables.
Hold the plug or connector when unplugging. Tugging on the
cable may result in fire, electric shock or equipment failure.

Do not handle the plug and connector etc. with wet hands.
This may result in injury, electric shock or equipment failure.

If smoke or an unusual odor comes from the device, turn off
your PC connected to the device and unplug the connection
cable.

This may indicate a fire, liquid leak, overheating, damage,
ignition or equipment failure. Please contact Yaesu Technical
Support or the retail store where you purchased the device.

Do not use the device when the connection cables are
damaged, or when the connector cannot be plugged in

tightly.

® Please contact Yaesu Technical Support or the retail store where
you purchased the device as this may result in fire, electric
shock or equipment failure.

as water to get inside the product.

® Do not allow metallic objects such as wires, or liquids such
This may result in fire, electric shock or equipment failure.

Do not place the device in areas that may get wet easily
(e.g. near a humidifier).
This may result in fire, electric shock or equipment failure.

Do not bend, twist, pull, heat and modify the connection
® cables in an unreasonable manner.

The cables may be cut or damaged and result in fire, electric

shock or equipment failure.

Refrain from using headphones and earphones at a loud

volume.
Continuous exposure to loud volumes may result in hearing
impairment.

If there is thunder or lightning, turn off the PC connected to
% the device and remove the power plug from the wall outlet.
This may result in fire, electric shock or equipment failure.

T e e e e e e e e e e e e e e & CAUTION LTt e e e e e e e

Do not place this product near a heating appliance or in a
location exposed to direct sunlight.
This may result in deformation and discoloration.

The connection cables may be damaged, resulting in fire or

® Do not place heavy objects on top of the connection cables.
electric shock.

Do not place this product in an environment of dust and
humidity.
Doing so may result in fire or equipment failure.

Do not operate the device near a radio or TV.
This may result in electromagnetic interference.

Do not wipe the case using thinner and benzene etc.
Use only a soft dry cloth to wipe stains from the case.

When the device will not be used for a long period of time,

Disconnecting the power cable may prevent electrical damage,
fire or overheating.

Do not use optional products other than those specified by
Yaesu company.

Use of non-specified products may result in equipment failure or
damage.

Do not throw or subject the device to strong impact forces.
This may result in equipment failure.

Do not place the device on an unsteady or sloping surface,

The device may fall over or drop, resulting in fire, injury or
equipment failure.

Do not place magnetic cards or video tapes near this
device.
The data on the cash card or video tape etc. may be erased.

Do not stand on top of the product; do not place heavy
objects on top or insert objects inside it.
This may result in damage or equipment failure.

Keep out of the reach of small children.
Mishandling this device may result in injuries to children.

% unplug the connection cable for safety.

Do not open the case of the product.
This may result in injury, electric shock or equipment failure.

® or in a location where there is strong vibration.
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About WIRES-X Connection Kit

Package contents

Please confirm that the package contains the following items. If any items are missing, please contact your dealer.

HRI-200 unit

USB cable (type A - type B)

Mini DIN 10 Pin to 10 Pin data cable CT-174
Mini DIN 10 Pin to 6 Pin data cable CT-175
WIRES-X software Setup disk (CD-R)
WIRES-X User Registration Guide

[HRI-200 unit]

Option

« CT174 ....... Mini DIN 10 Pin to 10 Pin data cable
* CT175....... Mini DIN 10 Pin to 6 Pin data cable

About This Manual

Depending on your OS version, the naming that appears in the provided screen shots and in various parts of the screen, as well
as terminology indicating functions and operations (such as “click”) may differ.

The following notations are used throughout this manual.
[GM], [ClOSE] ......ooeeeeeieceeeee e Indicate the device keys and switches or buttons on the PC screen.
“Setting”, “Basic Operational Information” ............ Indicate the headings and menu selection item names on the PC screen.

Please be aware that the contents of this manual, including the illustrations, may be different from the product due to product
upgrades.
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Registration with the WIRES-X Server (applying to obtain an ID number)

1 Access the WIRES-X website (https://www.yaesu.com/jp/en/wires-x/index.php)
2 Click “New Member Registration”
3 Input your email address and submit it
You will promptly receive an email with an address for the website to complete your member registration.
4 Visit the website and select “Apply for WIRES-X new ID (membership registration)”
5 Click [ Agree] on the “WIRES END-USER LICENSE AGREEMENT” screen
6 Fill in the essential fields and submit
Once registration is completed, you will receive an email containing further details about obtaining an ID.
It takes 2-3 business days for registration to be processed.
Caution

If YAESU MUSEN management judges, in the future, that technological advancements or regulatory changes make it unfeasible for YAESU to continue
hosting the WIRES server, it may be necessary to discontinue the management of the WIRES server.
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Installing WIRES-X Softw

Caution

page from the following link; https://www.yaesu.com/jp/en/wires-x/index.php

We recommend that you use the latest edition of the WIRES-X software. You can download the latest software version by logging in the WIRES-X member

I Installing a USB device driver for HRI-200

1 Start up the PC, then use an administrator authorized user account to log in

When another application opens, close it before going to the next step.
2 Browse the supplied CD-R to find and execute the “Install.exe” file
The “WIRES-X installer” window will appear.
3 Click [HRI-200 Device Driver Setup]

The “Command Prompt” window will appear and the USB
device drive setup will start.

jilad If the “Connect HRI-200 to USB.” message dialog box appears,
reconnect the HRI-200 USB cable to the USB port, then click [OK].

4 If the “Windows security Alert” window appears, click [Install]
Setup will start.

When setup completes, the “Ready to use the device” pop-up
message will appear, then the “Command Prompt” window will
close.

J] Installing WIRES-X software

1 Browse the supplied CD-R and execute the “Install.exe” file
The “WIRES-X installer” window will appear.
2 Click [WIRES-X Software Setup]

The “Welcome to the WIRES-X Setup Wizard” window will
appear.

3 Click [Next]
The “License” window will appear.

——————
'WIRES-X installer for 64bit

[ HRI-200 Device Driver Setup |

Driver version - 1.0

WIRES-X Software Setup |

Refer to folder

Software version - 1.088[English]

Would you like to install this device software?

Mame: YAESU MUSEN CO,, LTD. Ports (COM & LPT)
=3 Publisher: YAESU MUSEN CO,, LTD.

[C] Always trust software from "YAESU MUSEN CO., [ mstan | " Don'tnstall }
LTD.". C :

@ You should only install driver software from publishers you trust. How can [ decide which
device software is safe to install?

—
'WIRES-X installer for 64bit

HRI-200 Device Driver Setup |

Driver version - 1.0

[ WIRES-X Software Setup |

Software version - 1.008(English)

Refer to folder
ose |
ﬁWlRES—X;Jp [

Welcome to the WIRES-X Setup Wizard

The Setup Wizard will install WIRES-X on your computer,
Click Next to continue or Cancel to exit the Setup Wizard

==

10
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Installing WIRES-X Software

4 Put a check-mark in the “l accept the terms in the License 15 WIRES X Setup [EEEERE)
Agreement” check box, then click [Next] Endt-User License Agreement .
Please read the following license agreement carefully
The “Destination Folder” window will appear.
il If you do not put a check-mark in the “I accept the terms in the License [WIRES END-USER LIGENSE AGREEMENT G
Agreement” check box, installation will abort. T e ner
an Individual or & single entity) and YAESU MUSEN GO, LTD
(Japan) (hereinafter referred to as “YAESU MUSEN") for the
WIRES camputer software ("Software”). By indicating vour
mgresment at the end of this document, or exercising vour rights
to make and use coples of the SOFTWARE, wou agree to ke
bound by the terms of this EULA. If wou do not agree to the
terms of this EULA, vou may not use the SOFTWARE.
[7]1 zccept the terms in the License Agreement
gack [ Next | [ Cancel
5 Confirm the destination where the WIRES-X software will install T wies xsenup o=

This setup program will install the WIRES-X in the following folder.

The “Ready to install WIRES-X” window will appear. You ean choose ot to nstal the WIRES-X by cick [Cancel] o ext setup.
jifs] If you put a check-mark in the “Enable WIRES-X Auto Start.” check
box, the WIRES-X software will run automatically when Windows

and click [Next] Destination Folder .

starts. [¥] Enable WIRES-X Auto Start.

Even when the WIRES-X software is terminated for some reason, it Install WIRES X to:

will reboot automatically. [€:Program Fies (x36) rAESUMUSEN WIRES X\

Bak [ Nea | [ cancel
6 Click [Install] 5 s omor p——

Program installation will start. Readly to install WIRES-X .
« To confirm or change the installation setting, click [Back].

« To exit the wizard, click [Cancel]. Click Install to begin the installation. Click Back ta review or change any of your

installation settings. Click Cancel to exit the wizard.

When installation completes, the “Completed the WIRES-X
Setup Wizard” window will appear.

Bacc | el | Cancel

] WIRES X se Setup [

Installing WIRES-X .

Please wait whie the Setup Wizard installs WIRES-X.

Status: Copying new fies
Back Next
7 Click [Finish] 18] WIRES X Setup =A==

The “Completed the WIRES-X Setup Wizard” window will close.
When WIRES-X software installation has been completed
properly, the [Wires-X] icon will appear on the Windows ik the Finh button to <t the Setwp Wizord.
desktop.

8 Click [Close] in the “WIRES-X installer” window

Completed the WIRES-X Setup Wizard

o e
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Connecting Devices

HRI-200 interface box

l Front panel

L —x

POWER

() HRI-200
Wide-C| verage Internet Repeater Enhancement System

7 —
O]

@® POWER indicator
Lights green when the power is on.

l Rear panel

s
500 @

—|—
o @ ® @

® MONITOR jack (3.5 mm)

Connecting an earphone or speaker plug allows monitoring the sound transmitted by the node.

N.C

MONITOR GND

@ RADIO 2 jack (Only for C4FM digital operation)

Connect the plug of a 10 Pin to 10 Pin Mini DIN cable. Use to connect a C4FM compatible digital transceiver for preset search
channels.

® RADIO 1 jack

Connect the 10 Pin plug side of a 10 Pin to 10 Pin Mini-DIN cable (for compatible transceivers) or a 10 Pin to 6 Pin Mini DIN
cable (for FM analog transceivers).

@ USB jack
Connect the supplied USB cable type B plug. Use to connect to a PC.

WA == N 12
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Connecting Devices

Connecting HRI-200 to a PC

CAUTION!

Do not connect the HRI-200 to the computer via the USB cable until the USB device driver installation
process has been completed (See page 10). Connecting the HRI-200 to the computer via the USB cable
before installing the correct driver may result in improper operation.

LAN cable
(sold separately)

—— =X To the Internet

HRI-200
(rear panel)

plug

USB cable
(supplied with
HRI-200)

When the HRI-200 is connected to the PC properly, the HRI-200 will turn on automatically when the PC is turned on.

Tip
When using a router to connect the PC to the Internet, refer to the instruction manual supplied with the router for information about attaching the PC to the
router, and the router to the Internet using LAN cables.

Also, refer to the instruction manual supplied with your router to perform the initial router configuration. Users generally access the IP address of the router
using a web browser to configure various settings on the displayed setup screen.

® Ferrite Cores

To reduce high frequency EMI/RFI electronic noise, place either end of the USB Cable through the supplied ferrite core, and then wrap one
turn around the core.

Then snap the two halves of the core together, as shown in the illustrations below.

Attach the ferrite core as close as possible to the USB plug, as shown.

Wrap one turn, Wrap one turn,
snap core together snap core together

] |

as close as possible as close as possible
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Connecting HRI-200 to transceivers

Cautions

® Turn off the transceiver before connecting cables.
® Provide a DC 13.8 V transceiver power supply separately.

® When operating with a transceiver

C4FM Digital Transceiver
(such as FTM-400XD)

go

HRI-200
g(rear panel)
|

To antenna ¢

Coaxial cable
(sold separately)

FM Analog Transceiver @

10 pin 10 pin
DATA Jack plug
10 pin

plug

CT-174 (supplied)

USB cable
(supplied)

RADIO

HRI-200
(rear panel)

To antenna ej

Coaxial cable
(sold separately)

® When operating with 2 transceivers

C4FM Digital Transceiver
for preset search channels|
(such as FTM-400XD)

Coaxial cable
(sold separately)

To antenna 3j

6 pin

CT-175 cable
(supplied)

CT-174 cable (supplied)

USB cable
(supplied)

A0 1

HRI-200
rear panel)

a3,

[ | DATA Jack

10 pin
plug

CT-174 cable
(optional)

C4FM Digital Transceiver
for operation channels
(such as FTM-400XD) ¥

©

To antenna )

Coaxial cable
(sold separately)

10 pin
5 DATA Jack

10 pin
plug

A
|

CT-174 cable
(supplied)

X ToaPC
USB cable
(supplied)

Tips

» When using an FM analog transceiver, set the data communication port rate to 1,200bps on the transceiver. For details, refer to the instruction manual

supplied with the transceiver.

« When using a YAESU FTM-500DR/DE, FTM-400XDR/XDE/DR/DE, FTM-300DR/DE, FTM-200DR/DE or FTM-100DR/DE transceiver as a node, turn on
the transceiver while pressing [D/X] and [GM] keys. This sets the transceiver to the connection-only mode, and menu settings including the port rate setting

will not be required.

14
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Preparing an Internet Environment

Since the protocol UDP (user datagram protocol) is used for WIRES-X communications via the Internet, some menu settings are
required depending on the Internet connection method.

Setting the PC and the router

] Why is the setting required?

©® Opening communication port

The WIRES-X server communicates with the PC used as a node station via specified ports (46100, 46110, 46112, 46114, 46120 and
46122).

When using a router to connect the PC to the Internet, the UDP port must go through the router as well; however, communications
using these ports are generally prohibited on commercially available routers in the default setting.

Therefore, if you are using a router, make sure that the UDP ports are “open” for passing UDP ftraffic.

Tip
If you do not use a router, this setting is not required. In this case, after installing the WIRES-X software, perform the Internet access permission setting
(See page 20) to use WIRES-X immediately.

® Assigning a static IP address

Generally, the DHCP (Dynamic Host Configuration Protocol) function of the router assigns an IP address automatically because of
the Internet connection setting on Windows PCs by default. In this setting, every time you start the PC, a new IP address may be
assigned.

If a new IP address is assigned automatically to the node PC when starting the PC, the address may be different from the one
specified on the router. It disables communications with the WIRES-X server.

On the other hand, when ports are open on the router, the communication destination of the port (a PC) is specified with an IP
address.

To enable communications, assign an IP address to the node PC and specify this address when opening ports on the router.

I Setting an IP address on the PC

® Selecting an IP address
The IP address set on the node PC differs depending on the router.
The steps are shown as follows:

1 Click the Windows Start button
2 Click [Control Panel]
3 Click [Network and Internet], then [Network and Sharing Center] e

G =T ConrolPanel » Network and ntemet » 43 [ Search Control Pane o

Control Panel Hoggg aCetwork and Sharing Center
. = i == Cennect to a network | View network computers and devices

Add a wireless device to the network

HomeGroup
@

o0se homegroup and sharing options

Internet Options
Changeyy pag add-ons history and cookies
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4 Click [Local Area Connection] B EEEr=>=
Depending on the OS or connection environment, “Ethernet” may OU-[E: ot » Nekonsiiens ) Mmsons oo SR 7 EI g
appear. Control Pond Hopg View your basic network information and set up connections
Change adapter settings Y = Seefull map
The “Local Area Connection Status” dialog box will appear. sy —— e

5 Click [Details]

The “Network Connection Details” dialog box will appear. Genera
Connection
IPv4 Connectivity: Internet
IPvE Connectivity: No Internet access
| Media State: Enabled
Duration: 01:18:27

6 Write down the “IPv4 Address” and “IPv4 Subnet Mask” values

View your active networks

Network 4
Public network

Change your networking settings

Comnectto s network
s‘ C

4G 5 upanew comnecton rneork
Setup a wireles, broadband,dia-up, ad hoc, or VPN connection; of set up a fouteror access point

Connect or disconnect

Access types”” Intemet
Connectior Local Area

a wireless, wired, dial-up,

@@ Croese homegroup andsharing options

[S] Troubleshoot problems

See also
HomeGroup
Internet Options

Windows Firewall

1 Local Area Connection Status

|

Activity

Speed: 100.0 Mbps

a

[ Eproperties | [ Fjpsabie | [ Diagnose |

I Sent — &! ——  Recsived "

Bytes: woM721 | 154,928,802

-
Network Connection Details

The “IPv4 Address” value is the IP address you set on the PC. Netwok Comociion Deols

7 Click [Close]

The “Local Area Connection Properties” dialog box will appear

again.

Property Value
Connection-specific DN

NetBIOS over Tepip En... Yes

Linkdocal IPv6 Address  fe80:+1cbf:3702-168:22c8%10
IPv6 Default Gateway

IPv6 DNS Server

Description Intel(R) 82578DM Gigabit Netwark Corine
Physical Address ==

( 1Pv4 Address 192.168.0.2 |

el |Pvd Subnet Mask 265.255.255.0

Lea =50y 12. 2014 1:10:51 PM
Lease Expires Sunday, July 13, 2014 2:24:29 FM l
IPvé Defeult Gateway ~ 152.168.0.1
IPv4 DHCP Server 152.168.0.1
IPv4 DNS Server 192.168.0.1 l
IPv4 WINS Server

< [}

Close
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® Changing the IP address

1 In the “Local Area Connection Status” dialog box, click @ Local Area Connection Staies i)
[Properties] “General |
The “Local Area Connection Properties” dialog box will appear. Connecton
IPv4 Connectivity: Internet
1Pv6 Connectivity: No Internet access
Media State: Enabled
Duration: 01:20:07
Speed: 100.0 Mbps
Activity
Sent —— -i —— Received i
-
Bytes: 4,044,721 | 154,929,862
Il |
t [ eroperties | | | Fpsable | [ Diagrose |
P4
Close
2 Select “Internet Protocol Version 4 (TCP/IPv4)’, then click R oc Are Conmetanii =)
[Properties] Metworkng |
The Internet protocol property setting dialog box will appear. Cennect eing:
& Intel(R) 82578DM Gigabit Network Connection

This connection uses the following ftems:

& Clent for Microsoft Networks

251 (305 Packet Scheduler

454 File and Printer Sharing for Microsoft Networks
<& Intemet Protocol Version 6 (TCP/IPYE) !

B Intemet Protocol Version 4 (TCP/IPv4)

& Link-Layer Topology Discovery Mapper /0 Diiver

<. Link-Layer Topology Discovery Responder fl
ﬁ
Description

Transmission Control Protocol/Intemet Protocal. The defautt
wide area network protocol that provides communication
aeross diverse interconnected netwarks.

Concd
3 Sele(:t “Use the fOIIOWing IP address” rInlEme'I Pratocol Vers_itﬂdlc_PLIPM) Properties M‘
4 Enter the IP address you wrote down in step 6 of “Selecting an General
IP address” o oy, G o e o sk st
“ » for the appropriate TP settings.
5 Enter “255.255.255.0” as the sub-net mask address
6 Enter the router IP address as the default gateway address ; e foloning P adres:
7 Enter the router IP address as the priority DNS server address [ et
Default gateway:

Obtain DNS server address automatically

@ Usg the following DNS server addresses:

preferred DNS server: ©
Alternate DNS server: z "

[C] validate settings upon exit

8 Click [OK] and [Close] in each dialog box

Tips
* The ddd part of an IP address (aaa.bbb.ccc.ddd.) can be set depending on the router range. See the router setup screen.
* When connecting several devices to the router, make sure the IP addresses do not overlap with each other.

[ Opening the router ports

First, refer to the instruction manual supplied with the router to make sure the router has the UPnP (Universal Plug and Play)
function.

On the router with the UPnP function, ports can be opened with the WIRES-X software.

On the router without the UPnP function, ports must be opened from the router setup screen.

WA == N 17
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In case you cannot open ports using the WIRES-X software on the router with the UPnP function, open ports from the router setup
screen.

® When using a router without the UPnP function
In advance, in the “NAT” or “Port mapping” setting on the router, set the address in “Setting an IP address on the PC” (page 15)
as the LAN address and register the following 6 ports:

46100, 46110, 46112, 46114, 46120 and 46122 (UDP ports)

For the detailed procedure, refer to the instruction manual supplied with your device.

® When using a router with the UPnP function

1 On the router setup screen, make sure that the UPnP function is enabled on the router
For details, refer to the instruction manual supplied with the router.
2 On the Windows desktop, double-click the [Wires-X] icon
The WIRES-X software starts.
The software can also be started by clicking the Windows Start button, then “Wires-X".
Then, the Internet security alert will appear depending on the settings of Windows and the firewall software (refer to “Setting the
Internet access security” (page 20) for details).
3 Click [Allow access]
Depending on the OS or firewall software, click [Unblock] instead.
The “WIRES ID Activation” window will appear.

4 Click [POI’t check] "WiRes 1D Activation ]
The “Port check” window will appear. Seril Ho. omes 10 Dser T Catisign
|=2 Node : || I I
Room : I I
City State Country
| | |
Input DTMF-ID and press [ID Entry] button.
P;‘:Ek ID Entry Cancel | Help
5 Put a check-mark in the “Automatic UPnP” in the “Port Check” o -
area
. . “« » ILS Port Check
6 Click [Start] in the “Port Check” area —
* Start
The communication status will be checked for each of the 6 [Eeze T ‘ -
Room contral Rutomatic UPnP
ports. ——e |
When checking is complete, the “OK” or “NG” will appear on the wews comezar [ T TR S

right side of each port name. s | com

If there is one or more “NG” messages, registrations of the 6
ports will start.

While checking, the operational status of the WIRES-X software .
(such as registering) will appear in the bottom half of the “Port check”
window.

« 3

I Port check fail.
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When the port registration is complete, the communication
status will be checked again.

-
Port check pr——
. -

Port Check

F hurouaric UPnD

ILS
Node contxol
Node voice

Room control

Room voice

Delete UPnp Entry
Help Close

News contxol

f b

i Port check start.
When checking completes, the “OK” or “NG” will appear on the e ——
right side of each port name. .
7 When “OK” appears for each port, click [Close] R “"—
The “WIRES ID Activation” window will appear again. EE| 4|
If “NG” still appears, ports cannot be opened using the WIRES-X o O
software. e () ovouom . eieee np Ty

AddPortMapping Start. UDP Port:46122
UBnP Setting success

AddPortMapping Start. UDE Port:46120
UBnP Setting success

AddPortMepping Start. UDE Port-46114
UBnT Setting success
UENP entry finished.

m

< r

i DPort check corplete.

Tip
To remotely control a node station using the remote monitor function, the TCP port 46190 (default value) must be open. For details, refer to “Operating the
WIRES-X software remotely” (page 49).

Taking security measures

Make sure to take security measures against interception and unauthorized access using a security service provided by the Internet
provider or a firewall program for the router and PC.
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Starting the WIRES-X software
1 On the Windows PC desktop, double-click the [Wires-X] icon

The software can also be started by clicking the Windows Start button, then [Wires-X].

l Setting the Internet access security

When the WIRES-X software starts up, the Internet security alert
window, as shown on the right, may appear; depending on the
settings of Windows and the firewall software.

In this case, release the block, and allow the WIRES-X software to
access the Internet.

J] Getting the WIRES-X server certificate

9 Windows Security Alert

@ Windows Firewall has blocked some features of this program

Windows Firewall has blocked some features of WIRES-¥ Application on all public and private
networks,

& Name:

Publisher: YAESU MUSEM CO.,LTD.

Path: C:\program files (x85) \yaesumusen wires-x. exe

Allow WIRES-X Application to communicate on these networks:
[ Private netwarks, such as my home or work network

[¥] Public netwarks, such as those in airports and coffee shops (not recommended
because these networks often have litHe or no security)

What are the risks of sllowing a program through a firewall?

[ @glowamess ] [ Cancel

When starting the WIRES-X software for the first time, the “WIRES ID Activation” window will appear.

1 Follow the steps in “Opening the router ports” (page 17) to check the WIRES-X communication ports

2 Enter the provided node and room DTMF IDs (both are 5-digit
numbers)

3 Click [ID Entry]
If the entered IDs are authorized, all the information that was
registered when applying for IDs will appear in the “User ID”,
“Call Sign”, “City”, “State”, and “Country” boxes on the “WIRES
ID Activation” window.

4 Click [OK]

-
WIRES ID Activation

Serial No. DIMF ID User ID CallSign

= Node - I I I

City State Countzy

Input DTMF-ID and press [ID Entry] button.

Dort

check ID Entry

Cancel | Help

The WIRES-X user information will be stored on the PC, and now the PC can be used as a valid node.

The “Settings” window will appear.

20



Basic Operations

_— —
Settings - — —
- e
Settings WIRES ID information
E-Personal sectings

WIRES ID informacion Serial No. DTMF ID CallSign TUser ID

Locaticn settings == (=== =2 == User 1D r.hamgel

Round QSC room settings

- Property City State Councry
HRI-200 setup |5mnaqaua—ku IIDkyD IJapan
Call settings e—

General settings I
Digital ID settings
Make list file I” confidential 1D

Log file settings

I” QSL exchange (SIZE QVGA 320x240bmp)

| =

Get info. text (MAX.200 cheracters)

o4 | Cancel Help

Here, comments can be entered and other node settings can be configured. For details, refer to “Basic setting” (page 26).
5 Click [OK]
The “Settings” window will close and the WIRES-X software main screen will appear.

Tip
When the software is accessed the second time, and thereafter, the “WIRES ID Activation” window will not appear.
When performing re-certification, the “WIRES ID Activation” window will appear again.
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] WIRES-X software main screen

Mainly the node and room lists on the Internet appear on the left, and your node status and operating status appear on the right.

=== Status indicators

User monitoring
window

o

() Log window

()= Chat window

.— Function window

Menu bar File(F) View(Y) Connect(C) Tool(T) Help(H)
Glser ID +DT.. |Act | Call/Rm.. | City | State | Cou...| FreqMHz) [ sQu [tat_ [Lon | comment = oot 1 |[c 20 o
| E—
Group window s
2017/11/22 16:29:00 Iranaceiver Mode:Digital/Digital B
2017/11/22 16:29:00 Humber of sound devices = 3
2017/11/22 16:29:00 Sev Voice Mixer Device : Input=2 Outpus=1
2017/11/22 16:29:00  Miwer inpur device-Microphone (ERI-200 A(CHL)
USB Audio codec )
2017/11/22 16:29:00  Mimer output device=Speakers (HRI-200 A(CHL) USB
Rudio codec
2017/11/22 16:29:00 HRI-200 Audio device detected.
[ DTM... [ CallSign | City [[Stete [ Cou...| FreqtMHz) [ SQL [tat [lon [Comn =«
= Kakogawa-city ~ Hyogo  Japen 430820M.. TSQ:885Hz N.. El34..
Kashiwazaki-city Niigata  Japen 430800M.. DG-ID36 _
Tokasaki-city ~ Gunma  Japan N3.. E138. ==
Kashiwaro-city ~ Oscka  Japan 144550M.. TSQ:770Hz N.. EI35..
Kamikawa-gun  Hokkaido Japen 430780M.. DG-ID78  Nd.. El:
i Kyoto-city Kyoto  Japan 430820M.. DGID:32  N3.. E
Active node Sapporo-city  Hokkaido Japan 430940M.. DG-IDO5  N.. Eddl.
; Kato-city Hyogo  Japan 144560M.. TSQ1Z30.. N3.. El4..
window Fleetood Lancashi.. UK 433675M.. DG-ID:00
Liverpool Merseysio UK 1440MHz DGID00  NS.. W00
Avisaig Highland UK 1448375.. DGIDO0  NS.. W00 -
Mandaue Gty Cebu Phil. 431775M.. DGDO0  Nl. E123. me=— |« m v
Lamaca Lamaca  Cyp.. 1455625M.. TSQ:88.5Hz
Nicosia Nicosia  Cyp 145725M.. DGIDO0  N3.. EO33.. -
Taito-ku Tokye  Japen
Kawaguchi-city Saitma _Japan N3, E139., T
0 | B
Room ID. [DTM... [ Act [ Room name [ city [State | Cou.. | Comment B
=00 Baldwin Wisconsin USA s 1|
=00 Kakogawa-city ~ Hyogo  Japan ‘s
=0 Kilrea County.. UK o
Active room =1 000 Surbiton Sumey UK e
=000 Kamikawa-gun  Hokkaido Japan
i =000 Takasaki-cty  Gunma  Japan
window == 003 Middlesbrough ~ North Y. UK -
000 Yarm North¥... UK S0 | R
070 Beaumont Teas  USA [EEUR{ ]|
=000 SALVADOR Bahia Brazil  — e =
=005 Ottawa Ontaric  Can.. E—
=00 Great Falls Montana  USA s
= o0 Fukuoks-city  Fukuoks  Japan
002 WEEEEE——— Morrisville Penngyl.. USA s
] v

Status bar === s

Menu bar

Group window
Active node window

Active room window

Status bar

Status indicator

User monitoring window .............

Log Window...........coeevviiiieieennnns
Chat window

Function window

Tip

Calls the WIRES-X software main functions.
For details on each menu, refer to “Main Menu” (page 74).

Veri== ONLINE

Displays active nodes and rooms arranging the list based on the setting.

Active WIRES-X nodes are listed.
Active WIRES-X rooms are listed.

Displays information such as the WIRES-X software status and descriptions of a menu item

pointed by the cursor.

For details, refer to “Displaying the operating instructions” (page 92).

Displays the status of your node with icons.

Displays information of the currently accessing digital node (mobile or fixed).

Displays operating status information regarding the WIRES-X software operation.

Displays records of text chats with connecting nodes (including nodes via a room). The entry

field is at the bottom.
Displays buttons to use the useful advanced functions.

“ For details on the use of each screen area (except for the Menu bar and Status bar), refer to “Main Screen” (page 66).

22




Basic Operations

Setting the WIRES-X node information

When using the WIRES-X software for the first time, set the basic information and configuration of the node using the WIRES-X
software.

Cautions

® [f your transceiver supports the HRI-200 mode (FTM-500DR/DE, FTM-400XDR/XDE/DR/DE, FTM-300DR/DE, FTM-200DR/DE, FTM-100DR/DE), the
settings will automatically be reflected into the transceiver.

® |f your transceiver does not support HRI-200 mode, the settings will not be reflected into the transceiver. You will need to manually configure the same
settings on the transceiver.

Tip
Press and hold the transceiver [D/X] Key and [GM] Key simultaneously for two seconds while turning the power ON.
The transceiver will be set to node station mode; and “HRI-200” will appear on the display.

l Configuring the transceiver settings
First, configure the WIRES-X node transceiver settings.

1 From the “File” menu, click “Transceiver” = wres
The “Transceiver” window will appear. G e i ) 2 i)
Import settings .
I If you connected to the DR-2X/XE or DR-1X/XE, refer to the HRI-200 a::::: allRm.. [City [swte [ Cou..[Freq.. [soL Lot [L.
Reference Manual for DR-2X/XE or DR-1X/XE.
Set default

Retry activation

Transceiver(T)

Settings(P)
Refresh list
Exit(E)
2 In the “Voice CH Transceiver” area, select the operating mode e
When “RX:DIGITAL - TX:DIGITAL” is selected, you can configure the ey Y
settings in the “Preset Search CH” area. Iransceiver |FE:DIGITAL - TE:DIGITAL -] | Operation mode e =
3 In the “Voice CH” area, configure the voice channel settings Lhslieceizeboiin w1
For details, refer to the next page. Transceiver I DST Flfw version I Transceiver I DST kl‘/w version
FIM-400D== =
Configure all the setting items. Otherwise, the node cannot be e e operaion [
i
Operated . Frequency 144.000 T Frequency 144.000 T
4 In the “Preset Search CH” area, set the preset search channel I™ Nerrow Deviation I Werrow Deviation
O eratlonS C4MM detect s C4FM detect b
p DG-ID o w||oo - D6-ID 00 w|loo -
For details, refer to “Setting the preset search channel” (page 35). = = . =
5 Click [OK] or [Apply] Tone s [ ezs x|
The settings will be stored. = lizz—_[ Z'l
Offset vz
P Beverse | ountinkc(e) 144,000z
¥ Hide frequecy settings
||
| ANnce e
| OK | [of 1 Apply Help
L . ————
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Operation mode

Select one of the following (4) WIRES-X modes in accordance with your transceiver configuration.
The default setting is Analog.

 Operates only the voice channel with one digital transceiver (Digital)

Voice CH — [Transceiver] — "RX:DIGITAL - TX:DIGITAL"
Preset Search CH — [Operation mode] — "OFF"

» Operates the voice channel and preset search channel by dual-receiving with one transceiver (Digital Dual Receive)

Voice CH — [Transceiver] — "RX:DIGITAL - TX:DIGITAL"
Preset Search CH --> [Operation mode] --> "Dual Rcv"

Dual Receive Timing setting: The interval time to switch monitoring between the voice channel and preset search channel can be set
from 1 second to 15 seconds in 1 second increments. Normally, set it to 1 second.

When operating in GM mode, this mode cannot be selected.
» Uses one transceiver for the voice channel and a second transceiver for the preset search channel (Digital Double)

Voice CH — [Transceiver] — "RX:DIGITAL - TX:DIGITAL"
Preset Search CH — [Operation mode] — "ON"
When operating in GM mode, this mode cannot be selected.

» Operates only the voice channel with an analog transceiver (Analog)

Voice CH — [Transceiver] — "RX:FM - TX:FM"
When operating in GM mode, this mode cannot be selected.
Voice CH
® Transceiver
Select the Repeater operation mode from the following:
* Digital (RX:DIGITAL - TX:DIGITAL): C4FM Digital mode
* Analog (RX:FM - TX:FM): FM Analog mode

® Transceiver / DST / F/IW version
Displays the data information of the digital transceiver in connection with the HRI-200.

® Modulation
Displays the Voice CH wave format selected for repeater operation.(RX CH and TX CH)
 Digital: Displayed if using digital (C4FM) mode.
* Analog: Displayed if using analog (FM) mode.

® Frequency
Enter the WIRES-X operating frequency (Voice CH frequency) in MHz.
The entered data will be displayed on the ID list.
If the connected transceiver is HRI-200 control mode compatible, the data will be set automatically on the transceiver.

® Narrow deviation

Select if using Narrow deviation operation.
DA This parameter cannot be set different for the RX and TX channels.

® DG-ID (Digital Group ID) / Analog SQL
Enter the squelch function of the WIRES-X operating frequency (Voice CH frequency).
The entered data will be displayed on the ID list.
If the connected transceiver is HRI-200 control mode compatible, the data will be automatically set on the transceiver.

The following squelch functions are available:
Digital Operation (The default setting is DG-ID 00, DG-ID Sub ID 00.)
* DG-ID: Select the DG-ID number "00"-"99" and DG-ID Sub ID "00"-"26" (functions only in digital mode).

+ By setting the DG-ID number to "00" and the DG-ID Sub ID to "00"-"26", the station becomes an open node station, and can be connected from
all transceivers with the WIRES-X DG-ID setting "AUTQO". Transceivers set to "AUTO" are automatically set to the same DG-ID Sub ID when
connected to a node station. Setting the DG-ID Sub ID to "01"-"26" may prevent relaying signals from other transceivers.

» When using a node station in a restricted group, set the DG-ID to a number other than "00", and then set all the group transceivers to the same
DG-ID number.

Analog Operation (The default setting is NoTone.)

» NoTone: Not using CTCSS tone or DCS code squelch.

» ToneSQL: Using CTCSS tone squelch.

» DCS: Using DCS code squelch.

If using ToneSQL, select the desired tone frequency (67.0 - 254.1 Hz).
If using DCS, select the desired DCS code (023 - 754).
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® Power
Set the transmission power of the repeater connected to the Radio 1 terminal.

® Reverse
Enables the transmit frequency offset.
* Reverse (when checked): The uplink (RX CH) input frequency information equals the downlink (TX CH) output frequency
minus the offset frequency. (Default - Offset)
» Normal (not checked): The uplink (RX CH) input frequency information equals the downlink (TX CH) output frequency
plus the offset frequency. (+ Offset)

When using a repeater, the portable terminal transceiver and transmission/reception are reversed. It is therefore necessary to use

the reverse setting (transmission frequency offset reception setting). (Default setting)
Example 1

Uplink (RX CH) frequency = 434.700 MHz
Downlink (TX CH) frequency = 439.700 MHz
Reverse setting (Default setting) (- Offset)

Uplink (RX) = 434.700 MHz / Downlink (TX) = 439.700 MHz / Offset = -5.000 MHz

List output/search response info = 439.700 MHz - 5.000 MHz
Example 2

Uplink (RX CH) frequency = 439.700 MHz
Downlink (TX CH) frequency = 434.700 MHz
Normal setting (+ Offset)

Uplink (RX) = 439.700 MHz / Downlink (TX) = 434.700 MHz / Offset = +5.000 MHz
List output/search response info = 434.700 MHz + 5.000 MHz

® Hide frequency settings
Hide transmission frequency data. If remove the check mark, operating data, such as frequency will be displayed in the ID list.
It is checked in the default setting.
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l Basic setting

Next, set the WIRES-X node user information.

® Basic operating information
Confirm the user information of your node and specify supplementary information.

1 From the “File” menu, click “Settings” xowessx
The “Settings” WindOW W|” appear' IFiIe(F} View(V) Connect(CT) Tool(T) Help(H)
. “ . R . ! " Import settings - ]
2 Click “Personal settings” - “WIRES ID information E— S N e e e e [
On the “Settings” window, the “WIRES ID information” screen Set default
W|” appear Retry activation
3 Enter or select the following required items: sl
Settings(P)
Refresh list
Exit(E)
E= — I X XTI
Settings WIRES ID information
[
- Serial No. DIMF ID CallsSign User ID
e s || [ = e [ ]
E- Property City State Country
- ERI-200 setup [sninagava-ia [Tokva [72pen
LCe11 serrings o
! - Generet seteings |
l .~ Make list file I™ confidential ID
: I” QSL exchange (SIZE QVGA 320x240bmp)
| [ _|
: Get info. text (MAX.200 characters)
|
M
| 0’4 | Cancel Help
Serial NO......vvvviiiiieeeeee Your HRI-200 serial number
DTMF ID ..o Access code of your node for the analog station
CallSign ... Your node call sign
User ID ..o Access code of your node for the digital station
[User ID changel].........cccceeveennnnes Click to change some parts of the user registration information.
For details, refer to the next page.
When designating ID name, please include Callsign information.
City/State/Country .........cccceenne Your node location
Comment.......coceviiiiiiieeeeee Entered comment will be shown in the “Comment” area on the node list of the WIRES-X
server.
Confidential ID..........cccoveeevieennnes Put a check-mark to hide your node from the node list of the WIRES-X server.
QSL exchange........c.ccccceeevueennes Put a check-mark to display QSL card images transmitted from connection destinations (nodes
and rooms) and transmit the QSL card image of your node to the connection destination. Click
[...] to specify the QSL card image file of your node.
Getinfo. text...cccoveeviiiiiees Entered text will be shown using the “Get Info” function on the node list of the WIRES-X

software.
4 Click [OK]
The settings will be stored and the “Settings” window will close.

Tip

“ For details on QSL card images, refer to “Displaying a QSL card image” (page 63).
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On the “WIRES ID information” screen of the “Settings” window, click [User ID change] to display the “User ID Change” window.

[User ID Change - - - )
The dialogue is for User ID and an Cperation Style, the
setting of the New function perform it.
Serial No DTMF ID User ID{Max 10Bytes)
— = =
STyl News setting
% Open *+ ALL OK
" Download only
fale:id " (S0 only
GM style is only Digital mode.
Bpply Cancel | Help |
Serial NO......oooiiiiii Your HRI-200 serial number (unchangeable)
DTMF ID ..o Access code of your node for the analog station (unchangeable)
User ID ..o Access code of your node for the digital station

The ID can be changed using up to 10 characters. After changing, click [Apply] to send the
new user ID to the WIRES-X server and the node list will be updated.
« If the new user ID you entered is already used, an error message will appear when clicking [Apply].

Enter another character string.
* Only alphanumeric characters, "-" and "/" can be entered for UserlD.
Style
The operating form can be selected from one of the followings:
The default setting is Open.
® OPBN..ceiiiieiic e Select to operate your node as an open node without limiting connection destinations.

*GM.uiiiiiiiii e Select to operate your node as a repeater node for a GM operating station.
This option can be set when “Digital” (operation with a transceiver) is selected in the “Operation mode”
area on the “Transceiver” window.

News setting

The following 3 types are selectable for setting how the digital station and other nodes can utilize the news station of the node.
* The default setting is ALL OK
* For details, refer to “Using the news function” (page 55).

CALLOK ..t Select to allow connection destinations to download/upload news data from/to your node.
* Download only..........cccceevveennnee Select to allow connection destinations to download news data from your node.
* QSO ONIY..ooiiiiiiiiiiiieceeee Select to prohibit access to news data of your node from the connection destination.

EMG Voice (emergency information voice data) can be uploaded/downloaded anytime.

® Your node location information
To use the location information of your node for a digital operation, latitude and longitude of your node can be specified.

1 From the “File” menu, click “Settings” s
The “Settings” window will appear. (File®] ViewV) Connect(Q) ool _Help(H)
. “ . R . . " Import settings . N
2 Click “Personal settings” - “Location settings E— R | Gy [sote | Coue | Frea= [soL [ 1ot [
On the “Settings” window, the “Location settings” screen will Set default
appea r. Retry activation
3 Enter or select the required items Transceiver(T)
. Settings(P)
4 Click [OK] Refresh list
The settings will be stored and the “Settings” window will close. Exit(E)
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[‘settings s oot & s am o
Settings Location settings
- Perscnal settings
WIRES ID information
Degree  Minute  Second
Round QS0 room settings Tacitmae : | 1 2| 1 2| 1 = [ferm -]
- Property [001 (geq) 1.017min)Noren
HRI-200 setup
Call sectings Longitude :[ 1 | =] 1 & [easc |
General settings [001 (aeq) 1.017¢min)East
Seund sertings Read GBS Data T
Make list file
Log file sevtings I™ Show positicn data
I
: f):4 | Cancel Help

Latitude/Longitude....................... Location information of your node
Enter values based on the location information of world geodetic system (WGS-84).

[Read GPS data] .......ccceevuvveennnen. When using a transceiver compatible with the HRI-200 control mode and the GPS satellite
information is acquirable, the GPS location information can be read from the transceiver. Click
this option to replace the location information setting on your node with the GPS location
information received from the transceiver.

Show position data ..................... Put a check-mark to show the location information when your node is shown on the node list
of the WIRES-X server. The location information will be sent to digital nodes connected to your
node as well.

J] Volume adjustment

When operating an analog node or connecting to an analog node, to operate with proper sound levels, the volume level must be

adjusted in advance.

Tip
For communications between digital nodes, the volume level adjustment is not required. The following volume level setting has no affect digital
communications.

® When using a transceiver with mini DIN 10-pin DATA jack (FTM-500DR/DE, FTM-400XDR/XDE/DR/DE, FTM-300DR/DE,
FTM-200DR/DE, FTM-100DR/DE or FTM-6000R/E)

1 From the “View” menu, click “Audio adjustment’ =wrss
The “Audio adjustment” window will appear. Fke 1 JRFEORN ooty T (i
G.User iR ' [state | Cou..| Freq(M.. |SQL | Lat | L.

v | Status Bar(S)

Connect ID window(T)

Group window 3
Bookmark-Info(B)
Mode-Info(N)

Room-Info (M)

Log 3
Audio adjustment(R)

News

Mebile Users list

2 From the “Settings” menu, click “Preset Volume” - “HRI-200 s DR e
mode Transceiver” Sekings |
Preset Volume 3 HRI-200 mode Transceiver
3 Clle [c|°se] Application Volume B conventional transceiver |
The setting will be stored and the proper sound volume will be
set.
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® When using a conventional FM analog transceiver with 6 Pin (8 Pin) mini DIN DATA jack (FTM-350, etc.)
owresx

File(F) | View(V) | Connect(C) Teel(T) Help(H)

1 From the “View” menu, click “Audio adjustment”
The “Audio adjustment” window will appear.

2 From the “Settings” menu, click “Preset Volume” - “conventional
transceiver”

3 Click [Close]
The setting will be stored and the proper sound volume will be
set.

G.User

v

Font(F)
Status Bar(5)

Connect ID window(T)

Group window
Bookmark-Info(B)
Mode-Info(N)
Room-Info (M)

Log

Audio adjustment(R)

News

Mabile Users list

' by I State

| Cou... | Freqm... | squ

| Lat | L.

Audio adjustments

Settings |

Preset Volume »
Application Volume »

HRI-200 mede Transceiver

Tip

“ For more advanced adjustment, refer to “Adjusting analog sound” (page 53).
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Connecting using WIRES-X
I Connecting to a node on the Internet

Connect to another node from your node PC.

1 From the active node window, select a node you want to SE= e Machids-oty  lokyo  Japan LAy
e s Ota-ku Tokyo Japan 430.96..

connect to I = hinagawa-ku Tokyo Japan

onne

. . . inagawa-ku Tokyo lapan  144.0M...
2 Move the cursor to the selected node, then right-click on it GetInfo mae-city Tokyo  Japan 43004..
. . Window defaul mato-city Kanagawa Japan 430.94..
The command list will appear. inclow default ina-city Chiba  lapen 430.6..
. « ,, Add Bookmark list ratsuka-city Kanagawa Japan 430.82..
3 CIICk ConneCt Node Reject 558-City Tokyo Japan 430.77..
1ama-city  Kanagawa Japan 438.76..

You can also click “Connect” from the “Connect” menu.
Machida-city Tokyo Japan 144.55..

The connection will be initiated, and when a connection is Sme om Ketsushike-ks  Tokyo  Japsn 4308L.
. . . . =T G Hadano-city K ] 144.58...
successfully established, the [IDLE] indicator will change to the = o= H:c:i"oj}.‘;ty TZTS?W J:§:: 144.52...
[NET] indicator =R O Yokohama-city  Kanagawa Japan
Also, the connection status will be shown in the log window. | [ —— = state
® Releasing the connection (disconnecting)
From the “Connect” menu, click “Disconnect’. g
FiIe(F_) Wiew(V) IConnecl(IC} Tool(T)  Help(H)
+MUserlD | Eonedif ste | Cou..|Freq.. [soL [ Lat [ L.
Connect To(T)
Disconnect(D)
¥ GM Auto connect(F)
Tip
The connection can be released from the mobile or fixed station instead of controlling it from the node PC menu.
l Connecting to a room on the Internet
Connect to a room on the Internet from your node PC.
1 From the active node window, select a room you want to = Tor T et [Roomnamme Ton Tom Toou]
connect to 22005 003 TOPTEAM Miyako-city Twate Japan
. . . 22065 000 BWT Lab. Machida-city Toky J
2 Move the cursor to the selected room, then right-click on it = e

. . Connect
The command list will appear. et info

3 Click “Connect” gjg.:____f Window default
You can also click “Connect” from the “Connect” menu.

ROOM Chiba-city Chiba Japan
aen Ota-ku Tokyo lapan
[bo Kawasaki-city Kanagawa Japan
64 Machida-city Tokyo Japan

Add Bookmark list Room Katsushika-ku Tokye Japan

. . L L e} wfNf%ofu  Narita-city Chiba Japan
The connection will be initiated, and when connection is g Node Reject I Kobe-city Hyogo  Japan
. . . . 24758 000 FEWDKFAFM f.fA-"0 N -cil Aichi J

successfully established, the [IDLE] indicator will change to the 2050 000 FENDKANF T P Neochy  Aem

i i o[ e—— 20341 000 Test Kasuya-gun Fukuoka  Japan

[NET] indicator. % RE=—=0m 25611 000 %hex"&"dZqRoom Ginowan-city Okinawa  Japan

A pop-up window will appear and show the room operation % Rs—=om 22099 000 MOMO Ichinosski-city ~ Iwate  Japan
status.
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Room information display area —? Room CQ-WORLDWIDE (20000) member 1 node Refresh | Close
Node ID display area ===

@

Transmission node information display area

(Room information display area) ..........cccccoeeunee. Displays the room User ID, DTMF ID and the number of activities (the number
of nodes connecting to the room)

[REFrESN] .. Click to update the active room window list on the main screen.

[ClIOSE] .ttt Click to close the pop-up window.

(Node ID display area).........cccceevneeeencrieeiinieen. Lists the IDs of nodes connecting to the room. The node which is currently

transmitting displays in green. Move the cursor to a node title and right-click
on it to show the node information.

(Transmission node information display area)......Displays information of a node or digital node which is currently transmitting.
Tip
Even after closing the pop-up window, as long as the node is connected to the room, the pop-up window can be displayed again by clicking “Connect ID
window” from the “View” menu.

® Releasing the connection (disconnecting)

From the “Connect” menu, click “Disconnect”. LI
File(F) View(V) | Connect(C) | Tool(T) Help(H)
MUser D | Bonpect{S) te | Cou..| FreqM... | SOL | Lat | L.
Connect To(T)

Disconnect(D)

¥ GM Auto connect(F)

Tip
The connection can be released from the mobile or fixed station instead of controlling from the node PC menu. For details, refer to the instruction manual
supplied with the transceiver used as a mobile or fixed node.

® Customizing the method to connect to a room
From the “File” menu of the WIRES-X software, select “Settings” - “Call settings” to set various settings to connect to a room. For
details, refer to page 82.

® Announcing the status of the room your node is currently connecting to with a voice message
From the “File” menu of the WIRES-X software, select “Settings” - “General settings” to set whether or not to transmit the voice
message when a node comes in or leaves the room (only for an analog operation). For details, refer to page 83.

I Notes on the node operation

+ Please inform node station users connecting to your node to limit their QSO individual transmissions to less than three minutes in
duration. There is a 3-minute timer on the HRI-200 that will interrupt transmission if a continuous transmission by a node exceeds
this duration of time. Even during transmission, the timer will forcibly cut off transmission of the node in use causing the voice
communication to be interrupted.

» Please inform node station users that a longer than usual interval time is required between each QSO exchange. Because
the voice is repeated via an Internet connection, a time lag must occur. If you transmit a response too soon after another node
finished transmitting a message, your node may remain in transmission status.
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J] Useful functions

® Bookmarking frequently connected nodes and rooms
On the node PC, IDs of frequently connected nodes and rooms can be bookmarked.

1 From the “View” menu, click “Bookmark-Info” = wresx |
The “Bookmark-information” window will appear. Fie(f) [View¥)] Connect(Q) ToollT) _Help(H)
G.User EotlE ' by I State I Cou‘..l Freg(M... I SQL | Lat | (L]

v Status Bar(S)

Connect ID window(T)

Group window 3
Bookmark-Info(B)
MNode-Info(M)

Room-Info(M)

Log 3
Audio adjustment(R)

News

Mabile Users list

2 In the “Bookmark” area, click [Add] (sookmarcimomaton
The “Input ID” window will appear. o

Call/Raliame [vser 10 [omer 1D |

[ Show the offline Node/Room
[~ Show the Closed Room

Help Close |

3 In the text entry field, enter the DTMF ID or User ID of a node or Mnputio
room you want to bookmark Please ioput User ID of a Hode/Room or
= . . CallSign add to a member.
Either nodes or rooms can be specified here.

4 CIICk [OK] [ Bookmark infomation - — '. '- '--
The entered node or room will be added to the list in the c mm:““ s s ‘
“Bookmark” area. P = =

5 Click [Close]

Delete

[ Show the offline Node/Room
[~ Show the Closed Room

Help Close |
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® Checking the status of the bookmarked nodes and rooms

1 From the “View” menu, click “Group window” - “Bookmark list” =wresx |

il “Bookmark list” is selected in the default setting. File(F) (View(V) ] Connect(C) Tool(T) Help(H)
. . . . . Font(F) 4
If the bookmarked connection destinations are active, they will Guser| ™" y | stete | Cou..[Freqm.. [sQU Lt [ L.
. . . L=l v | Status Bar(S) na.. Tokyo Japan

be listed in the group window. .
Connect ID window(T)
Group window » | ¥ Bookmark list
Bookmark-Info(B) Connecting Mode list
Mode-Info(N) MyRoom access list

Room-Info(M)

Log 3
Audio adjustment(R)

News

Mabile Users list

Tip

“ From the “Bookmark information” window, click “Show the offline Node/Room” to display inactive nodes and rooms in the group window.

® Text chatting with a node owner on the Internet
When you connect to another node or room, you can text chat with the connected destination owner.

1 Connect to a node or room on the Internet Chat history window
2 In the text entry field below the chat window, type a message N )
3 Click [SEND] on the right -
The message will be transmitted to the connected destination. ®
The transmitted message will be added to the top in the chat
window. Transmitted time and date, source host and destination u
host will also be shown. T i
When the cursor is inside the text entry field, pressing [Enter] on the H penlo! | a0 | o= |
keyboard can also send a message. : ' -
Text entry field
Tips

« Click [CLR] to delete the chat history from the chat window.
* The chat history is deleted by when the WIRES-X software is closed. To keep the history, select “Settings” from the “File” menu to display the “Log file
settings” screen, and then click “Node log-file save” to insert a check-mark. For details, refer to page 90.

Closing the WIRES-X software

1 From the “File” menu, select “Exit’ sy
You can also close the software by clicking [X] on the top right side of (Filel®] View®V) Connect(C) Tool™ Help(H)
the main screen. TS Cal/Rm... | City | State | Cou..| Freq(M... | SQL | Lat | L.
Export settings
Set default

Retry activation

Transceiver(T)
Settings(P)
Refresh list

Exit{E)

Tip
If “Enable WIRES-X Auto Start.” has been selected when installing the WIRES-X software, the software will restart immediately after closing the software.
If you do not want to restart the software, click the WIRES-X icon on the right part of the Windows task bar (or from the hidden indicator list), then select
“Quit” or “Auto Start” to remove the check mark.
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Using preset search channel

I What is preset search channel?

The mobile station or fixed station uses a preset channel when searching for a WIRES-X node. You can quickly find a local node by
registering (presetting) the channel frequency to the mobile station transceiver.

You can also find the nearest local node even when connecting from a mobile or fixed station at a place different from your usual
location, by using the preset search channel.

Operated by
1 digital transceiver
using 1 frequency

Preset search
channel T A
o
D
E—

Operated by
2 digital transceivers
using 2 frequencies

Operated by
1 digital transceiver

monitoring 2 frequencies
simultaneously

Caution

The preset search channel function is only compatible with digital communications in C4FM format.

J] Setting the preset search channel
There are two methods to operate a WIRES-X node using a preset search channel:

® When operating with 1 transceiver

Connect the C4FM digital transceiver to the HRI-200 RADIO 1 jack (See page 14).

When in the standby state, the preset search channel and the voice channel are monitored alternately.

When the node connects with another node or room, monitoring of the preset search channel is suspended and only transmitting/
receiving via the voice channel is performed.

® When operating with 2 transceivers

Connect a C4FM digital transceiver for the voice channel to the HRI-200 RADIO 1 jack, and also connect a C4FM digital transceiver
for the preset search channel to the HRI-200 RADIO 2 jack (See page 14).

When in the standby state, the preset search channel and the voice channel are constantly monitored in a receive-ready state.
When a signal is received on the preset search channel, the voice channel information is transmitted to the mobile or fixed station of
the sender.

Even when the node is connected with another room or channel, the monitoring of the preset search channel continues.
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l Setting the preset search channel

The local node operation method is selected by setting the operation mode of the WIRES-X software (See page 23).
jilad If you connected to the DR-2X/XE or DR-1X/XE, refer to the “HRI-200 Reference Manual for DR-2X/XE or DR-1X/XE”.

® Operating with 1 transceiver

Transceiver

In the “Transceiver” area, select “RX:DIGITAL - TX:DIGITAL”. This voice cx _ Preset Searen Ca
permits setting the “Dual Receive Timing” and “Preset Search CH”. : T
In the “Operatlon mode” area, SeleCt “Dual Rcv"_ rnnu;wu DST  E/W version Transceiver DST  E/W version
FTM-400D= [ = [Fru-so00= [ =
| | vomtacion  [orgzear Operation [Dual Receive. f
Frequency m?ﬂﬂ Frequency Wm,
cimMdetect [ -] Cimddetect | |
D-1D 00 ~][o0 <] D6-1D [oo =]fo0 =
Bnalog SQL  |NoTone v Power Low v
Tone s [ e85 o] N y
2es fozs =]
Power m
Offset Az

W

Uplink (RX) =438.040MAz

¥ Reverse Downl ink (TX) =438 .040MHz

[V Hide frequecy settings

f oK Cancel | Apply I Help
|

® Operating with 2 transceivers

Transceiver

In the “Transceiver’ area, select “RX:DIGITAL - TX:DIGITAL”. This Voice c Presec Search Ci

permits setting the “Preset Search CH”. _ - i
In the “Operahon mode” area, select “ON”. e DST  E/W version Trensceiver DST  E/W version
FTN-400D= [ = [Fru-so00= [ =
=== = e | f
Frequenc; 438.040 Frequenc 144.000
R e oy e
cimMdetect [ -] Cimddetect | |
26-10 00 ~][o0 <] 6-1D Joo =]fo0 =]
N i o]
Tone s [ e85 o] N y
N
Power [tow =]
offser [ e

Uplink (RX) =438.040MAz

¥ Reverse Downl ink (TX) =438 .040MHz

[V Hide frequecy settings

f oK Cancel | Apply I Help
f

Preset Search CH
® Operation mode
Displays the Preset Search CH operating mode.
* OFF: Displayed if not using Preset Search CH mode.
* ON: Displayed if using Preset Search CH mode.
I The search channel operation requires an HRI-200/ C4FM Digital control mode capable transceiver (FTM-500DR/DE, FTM-400XDR/XDE/DR/DE,
FTM-300DR/DE, FTM-200DR/DE, FTM-100DR/DE etc) connected to Radio 2 terminal of the HRI-200.
® Dual Receive Timing
Allows setting the preset search channel monitoring interval.
® Transceiver / DST / F/IW version
The firmware information of the digital transceiver connecting to HRI-200 for Preset CH operation is displayed.
® Operation
Displays either “Dual receive” or “ON: Digital” in accordance with the operation method selected by the “Operation mode”.
® Frequency (Preset Search CH)
Enter a unique WIRES-X Preset Search operating frequency in MHz.
In practice, consult with other WIRES-X stations to select a suitable frequency that will effectively avoid interference.
® Narrow deviation
Select if using Narrow deviation operation for Preset CH transceiver.
® DG-ID (Digital Group ID)
Enter the DG-ID number setting for the WIRES-X Preset Search CH operating frequency.

By setting the DG-ID number to "00", the station becomes an open node station, and can be connected from all transceivers with the WIRES-X
DG-ID setting “AUTO". When using a node station in a restricted group, set the DG-ID to a number other than "00", and then set all the group
transceivers to the same DG-ID number.

® Power (Preset Search CH)
Set the transmission power of the WIRES-X Preset Search CH operating frequency.
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Opening a room

] What is a room (Round QSO Room)?

Advanced Operations

This refers to community space on the WIRES system to which multiple nodes and stations can connect simultaneously. Operators
from multiple stations can freely engage in conversation, just like in a face-to-face meeting or party. There are open rooms that are
accessible to all members and closed rooms that only allow registered stations to connect.

A Room may be opened by the owner of a WIRES-X node. It is the owner’s responsibility to manage and control their own room.

One room may be opened per node.

ol
=
«4@.
HRI-200 WIRES
A
/\ server
S Jg¢—

AY
JATXXX S
-S1

J] Opening a room

D
=
JF7XXX
/i -ND3
l,l s\‘
% JQ1YBF-ND1

When the local node checks
into a room, the connected
station also checks into the
room accordingly

JHAXXX
-ND4

JA2YSO-ND2

HRI-200

JA2-ROOM 7

JQ1YBF-ND1 A
JF7XXX-ND3 0l
JATXXX-S1

-S2
*Currently 3 activities
in this room

Operators who have registered with the WIRES-X server are issued a node ID as well as a room ID.
As long as the WIRES-X software is installed onto your computer and you have opened a node, you may also open a room. No

special tools are required.

-

Start the WIRES-X software

From the “File” menu, click “Settings”
The “Settings” window will appear.
Click “Round QSO room settings”

The “Round QSO room settings” screen will appear on the
“Settings” window.

Click [Setup]

The “Room Open” window will appear.

Put a check-mark in the “Room Active” box

Click [Room Activation]

Room information is sent to the WIRES-X server.

Once verified, your room becomes active.

Click [OK]

The settings will be saved and the “Settings” window will appear
again.

o O

Room Cpen

¥ Room Bctivel

Serial No DIMF ID Room ID(Max 16Bytes)

style News setring
+ open

{" open(Digital)

@ ALL OK

" Download only
€ Closed

€ @S0 only

C

Input New Room ID.

Room Activation Cancel Help
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J] Setting the room

The various room parameters may be set as desired.

® Setting basic information
1 From the “File” menu, click “Settings”
The “Settings” window will appear.
2 Click “Round QSO room settings”
The “Round QSO room settings” screen will appear on the “Settings” window.
3 Input or select the necessary items
4 Click [OK]
Saves the settings and closes the “Settings” window.

. — _ S -
Settings — . — —

Settings Round QSO room settings

E-Personal settings
WIRES ID information
Location settings User 1D DIMF ID

— = s
- Property
HRI-200 setup
(K[ Call settings Room Name
I General settings ,—

Digital ID settings
I Make list file Comment

I Log file settings |

[ Confidential ID

[ QSL exchange (SIZE QVGA 320x240bmp)

h | s
.' Room information (MAX 200 Characters)
j |
| oK | Cancel Help
UserID ..o Access code (Room ID) of your room for the digital station
DTMF ID ..oooiiiiiieeeeec Access code of your room for the analog station
[Setup] ..o Clicking here allows you to change the room ID and operation styles.

Room Name Entered text appears in the “Room name” column of the room list of the WIRES-X server.

Comment............c...... Entered text appears in the “Comment” column of the room list of the WIRES-X server.

Confidential ID.........cccoeviienennn. Putting a check-mark here keeps information from appearing in the room list of the WIRES-X
server.

QSL exchange.........cccccceevnienns Putting a check-mark here makes the QSL card images that were sent from the connected

destination node or room appear, and allows QSL card images to be sent from your room to
the connected destination. Clicking on [...] allows setting the QSL card image file to be sent.

Room information ...................... Entered text appears by the “Get Info” function of the room list of the WIRES-X server.

Tip
“ For details on QSL card images, refer to “Displaying QSL card images” (page 63).
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® Procedure for organizing a room

1 Click [Setup] in the “Round QSO room settings” screen on the “Settings” window
The “Room Open” window will appear.

2 Input or select the necessary items

Click [Room Activation]

The changed information is sent to the WIRES-X server.

4 Click [OK]
Will save the settings and the “Settings” will appear again.

w

r ~
Room Open - e
[V Reom Activel
Serial No DIMF ID Room ID(Max 16Bytes)
Syl Hews setting
& Open @ BLL 0K

" Open(Digital
Oper (Big: ! " Download only
€ Closed

o QS0 only

Input New Room ID.

Room Activation Cancel Belp

Room Active .......cccccoovieeiiiins Putting a check-mark here allows you to make your room active.
Un-checking the check-mark here stops operation of your room. (Default setting)

Serial NO........ocoiiii Your HRI-200 serial number (unchangeable)
DTMF ID ..o Your node access code for the analog station (unchangeable)
Room ID ..o Access code of your room for the digital station

You can change up to 16 alphanumeric characters. Clicking [Room Activation] after changing
the entry, sends the changed Room ID to the WIRES-X server and updates the room list.

il If the changed room ID is already in use, clicking [Room Activation] will cause an error message to
appear. If this happens, change the entry, and use a different alphanumeric string.

Style

Choose between three different types of room operation.
The default setting is open.

® OPEN...ccitiiiee et Selecting this will set up a room with no connection user restrictions.
e Closed....cccoveiiiiiiiieeeeeeeeee Selecting this will set up a room that can only be used by nodes or stations of registered
members.

* In closed rooms, only digital nodes of registered members can connect. To connect an analog node,
select the open-room operation.

* In closed rooms, the communications mode only repeats the audio of “DN” (the “DN” mode
transmits audio & data simultaneously). To repeat the audio of “VW” (the “VW” mode transmits
digital audio at the full rate), select the open-room operation.

*GM. i Selecting this sets up a GM dedicated room that can only be utilized by nodes and stations
registered as GM operation members. This is only selectable when the operation mode of the
node (See page 23) is a “Digital” (1 station configuration) is set.

In GM rooms, the communication mode that can be repeated is limited to the audio of “DN” or the
digital data (excluding images) of “DW” (mode that only transmits data).
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News setting

The following 3 options are selectable for setting how the digital stations and other nodes can utilize the news station function
of the room.
* The default setting is upload /download.
* For details, refer to “Using the news function” (page 55).

CALLOK ..o Allows connected destinations to download/upload news data from/to your room.
* Download only........ccccuvvvvvennnes Allows connected destinations to only download news data from your room.
* QSO ONlY....oviiiiiiieiie Prevents connected destinations from accessing news data from your room.

EMG Voice data (emergency information voice data) can be uploaded/downloaded at any time.

Tips
« The owner who has opened the room can also connect.
» The room system operates on the computer running the Owner’s WIRES-X software.

® Registering nodes as members of your room (when running as a closed room)

1 From the active node window of the main screen, place the

. ) +AUserD | DT.. | Callsign [ City [state | Cou...| Freq(... |
cursor over the node and right-click D Amme AT === —wme Yatomi-city Aichi Japan  144.5L..
. . oy | ATET T B . AT Yokkaichi-city Mie Japan 430.78...
The command list will appear. IO ST i e pagieg. Mara Japan. T443L
: « » = Connect ceki-city Yamagu.. Japan 43867..
2 CIICk MyROOm member GetInfo n Okayama Japan 43030..
The node will be added as a member of the room. Window default *;t';'“ pma- j:;:: e
« From the “View” menu, clicking “Room-Info” allows you to confirm Add Bookmark list fty Miyagi  Japan 43090..
the registered members from the “MyRoom information” window that Node Reject pacity  Fukushi.. Japan 43077
9 Yy Tialds ty Hokkaido Japan 14452..
will be displayed. MyReom member tity Ishikawa  Japan 14588..
T e FURQT- Gty Fukui Japan 430.82..

» The member registration procedure is the same for a GM room as o = = Kensmwacity  Dshikaws  Japan 144.50..
well (See page 46). L= tae 5y Kanazawa-city ~ Ishikawa Japan 430.76..

® Registering stations as members of your room (when running as a closed room)

1 From the "View” menu, click “Mobile Users list x e
The “Mobile Users list” window will appear. File(F) [View(\)] Connect(C) Tool(T) _Help(H)
G.User EotlE g [state | Cou..| FreqiM.. | 5QL | Lat | L.

v Status Bar(S)

Connect ID window(T)

Group window 3
Bookmark-Info(B)
MNode-Info(M)

Room-Info(M)

Log 3
Audio adjustment(R)

News

Mobile Users list

N

Select a station Mobile Users list e — _——
- - -

Click [MyRoom member]
+CallSign Radio ID | Last received time Recv CH | Last position
The station will be added as a member of the room. — — 1 TIERE =CHI

* From the “View” menu, clicking “Room-Info” allows you to confirm
the registered members from the “Room-Info” window that will be
displayed.

» The member registration procedure is the same for a GM room as
well (See page 46).

w

MyRoom member Node reject idd BN member Help | Close

I Quitting the running of a room
From the “Room Open” screen, remove the check-mark from the “Room Active” checkbox and click [OK].

L2 w7 o7 = 2 - 39
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l Important Room Operating Considerations

 Inform node station users who connect to your node, to limit their QSO individual transmissions to less than three minutes in
duration. There is a 3-minute timer on the HRI-200 that will interrupt a continuous transmission of a node that exceeds this time
duration. Even during the transmission, the timer will forcibly cut off the node transmission causing the voice communication to be
interrupted.

« Inform station users who connect to your node, that a longer-than-usual-time duration is required to exchange QSO contact
direction. Since the voice is repeated via an Internet connection, time lag will inevitably occur. If you transmit a response too
quickly after another node finished transmitting a message, your node may remain in the transmission status.

» When open squelch of the connected node station occurs, or a signal from an unknown local station is present while WIRES-X is
operating, all of the nodes connected to the room will remain in transmission status; this can be a nuisance to the users. Should
this happen, the node owner can temporarily disable the connection of the node station repeating the signal that is causing trouble
(See page 42).

* When operating a room, the owner should monitor the situation as necessary to stop any nodes causing trouble.

» The quality of the Internet connection, the number of connected nodes, and strain on the computer may cause the audio quality to
degrade and the WIRES-X software to be unstable.

» Please understand that YAESU assumes no responsibility for any interference experienced between users.

J] Convenient functions
The WIRES-X software enables users to configure room operation in a variety of functions.

® Detailed setting of your room
From the “View” menu, clicking “Room-Info” displays the “MyRoom information”.
The information displayed differs depending on the room operation style (open/closed/GM).

MyRoominformation - . MyRoom information [ WS DS - . MyRoom information [ WS DS - -
—— om e —— om e —— om e
— = [ ¢ — = e — — ;
I I f e e s o I f
—— —— ——
i e
CcallSign TUser 1D [ome... | CallSign TUser 1D [omv... [Position data [Fro... |zast rece. CallSign User 1D [omv... [Position data [Fro... |zast rece.
hid vejece Tnfo | Dmtere Regecr T I 0 e veseer | oetess vemner I 3 i x| etere derbar I
| = I = | I = |
| — ™ N —— N N —— N
I Remove ID list : Remove ID list : Remove ID list
i : e T [ W T I Res
I Mate 1D list Apply : Mate 1D list Apply : Mate 1D list Apply
T T T
il il i
<Universal>

Operations style (open/closed/GM) and news data publishing method

USEr D oo Access code of your room for digital stations

DTMF ID ..o Access code of your room for analog stations

ACHVItY ..o Number of nodes currently connected (activity number)

Room name........ccccoooveeeiieennnen. The room name specified via the “Round QSO room settings” screen from the “Settings” menu
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<Open Room>

Reject list
(] R List of nodes/stations blocked from connecting
[Add Reject Info].......cccevvvvernnnn. Clicking here displays a dialog box where you specify the nodes/stations to be listed.

Place the mouse cursor over a node/station in the active list of the main screen and right-click. You can
quickly add information by selecting “MyRoom Reject” from the command list. As an alternative method,
from the “View” menu, select “MyRoom Reject” to display the “Mobile Users list” window. From this
window, select a node/station, and then click [MyRoom Reject] to add the information

[Delete Reject Info]......ccccuveeeeee. Selecting and clicking a node/station to be unblocked, removes the node/station from the list.

<Closed Room>

Member list
(LISt eeee e List of nodes/stations that are allowed to connect
[Add New Member].........ccccooue Clicking here displays a dialog box where you specify the nodes/stations to be listed.

Place the mouse cursor over a node/station in the active list of the main screen and right-click. You can
quickly add information by selecting “MyRoom member” from the command list. As an alternative method,
from the “View” menu, select “MyRoom member” to display the “Mobile Users list” window. From this
window, select a node/station, and then click [MyRoom member] to add the information.

[Delete Member]........c.ccocvveennnen. Selecting and clicking a node/station for removing permission to connect, removes the node/
station from the list.
<GM room>

GM member station information
(LiSt) e List of GM member nodes/stations

[Add New Member]..........cccc..... Clicking here displays a dialog box where you specify the nodes and stations to be listed.
Place the cursor over a node/station in the active list of the main screen and right-click. You can quickly
add information by selecting “MyRoom member” from the command list. As an alternative method, from
the “View” menu, select “MyRoom member” to display the “Mobile Users list” window. From this window,
select a node/station and the click [MyRoom member] to add the information.

[Delete Member]........c.ccocveeennnen. Selecting and clicking a node/station to be disabled, removes the node/station from the list.

<Universal>
Remove/Mute Node setting
(Input field).....cooooeeiieeeeeeee The entered DTMF ID/User ID is recognized as the node ID to be set.

[Remove] .....ccocevvieveiiieiiiicc Clicking here forcibly disables the connection of the entered ID node (room booting). The
entered ID also gets added to the “Remove ID list”.

[Mute]...oooieiiec Clicking here halts the repeating of audio from the entered node via the room. The entered ID
also gets added to the “Mute ID list”.

Remove ID list ..o The node ID whose connection has been forcibly released will appear. Click and place the
cursor, to add/delete the ID.

Reject ... Putting a check here prohibits nodes listed in the Remove ID list from connecting even when a
reconnection request is made.

Mute ID list.......ccvveeeiiiiiiieee The node ID whose repeating audio you desire to end (desire to mute) will appear. Click and
place the cursor, to add/delete the ID.

[APPIV]- oo Clicking here saves the settings and organizes the room in accordance with the settings.
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® Checking nodes connected to your room

1 From the “View” menu, click “Group window”

2 Click “MyRoom access list”
In the group window of the main screen, the nodes connected to
your room will appear.

3 Place the mouse cursor over a node and right-click
The command list will appear.

4 Click “Get Info”
The text entered by each node will appear as their node
information.

® Temporarily disconnect nodes connected to your room

1 From the main menu, place the cursor over the group window
and right-click
The command list will appear.

2 Click “Remove”
The connection to the node you placed the cursor over will be
disconnected.
Also, the node you placed the cursor over will be added to the

Remove ID list.

* The state will be the same as when specifying the node ID and
clicking [Remove] in the “MyRoom information” window displayed by
clicking “Room-Info” from the “View” menu.

* From the “MyRoom information” window, putting a check next to
“Reject” blocks repeated connection attempts.

« To disable refusal of connection, remove the ID from the “Remove ID
list” in the “MyRoom information” window.

File(F) |View(V) | Connect(C) Tool(T) Help(H)

G.User

Font(F)

v Status Bar(5)

Connect ID window(T)
Group window
Bookmark-Info(B)
Mode-Info(N)
Room-Info(M)

Log
Audio adjustment(R)
News

Mabile Users list

3

34

| state [ Cou...[ Freqmm... | sqL

| Lat [L.

Bookmark list
Connecting Mode list

MyRoom access list

File(F) View(V] Connect(C) Tool(T) Help(H)

M.User ID

| <D.. [ Act | Call/Rm... | City

| state [ Cou...[ Freqmm... | sqL

| Lat [L.

Get Info

Remove
Mute

Window default
Refresh Group List

File(F) View(V) Connect(C) Tool(T) Help(H)

M.User ID

[ +D.. [ Act [ ca/Rm... [ City

[stete [ Cou..[ Freqm.. [ sqL

[Lat [ L.

Get Info
Window default
Refresh Group List

Remaove

Mute

® Temporarily muting the audio repeated from nodes connected to your room

1 In the group window of the main screen, place the cursor over
the node and right-click
The command list will appear.

2 Click “Mute”
The audio from the selected node will no longer be repeated.

Also, the selected node will be added to the saved Mute ID list.
« The state will be the same as when specifying the node ID and
clicking [Mute] in the “MyRoom information” window that is displayed
by clicking “Room-Info” from the "View” menu.
« To disable mute, remove the ID from the “Mute ID list” in the
“MyRoom information” window.

® Retrieving your room log

File(F) View(V] Connect(C) Tool(T) Help(H)

Selecting “Log file settings” from “Settings” in the “File” menu, permits saving the room log to your PC. For details, refer to page

90.

MUserld | =D.. | Act | CallRm... [City [Stste | Cou..| FregM.. [sQL [ Lat [ L.
Get Info
Window default
Refresh Group List
Remove
Mute
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Using the GM function

] What is the GM function?

The GM (group monitor) function automatically listens for stations which are operating the GM function on the same frequency and are
within communication range. FTM-500DR/DE, FTM-400XDR/XDE/DR/DE, FTM-300DR/DE, FTM-100DR/DE, FT1XDR/XDE/DR/DE
and FT2DR/DE support this function.

When radio stations that you communicate with frequently are grouped and saved in the memory, the GM function is convenient
for sending and receiving messages and pictures, and for displaying a notification when group members enter into the sphere of
communication. The position information of the other stations can also be used for location and navigation purposes.

The GM function can also be used with the WIRES-X node for C4FM digital operation. When the node is a member of the group, the
node operating status can be checked from the mobile or fixed station. This allows you to know whether or not WIRES-X is available.
When nodes operating in the GM mode are connected to each other using WIRES-X, communications with group members becomes
possible regardless of the communication range.

l Before operating in the GM mode

® Using a C4FM digital transceiver as the node

To operate a node in the GM mode, a C4FM digital transceiver compatible with the HRI-200 mode is required.

As of Apr 2023, transceivers which can be used as a node operating in the GM mode are YAESU C4FM digital transceivers FTM-
500DR/DE, FTM-400XDR/XDE/DR/DE, FTM-300DR/DE, FTM-200DR/DE and FTM-100DR/DE. Connect one of them to HRI-200
(See page 14).

® Using only 1 transceiver as the node
The preset search channel cannot be used during GM operation. Connect the transceiver only to the RADIO 1 jack of HRI-200.

® Opening a room for GM operation

To communicate with a wide range of group members, prepare a designated room for WIRES-X GM operation.

The room for GM operation must be opened by a node that will be a member of the room, and register the mobile, fixed and node
stations as its members.

l Starting operation as a GM node

1 Start the WIRES-X software Il R
2 Click [GM] on the bottom right side of the main screen 0
The “GM (Group Monitor) Guide” window will appear.

| ONUME | [ [NUM |

3 Click [Transceiver]

GM(Group Monitor) Guide

The “Transceiver” window will appear. ~Set to G Nede opreation
You can also display the window by clicking “Transceiver” from the .. Tranacesver
“File” menu. 2. uoas operation

3. EM Room select
4 Mobile User list

Member update is performed for
@M Room.because the @ Room
menages the member informetion
collectively in WIRES-X.
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4 In the “Transceiver” area, select “RX:DIGITAL - TX:DIGITAL”.
5 Click [OK] Transceiver - - g

The “GM (Group Monitor) Guide” window will appear again. Voice CH

Transceiver |BX:DIGITAL - TX:DIGITAL j

6 Click [Node Operation]

r
GM(Group Monitor) Guide

The “User ID Change” window will appear. Sex to GH Hode opreation
You can also display the window by clicking “Settings” from the “File” 1 Tranaceiver
menu to display the “WIRES ID information” screen, then clicking 2. Node Operasion

[User ID change]. 3. M Room selecs
4. Mobile User list

Member update i3 performed for
GM Room.because the GM Room
manages the member information
collectively in WIRES-X.

N

In the “Style” area, select “GM”.
8 Click [Apply], then [OK]
The “GM (Group Monitor) Guide” window will appear again.

-
User ID Change

The dialogue is for User ID and an Operation Style, the
setting of the New function perform it.

Serial Ho DIMF 1D User ID{Max 10Bytes)
style———| [News setting
" Open F ALL 0K

€ Dowvnload only

® o © 050 only

Input New User ID.

1l Apply Cancel | Help

9 Click [Close] Y p——
Your node starts working as a GM node. | e G

6. My Room Information
7. Mobile User 1list

Setting to MyRoom information
for GM operation.

GM member of Node i3 different
from MyRoom member.

Help Close

® Connecting to a GM room on the Internet

1 Click [GM] on the bottom right side of the main screen of the J“ E |
WIRES-X software

The “GM (Group Monitor) Guide” window will appear.

| onuNE | [ [num |

2 Click [GM Room select]

,
GM(Group Monitor) Guide

The “GM Room list” window will appear. ~Set o G Node opreation
You can also display the window by clicking “Node-Info” from the 1 Transceiver
“View” menu to display the “My Node information” window, then 2. Node Operation

clicking [Select change]. 3. GM Room select
4. Mobile User list

Member update is performed for
GM Room.because the GM Room
manages the member information
collectively in WIRES-X.

W == N 44
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3 To add, click in GM Group List Windows, then proceed to step 4. TR

. e S - -
4 In the “GM Group” area, enter the name of the GM Group you S Group 11t
want to connect with in the “Room ID” box sem i _\Tt e ) R el G |Gt I
The information will be imported from the WIRES-X server
automatically, and the DTMF ID and Room name will appear.
5 Enter a desired name in the “Group Name” box
6 Click [Replace]
The entered room name will be added to the “GM Group list” [ Gzoue
Room ID DIME ID Room Name Group Name
area. | | |
« To add more GM rooms, repeat steps 3 to 5. p—
* Information such as GM room features can be entered in the LI |
“Comment” area. =
Input GM Room User ID
Cancet st
7 Inthe “GM Group list” area, select the GM room you want to T —— —
— - — - -
connect to o Group 115t
8 CIle [select] Room ID n'm.. Room. ame Group Name Comment
The connection to the selected GM room will be initiated, and
the “GM (Group Monitor) Guide” window will appear again.
« If “GM Auto connect” under the “Connect” menu is checked,
connection to the GM room will be initiated automatically when
selecting the GM room or when starting the WIRES-X software next
time. It is checked in the default setting. [ e e 25 moem e -
« If the selected GM room is not active, connection will not be initiated. = = |i-""§ =
R Replace i
Delete 1
Input GM Room User ID
Cancet st
9 Click [Mobile User list] T
The “Mobile User list” window will appear. Sex to GH Hode opreation
You can also display the window by clicking “Mobile User list” from the 1 Tranaceiver
“View” menu. 2. Node Operacion
3. EM Room select
4. Mobile User list
Member update is performed for
GM Room.because the GM Room
manages the member information
collectively in WIRES-X.
10 Select the mobile station you want to add as a group member obte e e I
11 Click [Add GM member]
+Callsign | Radic ID | Last received time |Recv Ci | Last position
The mobile station selected as a member of the GM room you == = WA e VoEHI
are currently connecting to will be added.
You can add group members only while connected to the GM room.
12 Click [Close]
The “GM (Group Monitor) Guide” window will appear again.
MyRoom reject Node reject Add GM menber Export Help Claose |
L
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® Disabling the connection to a GM room

1 From the “Connect” menu, remove the check-mark from “GM ~wresx

Auto connect” File(F) View(V) [Connect(C) | ToolT) Help(H)
The connection to the GM room will be disabled. MUserD | E“”“E‘f’ﬂ te [ Cou.|FreqM.. [SQL [ Lat L.
onnect To(
Ll Insert a check-mark again to reconnect to the previously connected Disconnect(D)
GM room.
v GM Auto connectiF)
To connect to another GM room, select the GM room from the “GM

Room List” window, then insert a check-mark to “GM Auto connect”.

® Using the SYNC function

With the SYNC function, each member’s information can be synchronized among fellow transceivers operating in the GM mode.
With WIRES-X, the GM member information is managed in the GM room. Starting SYNC transmits the member information from
the nodes operating in the GM mode to the GM room. Then, the GM member information is updated and transmitted to each node
connected to the room.

+ Starting SYNC
1 Click [SYNC request] on the bottom right side of the main
screen of the WIRES-X software

[SYNC request] appears only while the node is connecting to the GM
room as the GM node.

GM synchronization requests will be sent out to each node
connecting to the GM room.

The member information sent from each room will be repeated
to the GM room.

Then, the member information will be updated in the GM room ToNmRE [ [ oM |
to transmit to each room member connecting to the room. Your

own information will be updated here as well.

SEND | GLR

Y SYNC request

* Responding to a SYNC request
If a GM synchronization request is sent from a node while you are connected to the GM room as the GM node, the dialog box to
confirm whether or not to send out the member information will appear.
Clicking [Enable SYNC] sends out the member information you have to the node in return.
Then, the GM room will transmit the updated member information. Your own information will be updated here as well.
* To exit without transmitting the member information, click [Cancel]. The dialog box will close without transmitting the member information.

* GM synchronization requests are retained for 20 seconds. If you do not click [Enable SYNC] within 20 seconds, the dialog box will close without
transmitting the member information.

l Opening and organizing a GM room on your station

1 Click [GM] on the bottom right side of the main screen of the J|i o

WIRES-X software o
The “GM (Group Monitor) Guide” window will appear.

| onuNE | [ [num |

2 Click [Room Operation] 25 o ) Lo o
The “Room Open” window will appear. 5. Foom Operatian
You can also display the window by clicking “Settings” from the “File” 6 My Roam Information

menu to display the “MyRoom information”, then clicking [Setup]. 7o Mobile Dser list

Setting te MyRoom informaticn
for GM operation.

@ member of Node is different
from MyRoom member.

Help Close
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3
4
5

9

Put a check-mark in the “Room Active” checkbox

In the “Style” area, select “GM”

Click [Room Activation]

The WIRES-X server information will be updated.

Click [OK]

The “GM (Group Monitor) Guide” window will appear again.

Click [My Room Information]

The “MyRoom information” window will appear.

You can also display the window by clicking the “Room-Info” from the
“View” menu.

Click [Add New Member]
The “Input ID” window will appear.

Enter the node ID or call sign of the mobile station

10 Click [OK]

The node or mobile station will be added to the list in the “GM
Member list” area.

11 Click [Close]

The “GM (Group Monitor) Guide” window will appear again.

-
Room Open
¥ Room Active
Serial No DTME ID Room ID{Max 16Bytes)
Style News setting———
 open @ ALL 0K
f
€ Closed  Download only I
l
I (ke " (S0 only
Input New Room ID.
Room Activation Cancel | Help
Set to GM Room opreation
5. Room Cperation
€. My Room Information
7. Mobile User list
Setting to MyRoom information
for GM operation.
GM member of Node is different
from MyRoom member.
Help Close
F - - - - -
e Y W ™ - -
Status User 1D DIMF 1D Activity
=== GM Room === |JQ1YBF7300M3 |25900 0
News setting > ALL OK
Room name
[ GM Member list
callSign [User 10 [ oTM... [ Fosition data Fro... | Last rece..
JQIYEG/1 ECOM-NODEL 25931
« i v
2dd New Member Delete Member |
-
Input ID
Please input User ID of a Node or CallSign of
2 mobile station to add to a member.
oK | Cancel |
| o il v
2dd New Member | Delete Member |
I
\| [ RemovesMute Hode setting A
|
I Remove Mute
|
L fl
| Remove ID list
Reject
l | " Rej !
I Mute ID list 2pply i
I "
i T |
L b
i Help i

47
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12 Click [Mobile User list] 5 o ) e e
The “Mobile User list” window will appear. S.  Foom operation
You can also display the window by clicking “Mobile User list” from the §: ¥y Room Tnformavion

“View” menu. 7. Mobile User list

Setting to MyRoom information
for GM operation.

GM member of Node i3 different
from MyRoom member.

Help Close

13 Select the mobile station you want to add as a group member v S L

14 Click [MyRoom member] : : : :
+CallSign | Radic ID | Last received time | Recv CH | Last position
The mobile station will be added to the list. e N —
15 Click [Close]

The “GM (Group Monitor) Guide” window will appear again.

MyRoom member Add GM member Close

Node reject

Export Help

J] Quitting the GM operation

1 Click [GM] on the bottom right side of the main screen of the WIRES-X software
The “GM (Group Monitor) Guide” window will appear.
2 Click [Node Operation]

The “User ID Change” window will appear.

You can also display the window by clicking “Settings” from the “File” menu to display the “WIRES ID information” screen, then clicking [User ID
change].

In the “Style” area, select “Open”

Click [OK]

The “GM (Group Monitor) Guide” window will appear again.
5 Click [Room Operation]

The “Room Open” window will appear.
You can also display the window by clicking “Settings” from the “File” menu to display the “MyRoom information” screen, then clicking [Setup].

In the “Style” area, select “Open” or “Closed”
Click [Room Activation]
The WIRES-X server information will be updated.
8 Click [OK]
The “GM (Group Monitor) Guide” window will appear again.
9 Click [Close]
Your node will operate as a normal node, and your room will be normally open or closed.

Hw

N o

Tip
Just to quit the GM room operation, remove the check-mark from “Room Active” in step 6.
In this case, when starting to open and organize a room not in the GM mode next time, put a check-mark in the “Room Active” checkbox, then select
“Open” or “Closed”.
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Operating the WIRES-X software remotely

You can operate the WIRES-X software via the Internet from another PC (remote monitor function).

l What you can do with the remote monitor function

» Voice communication monitoring
When your node connects to another node or room, you can listen to voice communication that is being repeated.
« PTT control
Stop the node transmitting/receiving function (ON-AIR LOCK) or release the lock (UNLOCK).
* WIRES-X software reboot
» Web monitor function
The operating status and settings of the WIRES-X software can be confirmed using a web-browser (such as Internet Explorer).

l Operating the WIRES-X software remotely
The dedicated software and a PC designated for remote operations are required.

® Preparing a PC designated for remote-control operations
Prepare a PC connected to the Internet besides the node PC. It is recommended that the specification of the PC is equivalent to that
of the node PC (see page 5).

Since the communications are preformed using the node PC and the Internet, the specified UDP ports (46100, 46110 and 46122)
are used.

When using a router to connect your PC to the Internet, the UDP port must go through the router as well; however, communications
using these ports are generally prohibited on commercially available routers in the default setting.

Therefore, if you are using a router, make sure that the UDP ports are “open” for passing UDP traffic.

First, refer to “Setting an IP address on the PC” (page 15) to fix the IP address for the PC prepared for remote-control operations.
Next, register the following 3 ports for the router settings such as “NAT” or “Port mapping”: 46100, 46110 and 46112 (UDP ports).
Use the IP address already fixed on the LAN side.

For the detailed procedure, refer to the instruction manual supplied with your device.

® Getting the software for remote-control operations
The dedicated software can be downloaded from the WIRES-X website.

Connect the PC for remote-control operations to the Internet, then start up the PC
Access the WIRES-X website: https://www.yaesu.com/jp/en/wires-x/contact/owner.php
Click “Download WIRES-X Remote Control software”

Follow the on-screen instructions to download the remote monitor software

AON-=-

Caution

WIRES-II Remote Monitor Software “WIRESMON.exe” cannot be used with WIRES-X.
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l Before starting remote-control operations

Since the WIRES-X software does not to accept remote-control operations by default, the setting must be changed before remote-
control operations can begin.
Also, the Internet environment of the node station must be setup in advance to accept remote-control operations.

® Opening the communication ports

When using the web monitoring function, the PC for remote-control operations communicates with the node PC via the specified
TCP port (46190).

When using a router to connect your PC to the Internet, the TCP port must go through the router as well; however, communications
using this port is generally prohibited on commercially available routers in the default setting.

Therefore, if you are using a router, make sure that the TCP ports are “open” for passing TCP ftraffic.

Register the TCP port 46190 for the router setting such as “NAT” or “Port mapping”. Use the address set in “Setting an IP address
on the PC” (page 15) for the LAN side.
For the detailed procedure, refer to the instruction manual supplied with your device.

® Configuring the WIRES-X software setting
Set the WIRES-X software in advance to accept remote-control operations.

1 Start the WIRES-X software
2 From the “File” menu, click “Settings”
The “Settings” window will appear.
3 Click “General settings” under “Property”
On the “Settings” window, the “General settings” screen will appear.
Put a check-mark in the “Remote control” checkbox
Enter your new password in the “Password” box
Click [OK]
The WIRES-X software is ready to accept remote-control operations.

o O b

Settings _—_——

S_er.r.mgs General settings I

= Personal settings

-WIRES ID information

! | Location settings

i Round @S0 room settings TOT(TimeGut Timer) mjmn (5-60}

= Property r Announcement
;~HRI-200 setup [~ Connect request message

t.Call settings = /00T
i.General settings oom T/

I~ Unlimited TOT

\..Sound settings [~ Room logon node info
{.Make list file [~ DIMF#66666
i.Leg file settings [~ DIMF$55555

[~ DIMF * Disconnect

W Remote control

N Swsmword  [rreeeeee] |

{
| OK | Cancel Help
|

L2 w7 o7 = 2 - 50
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® Setting the dedicated plug-in
To use the web monitoring function, load the dedicated plug-in into the WIRES-X software in advance.

1 From the “Tool” menu, click “Plugin set” WIRES.-
The “WIRES plugin menu” window will appear. e e () S PRSI ki i
MUserID | <D... | Act | PRiEis [ Cou...| FregM... [ SQL | Lat | L.
Plugin set

2 Click [Add Module] [ WRES plugin menu
The window prompting you to select the plug-in file will appear. Prugtn modutes

n

Add Module

Delete Module

Property

Version Info

Ll

3 Select “WiresWeb.dlII", then click [Open] Mo O EEETEE TEITET T S
The “WIRES plugin menu” window will appear again, then in the QO === e =, Pl <arch Pl 2]
“Plugin modules” area, “WIRES WebServer” will appear. ":Ft = . e i; (m®

B Deskeop [&] WiresWeb.di T2/2014 1248 PM_ Application extens, 3608

18 Downloads
% Recent Places

A Libraries
[ Documents
& Music
[ Pictures
B videos

18 Computer
&, Local Disk ()
o data (09
&% DVD RW Drive (@) £

€ Netwark

File name: WiresWeb.dll ~+ | Wires Plugln (".dIl) -

® -——
WIRES plugin menu -

Plugin modules

WIRES WebServer —— |
Delete Module

Property
I
Version Info

[ Help | oK |
4 Click [Close] WIS
5 From the “Tool” menu, click “WIRES WebServer” File(F) View(V) Connect(C) [Tool(T)] Help(H)
The “Wires WebServer Setting” window will appear. MUserD | -D... [ Act ::':;h:;k Cou...| Freq... [sQL [ tat [ L.
'WIRES WebServer
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6 Confirm the password and the port number.

[ Wires WebServer Setting : -
il In the “Access password” box, the password registered in “Configuring
the WIRES-X software setting” is inserted automatically. PE—rrr]
7 Click [OK] Port o 5150

[¥ Remate Control

J] Operating the WIRES-X software remotely

Turn on the node device

Start the WIRES-X software

Start up the Windows PC designated for remote-control operations
Run the remote monitor software “WIRESMON-X.exe”

The main screen will appear.

A ON-=-

For details on how to use, refer to the online help of the remote monitor software.

Caution

The WIRES-X software cannot be operated remotely using WiRES-II Remote Monitor Software

“WIRESMON.exe”.
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Adjusting analog sound

Input/output sound volume on the node can be adjusted to an appropriate level with the “Preset Volume” setting. Fine adjustment
can also be made according to your preference. This adjustment is available only while operating in analog mode.

Tip

“ The volume of voice communications between digital nodes and sound data played for the news function cannot be adjusted.

l Adjusting analog sound volume

® Setting the node operating mode to analog
1 Start the WIRES-X software
2 From the “File” menu, click “Transceiver”

The “Transceiver” window will appear.
3 In the “Operation mode” area, select “Analog”
4 Click [OK]

® Monitoring analog sound
From the “View” menu of the WIRES-X software - “Audio adjustment”, display the “Audio adjustments” window where audio can be
displayed as a waveform graph.
This “Audio” has solid lines and dotted lines as indications of the input sound level.
Solid lines ...... Indicates the maximum and minimum sound volume HRI-200 can receive.
Dotted lines.... Indicates the maximum and minimum ideal sound volume.

In the “Volume” area, colored indicator bars indicate the current input/output sound volume.

Audio adjustments - - - - — - - e

Settings

Rudio

Mon.

Maximum volume

Ideal volume range

Minimum volume

Graph select Volume

Wave - starc QUTEUT (Tx) Output sound indicator
l » Announcement
s tome s =vEL ¢ [l os
‘Any frequency tone j
. J= IHEUT {Bx) Input sound indicator
Frequency: 1000 = Hz (50 - 4000Hz) IC LEVEL ﬂ J jmq Loapback p

DN:Digital Voice Norma

Tone level: 32ﬂ % (10 - 100%)

Start

Help | Close ‘

= - — — = =

® Adjusting the input sound volume
1 From the “View” menu, click “Audio adjustment”
The “Audio adjustments” window will appear.
2 In the “Graph select” area, click [Start]
[Start] will be switched to [Displaying].
When sound is received, the waveform will appear in the “Audio” area.
3 From a level adjusted FM analog transceiver (such as VX-8D or FT1DR), transmit the #1 DTMF sound in FM mode
When the node transceiver receives it, the DTMF sound waveform will appear in the “Audio” area.
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Advanced Operations

4

In the “Volume” area, click [ «] or [»] of “MIC LEVEL”
In the “Audio” area, the top of the waveform will move up/down.

When adjusting, make sure that the wave amplitude stays within the dotted lines.
You can also adjust by dragging the slider in the bar.

® Adjusting the output sound volume

1

o bhw

From the “View” menu, click “Audio adjustment”

The “Audio adjustments” window will appear.

In the “Graph select” area, click [Start]

[Start] will change to [Displaying].

From another FM analog transceiver (such as VX-8D or FT1DR), transmit the #1 DTMF tone

On the node transceiver, check the input sound

In the “Test tone” area, click [Start]

A test tone is transmitted from the node transceiver, and in the “Volume” area, the “OUTPUT” indicator bar will appear.
[Start] will change to [Transmitting]

In the “Volume” area, click [ €] or [»] of “SP LEVEL”

Adjust the audio to a similar volume level to the sound you checked in step 4 making sure there is no distortion or abnormal

sound.
You can also adjust by dragging the slider.

In the “Test tone” area, click [Transmitting]
Transmission from the node transceiver will be stopped.
[Transmitting] will change to [Start].
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Using the news function

] What is the news function?

This feature allows digital data text, images and audio data to be saved on the WIRES-X node PC. The data can then later be read
from the connected digital stations and and other nodes.

The digital stations and nodes can access the data storage area (news station) of the connected node or room and upload/download
the various types of data.

Text messages, images or audio data can be shared. In the event of an emergency, audio messages can be transmitted to Group
Members.

The WIRES-X server also has its own news station where you can read digital data (INT NEWS) provided by YAESU.

JQ1YBF-ND1 PC e PC JA2YSO-ND2
AN\
N
HRI-200 WIRES |
S server ! \
Z \\ )’)
. S Sany——3
Local news INT news JA2-ROOM
Ay
S Audio messages Audio messages &
.

JATXXX s || (emergency) (emergency) Local news A0
-S1 “MINews Station News Station Audio messages e
Audio files Audio files (emergency)

Connecting to a node Text data Text data N Sgt ti Y.
allows access to data Images Images Ae‘g's f'la ion
inthe local node, the WIRES-X |+~ b=—7/——== | - Tu ‘IC; |tes
server, nodes or rooms Iex ata
on the Internet mages

Data on the WIRES-X
server is only available
for downloading

Data stored and published by a WIRES-X node or room is called “NEWS”. The NEWS is categorized into the following 3 types.

LOCAL NEWS ... Data stored and published by your station (node/room)
Access to the data on your node or room from other digital station and nodes, can
be permitted by selecting from the options: upload & download; download-only, or
access denied.

NEWS STATION....cooiiiiieeiiee e Data stored and published by a node or room on the Internet
Depending on the publisher’s setting, the data may be upload & download, or
download-only.

INT NEWS ... Data originated and published by YAESU
For download-only

The following types of data can be handled:

TEXE e Up to 80 letters in TXT format
Picture ....oooooeeeeeee e Image resolution of 320 x 240 or less, 40 kB or less in JPEG format
Voice/EMG VOICE ......ooeviiiiiiiiiieiiiiiiee e WAV format data
16-bit monaural, length less than 1 minute long, size less than 1 MB data is
recommended.

Tip
“EMG Voice” emergency information is audio data that is stored separately from the routine audio data. For the first 2 hours after the emergency data is
uploaded, the “EMG Voice” message is automatically transmitted every 5 minutes via the connected node or room. After 2 hours, the data will be deleted
automatically.
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Useful Functions

J] Organizing your news station

You can register/delete local news data from the node PC, and also store backup copies of news station data.

® Checking the news data of your station

1 From the main screen of the WIRES-X software, Click [News] “.

S| ol |

on the bottom right side of the screen News

The “News list” window will appear.

You can also access the News List window by clicking “News” from
the “View” menu.

2 From the tree display, click “Local News”

The news data of your station will be shown in the list display area on the right.
All data in the storage location (node/room) selected from “Local News” in the “View select” area will appear.

e
News list

File(F)
~View select
Local Type el |
¥ Hode [ Texc [ M6 Voice Refresh
v ¥ eicture
v
Foem W voice G News
Local Wews Total : 1
[ News Data —Date/Time | From [ 1vpe | sup3ect | size[ Position | Qutput
E-LDCEI News !,Zﬂlﬂfﬂ'lfll 17:14:40 T Text Welcome t... 20 -:-- ... Node

i INT News
l i.Downloaded News

3 Select data from the list, then double-click on it e ] J g
The “News” window will appear and the data content may be == [estaromiz teisao
viewed. = e
You can also display the window by selecting data from the list, right T ===
click on it to display the command list, then selecting “Display details”. @ Hode & Texs
When audio data is selected, [Play] appears in the “News” || e :Zm
window. Clicking it transmits audio from the node transceiver. £ EMG Voice

Click [Stop] during playback to stop transmitting.

Subject |Welcome to our r

[ Text data

‘Welcome to our r
oom!

Eelj
4"' f

4 Click [Close]
The “News List” window will appear again.

| ONLINE

[Num |
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Tips
« From the “View select” area in the “News list” window, you can select and sort the data types to be displayed in the list.
« By clicking the column title (such as “Date/Time”, “Type” or “From”) in the list display area, you can change the sort order of the list.

® Registering text as news data of your station
1 In the “News list” window, click [Input]
The “News Entry” window will appear.

2 In the “Output” area, select “Node” or “Room” e TR W
3 Inthe “Type” area, select “Text” == |

At the bottom of the window, the “Text data” area will appear. - ,T_
4 Enter text in the text entry field. e —

Up to 80 letters can be entered.

£ Room  Picture
| " voice

" EMG Voice

Subject

[ Text data

Cancel

Belp

Il

5 Click [Set]
The data will be stored as “Local News”.

The registered data will be added to the list display area in the “News list” window.
The first 16 letters of the data will be shown in the “Title” column of the list.

® Registering an image as news data of your station
1 Prepare an image file in JPEG format
2 In the “News list” window, click [Input]

The “News Entry” window will appear.

3 In the “Output” area, select “Node” or “Room” o ] J g
4 Inthe “Tyep” area, select “Picture” = |
At the bottom of the window, the “Subject” area and “Picture :“t IZ_ =
data” area will appear. — Type
5 Enter text in the “Subject” area o L
Up to 16 letters can be entered. | izm
6 Click [...]

The window where you specify the file will appear.
You can also enter the file path directly.

Subject
 Picture

| -]

i Cancel

0l

Help
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7 Select the file, and then click [Open]
The “News Entry” window will appear again, and the specified

file path will appear.

You can specify images with resolution of 320 x 240 or less, 40 kB or
less in JPEG format.

8 Click [Set]
The data will be stored on “Local News”.

5 Open

et

- - .

OOV' ) » s ) My Documents » WSS we S
— —

-4 Lssm»- Piugin o]

Organize ~

.0 Favorites
B Deskiop
18 Downloads

% Recent Places

i Libraries
[%) Documents
& Music
=] Pictures

B videos
% Computer

&, Local Disk (C)
s data (D7)

€ Network

New folder

&% DVD RW Drive (@:) #

)

Name ° Date modified Type Size

No items match your search.

File pame: Y ~ | IPEGFile ("jpg) -

The registered data will be added to the list display area in the “News list” window.

® Registering audio data as news data of your station

1 Prepare an audio file in WAV format

2 In the “News list” window, click [Input]
The “News Entry” window will appear.

3 Inthe “Output” area, select “Node” or “Room”

4 Inthe “Tyep” area, select “Voice” or “EMG Voice”
At the bottom of the window, the “Subject” area and “Voice data”
area will appear.

5 Enter text in the “Subject” area
Up to 16 letters can be entered.

6 Click [...]

The window where you specify the file will appear.
You can also enter the file path directly.

7 Select the file, and then click [Open]

The “News Entry” window will appear again, and the specified file

path will appear.

* You can specify data in WAV format. 16-bit monaural, with a length of
less than 1 minute; a file size less than 1 MB data is recommended.
In the case of EMG Voice, only registration of a 16 bit 8 kHz sampling
(monaural) wav file is possible.

« Clicking [Play] transmits the audio message from the node transceiver.

Click [Stop] during playback to stop transmitting.

r
News Entry

IE:( ew )

From =T

Position |N:; -

!
 Node

£ Room

 Picture
@ Voice

" EMG Voice

Subject |

Voice

Play Jtop

i Cancel

Help

0l

5 Open

==

- - ‘

OOv| ). » == b My Documents » MEESSE w Samm

~ [+ |_5w:)~ Plugin o]

Organize ~

/¢ Favorites
Bl Desktop
18 Downloads

% Recent Places

' Libraries
[Z) Documents
& Music
[ Pictures

B videos
M Computer

&, Local Disk ()
a data (D)

€ Network

New folder = v

€ DVD RW Drive Q1) £

]

Name Date modified Type Size

No items match your search.

File name: « | [WAVE File ("wav) -
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8 Click [Set]

The data will be stored on “Local News”.

The registered data will be added to the list display area in the “News list” window.

Tip

“ Up to 5,000 news data files can be registered with your node and room in total.

® Deleting the news data of your station

1 Display the “News List” window

2 From the tree display, click “Local News”
The news data of your station will be listed in the list display area on the right.

3 Place the cursor over the data you want to delete and right-click on it

The command list will appear.

-
News list

File(B)

View sel

Local
¥ Node
¥ Room

|

Type
¥ Text ¥ EMG Voice

¥ eicture
¥ voice

Input

[ |
—
o |

G News

Local News Total : 1

) News Data
i-Local News
i INT News

f i Downloaded News

—Date/Time
- -2014/07/12 17:14:40

Help Close

4 Click “Delete”

The pointed data will be deleted from the list.

® Organizing the news data of your station
The WIRES-X software assigns control numbers automatically to data files registered with “Local News”. Data files can be registered

until the control number reaches 60,000.

Since control numbers of deleted data will not be reassigned to other data, the control number may reach 60,000 even when less

data files are shown in the list.

However, following the steps below allows you to reassign numbers to data with control numbers of over 50,000.

1 Display the “News list” window

2 Scroll the list to the right until the right end is displayed
3 Inthe “No.” column, confirm the largest number is over 50,000

¥ EMG Voice

Input

Refresh

Gl News

il

Local News Total : 2

From

[1vee [ subzect

size | Posizion | output

[ wo.

24 T

Text. test

Text. Welcome ...

4 -:-- ... Yode
20 -:-- ... Yode

00002
00001

= === Data control number
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4 From the “File” menu in the “News list” window, select
“Renumber”

This is not selectable when the largest control number is not over
50,000.

The dialog box will appear prompting you to restart the
WIRES-X software.

5 Click [OK]

The WIRES-X software will close.

Start the WIRES-X software

In the “News List” window, display the right end of the list
The reassigned control numbers will appear.

~N o

® Useful functions

r
News list

From the “File” menu in the “News list” window, news data can be saved and deleted.

« “Backup”
All data in your news station can be stored together on a
desired location of your node PC.
This may helpful when exchanging the node PC to a new
computer.

» “Restore”
Backup copies can be imported.
This may be helpful when exchanging the node PC to a new
computer.
If the DTMF ID of the files to be imported and that of the node
are different, restoration cannot be performed.

« “All delete”

Data shown in the “Local News” list can be deleted all at once.

Local News
INT News
Il Downloaded News

File(F)
Backup
Restore Type Input
Al delete
[V Text [V EMG Voice Refresh
Renumber
v [V Picture
v
Racm ¥ Voice G News
Local News Total : 2
= News Data | Fzom [Tyee [ Ssaject | size[Position
~Local News 2 17:20:24 T Text test .- 4 —re- Ll
- INT Rews 2 17:14:40 JEm=T  Tesmt Welcome t... 20 -i—- ...
I ~. Downloaded News
|
ki
ff
fl
il
r
News list
File(F)
Backup
Restore T Input
Al delete
[V Text ¥ EMG Voice Refresh
Renumber
4 [V Picture
v R
oo IV Voice GH News
Local News Total : 2
E Hews Data [ From [ 1ype Subject. | size[ rosition

2 17:20:24 ===
2 17:14:40 e o

test .
Welcome ...

4 -i- Ll
20 -1 L.
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l Viewing news data of a node or room on the Internet

You can view or listen to the news messages from the node or room on the Internet that is being accessed by a digital station
through your node.

1 Click [News] on the bottom right side of the main screen of the J|' i

[ [smo | e |
WIRES-X software
The “News List” window will appear.
The “News List” window may also be accessed by clicking “News”
from the “View” menu.
[onume [ [ hm |

2 From the tree display, double-click “Download News”

IDs of the nodes and rooms where you have viewed news data will be shown in a tree display.
3 Click the ID of a node or room to view its data

News data from the node or room will be listed in the list display area on the right.

File(F)
[View sels
Local News Type L
¥ mode [ Texc [ EMG Voice Refresh
I ¥ picture
v R
o W voice GH News
Local News Total : 2
5 News Data | -Date/Time [ Frem [ Type Subject Size[ Position [ ourp ~
i-Local News 2014/08/10 21:54:22 — Text by £ Wode
- INT News 2014/06/09 22: Text T2 Hode|
[+ Downloaded News 2014/06/09 22: Text RERNRYR Node|
- 2014/06/05 Text w0 Hode,
2014/06/05 Text kam Yode|E
2014/06/03 Text RERSRRAVU. . . Node|
2014/06/03 Text ja Hode,
2014/06/03 16: Text a3 Yode,
2014/05/08 20 Text MR Node|
2014/08/28 23: Text T Hode
2014/03/28 Text Ma Yode
2014/03/08 Text R Node
2014/02/14 Text rgdnfy Hode
2014/01/27 18:21:13 == Text ARRARA ode ~
< il '
[l

4 Click [Refresh]
If the selected node or room is currently on-line, the list will be updated to the latest version.
If the selected node or room is off-line, the list will not be updated.
When you right click the Node/Room button in the tree, a Delete button is displayed. Click Delete and then OK, to delete the News (download
history) of the chosen Node/Room.
5 Select data from the list, then double-click on it

The “News” window will appear and the data content can be viewed.
jilad If you select data that you have never downloaded, and the node or room showing the data is on-line, the data will be downloaded and displayed.

Tips
» From the “View select” area in the “News list” window, you can select and sort news station (node or room) and the data type to be displayed in the list.
« By clicking the column title (such as “Date/Time”, “Tyep” or “From”) in the list display area, you can change the sort order of the list.
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J] Viewing the news data of the WIRES-X server
From the local node PC, you can also view or listen to YAESU news server data.

1 Click [News] on the bottom right side of the WIRES-X software J| ! i

[ [smo | e |
main screen of the WIRES-X software
The “News List” window will appear.
The “News list” window may also be accessed by clicking “News” from
the “View” menu.
[onume [ [ hm |

2 From the tree display, click “INT News”
YAESU news server data will be listed in the list display area on the right.

e
News list

File(E)
[View select
Local Type Inpue
F node [ Texc ¥ EMG Voice Refresh
e ¥ eicture
./
Roon W voice G News
Lacel News Total : 2
| [=nwews pata —Date/Time | From [ 1vpe | sup3ect | size[ Position | Qutput
'l E-LDCBI News !,Zﬂlllﬂ'lllz 17:45:31 T Text 14/07/10 ... 42 -:—— ... Room
I R i tews| U 201a/07/12 17:45:09 T Text Welcome W... 15 —:— ... Room

I i.Downloaded News

Help Close

3 Click [Refresh]
The list will be updated to the latest version.
4 Select data from the list, then double-click on it
The “News” window will appear and the data content can be viewed.

Tips
» From the “View select” area in the “News list” window, you can select and sort the data type to be displayed in the list.
« By clicking the column title (such as “Date/Time”, “Tyep” or “From”) in the list display area, you can change the sort order of the list.
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Displaying a QSL card image

When connecting to a node/room on the Internet, the “View QSL” pop-up window will appear.

This window allows you to confirm the ID and call sign of the connected destination, text information set on the connected
destination, and the date/time of connection.

Also, when the setting is such that an image will display both on the connected destination and your node, the image display area
will open where images sent from a node/room will appear. By selecting an image for your node/room, the image can be displayed
on the screen of the connected node.

4 ~

View Q5L de AT IS

i Lhe Bl 153 Foie ._ :

|

DIMF ID: ==== 2014/07/12 18:19:29
JQ1YBF

< e

|I'I|
i.

HardCopy |

Tip
The following operations are available in the “View QSL” pop-up window:
« Clicking [HardCopy] imports the pop-up window as an image to the image buffer of the PC. By opening an image editing application that can edit
bitmap files, and pasting the image, allows you to save it in your desired format.
« Clicking [Save] opens the window where you may specify the name and location to save the file. The QSL card image shown in the pop-up window can
be saved in bitmap format. Information such as the ID and call sign will be saved under the same file name in TXT format in the same location.
* Clicking [Close] closes the pop-up window. This will not sever your connection.

I Displaying QSL card images

® Displaying the QSL card image of a node
1 From the “File” menu, click “Settings”
The “Settings” window will appear.
2 Click “Personal settings” - “WIRES ID information”
On the “Settings” window, the “WIRES ID information” screen will appear.

3 Put a check-mark in the “QSL exchange” checkbox e —
4 Click [OK]
Settings WIRES ID information
The settings will be saved and the “Settings” window will close. g R et . omr T coisln | et
. .. . . Location settings = — — — ]
Now, each time a node containing a QSL card image is Round 050 room sectings | | [z on
. . . B- Property City State Country
connected on the Internet, the QSL card image will appear in BRI-200 aetup [sninagava-ia [roxyo [Japan
@ s » . Call sectings Comment
the “View QSL” pop-up window. Gener ez |
u;z?;“ ;;Zmngs " Confidentiel ID
Log file settings
¥ $5L. exchange ) (SIZE QVGA 320x240bmp)}
|
Get info. text (MEX.200 characters)
[
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® Displaying the QSL card image of a room

1

Hw

Tip

From the “File” menu, click “Settings”
The “Settings” window will appear.
Click “Personal settings” - “Round QSO room settings”

On the “Settings” window, the “Round QSO room settings” screen will appear.

Put a check-mark in the “QSL exchange” checkbox

Settings

— e .
— . - -

Click [OK]

The settings will be saved and the “Settings” window will close.
Now, each time a room containing a QSL card image is
connected on the Internet, the QSL card image will appear in
the “View QSL” pop-up window.

Settings
E-Personal settings
WIRES ID information
Location settings
Round QSO room settings
E- Property
HRI-200 setup
Call settings
General settings
Digital ID settings
Make list file
Log file settings

Round QSO room settings

User ID DIMF ID

Setup

Room Name

e

Corment.

[~ Confidential ID

v (5T exchange}(STZE GVEA 320%240bmp)
Room information (MAX 200 Characters)

“ If a QSL card image is not set on the connected room, the screen for “Setting to display an image” shown on the previous page will appear.

I Transmitting the QSL card image of your station

® Transmitting the QSL card image of your node

1
2

3

4

In the “Settings” window, display the “WIRES ID information” screen
Click [...] on the bottom right side of “QSL exchange”
The window where you specify the file will appear.

[ seti e e -
etings - ———
Settings WIRES ID information
£l Personal settings
WIRES ID information Serial No. DIMF ID CallSign User ID
-Location setrings = =" = == |[vzer cnanqel
Round §SO room settings
Bl Property City State Country
HRI-200 setup |5h1nagauafku I'Inkyn |:|apan
: --Call settings Comment
General settings [
| Digital ID settings
! Make list file I Confidential ID
| Log file settings
N v S5L cxchanae |[STZE GVER 320x230bme] )
—
Get info. text (MAX.200 characters)
I -
I
I
I
! \
I
I
I
I
I
I OK | Cancel Help
I

Select a desired file, then click [Open]

The “WIRES ID information” screen will appear again. The file path will also appear below the “QSL exchange”.

You can also enter the file path directly.
Click [OK]
The setting will be saved and the “Settings” window will close.

Now, each time a node on the Internet connects to your node, the specified file will be transmitted as your QSL card image.
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Tip
The QSL card image file must meet the following conditions.

» Format: bitmap (.bmp)

* Resolution: 320 x 240

® Transmitting the QSL card image of your room
1 In the “Settings” window, display the “Round QSO room settings” screen
2 Click [...] on the bottom right side of “QSL exchange”

The window where you specify the file will appear.

‘
= | i § i =g

Settings
£l Personal settings
WIRES ID information
- Locatien settings
Round §SO room settings
[l Property
HRI-200 setup
Call settings
General settings
Digital ID settings
Make list file
Log file settings

Round QSO room settings

User ID DIMF ID

I..'_‘;Z! | == Setup

Room Name

—

Comment.

™ Confidential ID

v Q5L exchange (SIZE QVGA 320x240bmp) ) |

Room (MBX 200 Ch

I
CK | Cancel Help

3 Select a desired file, then click [Open]
The “WIRES ID information” screen will appear again. The file path will also appear below the “QSL exchange” screen.
You can also enter the file path directly.
4 Click [OK]
The setting will be saved and the “Settings” window will close.
Now each time a node on the Internet connects to your room, the specified file will be transmitted as your QSL card image.
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The WIRES-X software main screen is divided into two parts, the left side displays information of nodes and rooms on the Internet,
and the right side displays your node information, in real time.

File(F) View(V) Connect(C) ToolT) Help(H)

GUserD | +DT.. | Act | Cal/Rm.. | City | State | Cou..| Freq(MHz) | SQL [tat [ton |Comment | I.I‘ ﬁlﬁlﬂl

BE-206) =

2017/11/22 16:29:00 Transceiver Mode:Digital/Digital =
2017/11/22 16:29:00 Number of sound devices = 3

2017/11/22 16:29:00 Set Voice Mixer Device : Input=2 Gutpuc=l

2017/11/22 16:29:00  Mixer input device=Microphone (HRI-200 A(CH1)

USB Audgio codec )

2017/11/22 16:29:00  Mixer output device=Speakers (KRI-200 A(CH1) USB.

)
2017/11/22 16:29:00 HRI-200 Audis device detected.

<AUserlD | DTM... | Calisign | city [stete | Cou..| Freqiz) | sQL [t [Lon [Comm~
Kakogawa-city ~ Hyoge  Japan 430820M.. TSQ:885Hz N3.. Ed3d. =1

Kashiwazaki-city Niigata  Japan 430800M... DG-ID:36

Tokesakicity  Guama  Japan N3. EA3.

Kashiwara-city ~ Osska  Japan 144550M.. TSQ:770Hz N3.. E135. =

Kamikawa-gun  Hokkeido Japan 430780M.. DG-IDJE  Ned.. Edd2.

Kyotocity Kyoto  Japan 430820M.. DGD32  N3.. E135.
Sapporo-city  Hokkeido Japan 430840M.. DGD:05 Nk Eddl.
Kato-city Hyogo  Japan L44560M.. TSQ1230.. N3.. E13.
Fleetwood Lancashi.. UK 433675M.. DG-ID:00

Liverpool Merseysi.. UK 1440MHz DG-D00  N:5.. W00,
Arisaig Highland UK 1448375.. DGID00  N:5.. W00, -
Mandaue ity Cebu Phil. 43775M.. DG-D00  MNil.. E1B. = | I »
Larnaca Lemaca  Cyp.. 145625M.. TSQ:88.5Hz

Nicosia Nicosia  Cyp.. 145725M.. DGAD00  M:3.. E033. z
Taito-ku Tokyo  Japan

Kswsquchi-city _Saitams __Japan N3.. E1%9.. T

il ] B

e

[city [stete [ Cou...[ Comment B
Baldwin Wisconsin USA s

Kakogawa-city  Hyogo
Kilrea County
Surbiton Surrey
Kamikawa-gun  Hokkaido Jopan
Takasaki-cty  Gunma
Middlesbrough ~ North V.
Yam North Y..
Beaumont Texes
SALVADOR Bahia
Ottawa Ontario
Great Falls Montana
Fukuoka-city  Fukuoka
Morrisville Pennsyl..

SEWD_| CIR |

News oM

Ready Verl== | ONUNE

IAct ve list

The left side of the screen is divided into three windows that show lists of active WIRES-X groups, nodes and rooms.

File(F) View(V) Connect(C) Tool(T) Help(H)

GUserl) | +DT.. |Act | Cal/Rm.. |City |Stste | Cou..| FreqMHz) [ sqL [tat [ton [ comment |

Group window o

+AUserlD | DTM... [ Callsign | City [state [ Cou...[ FreqMHz) [ sQu [tat_[ton [comm
A Kakogawa-city  Hyogo  Japan 430.820M.. TSQ:885Hz N:.. Ed34
Kashinazaki-city Niigata  Japan 430.800M.. DG-ID:36
Tokasaki-city ~ Gunma  Japan E133
Kashiwara-city ~ Osaka  Japan 144550M.. TSQ:77.0Hz E135
Kamikawa-gun  Hokkaido Japan 430.780M, E142
i Kyoto-city Kyoto  Japan 420.820M E135
Active node Sapporo-city  Hoklaido  Japan  430.940M E141
i Kato-city Hyogo  Japan 144.560M E134,
window Fleetwood Lancashi.. UK 433675M
Liverpool Merseysi.. UK 144.0MHz NS, W0
Arisaig Highland UK 144.8375 NS, W0
Mandaue City ~ Cebu Phil... 437.775M N E123.. s
Larnaca lamaca  Cyp.. 145625M.. TSQ:885Hz
Nicosia Nicosia  Cypw 145725M.. DGAD0  Nu. E033..
Taito-ku Tokyo  Japan
Kawaguchi-city _Saitama __Japan N3, E139.. o
i ]
+Room ID [DTM... [ Act | Room name [ city [State [ Cou..| Comment -
@ 003 Baldwin Wisconsin  USA g
@ o001 Kakogawa-city ~ Hyogo  Japan
@ 000 Kilrea County.. UK
Active room @ Surbiton Sumey UK

Kamikawa-gun  Hokkaido Japan

N

i 000 Takasaki-city Gunma
window 003 Middlesbrough  North V...
A= 000 Yarm North V...

-1 070 Beaumont Texas
=] SALVADOR Bahia
= 005 Ottawa Ontario

Great Falls Montzna
Fukuoka-city ~ Fukuoka
Morisville Pennsyl...

2
2

Ready

The displayed information is automatically updated periodically. To update the latest information immediately, click “Refresh list” from
the “File” menu.

Tips
 Place the mouse cursor over the window border and drag to change the window width and height.
« Place the mouse cursor inside one of the windows, right-click to display the command list, then select “Window default” to make all three window heights
equal.
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H Active node window
Active nodes are listed in the window.

Each item in the list indicates the following information:

® [cons
Icons appear on the left side of each

Digital node, idling
Digital node, connecting to

Analog node, idling

GM node, idling

N@LL2PBPNAD

Muting node (appears only

® Information items
The node information consists of 11 it

column to indicate the operating mode and connection status of the node.

another node or room

Portable Digital node, idling
Portable Digital node, connecting to another node or room

Analog node, connecting to another node or room

GM node, connecting to another node or room
Off-line node (appears only in the group window when “Bookmark list” is selected)

in the group window when “MyRoom access list” is selected)

ems:

AUserD......coovveeeeiieeeee The node user ID (consisting of up to 10 alphanumeric characters). The access code for a
digital operation.
In the group window, “G.UserID” will appear.

DTMF .o The node DTMF ID (5-digit number). The access code for an analog operation.

CallSign.....vveeiiiiecece The node call sign
il In the group window, “Call/RmName” will appear.

CItY v The node location. If the node is located in Japan, the city, ward, town, and village names
appear. If the node is located outside of Japan, the city name appears.

State oo The node location. If the node is located in Japan, the prefecture name appears. If the node is
located outside of Japan, the state or province name appears.
depending on the location, this may be blank.

CouNtry .o The country name of the node location

Frequency.......cccococveviieeeicieennnen. The node operating frequency (voice channel)

SQL.iiiiiieieee e The SQL setting (DG-ID number, tone squelch frequency, or DCS code) used for the node
operating frequency.

Tips

* When the node station DSQ is “OFF”, DG-ID “00” is displayed. Node station DSQ settings 001 to 099 are displayed as “DG-ID 01" to “DG-ID 99” in

the SQL column. By setting the tran

* When using the latest firmware, a C4FM digital transceiver cannot access any node stations that are set up for DSQs 100 to 126. Please use DSQ
01 ~ 99, or update to the latest WIRES-X firmware, and set the node station to DG-ID 00 to 99. The latest WIRES-X firmware can be downloaded
free of charge by logging into the owner page on the YAESU WIRES-X web site.

sceiver DG-ID number the same as the displayed DG-ID number, the transceiver may access the node station.

Tip

The node location (latitude/longitude)
The node information, and Information set by the node owner appears.

By clicking the item name on the top of the
are sorted in descending order.

list, the list can be sorted. When “+” appears, items are sorted in ascending order, and when “-“ appears, items

® Short-cut command

Placing the cursor inside the window and right-clicking, displays the

command list of frequently used functi
main menu.

| +AUseriD | state

Tokyo

| (ou...l Freg(M...
430.96...

| o1... | Calisign | city
-l Ota-ky

ons, without returning to the

=

Japan

Connect

Get Info awa-ku Tokyo Japan

-ci Tokyo Japan 430.94..
Windou default -c?t"y Ka::gawa Jasan 43084..
Add Bookmark list ity Chiba Japan 43096..

ka-city Kanagawa Japan 430.82..
[frialee: ity Tokyo  Jepan 43077..
MyRoom Reject ama-city ~ Kanagawa Japan 438.76...
— . Wachida-city Tokyo Japan 144.55..
e Je= Katsushika-ku Tokyo Japan 430.81..
=F G Hadano-city Kanagawa Japan 144.58..
T T Hachiaji-city Tokyo Japan 14452..
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CONNECE ...eeiiieeeeeeieeeeeeeee e, Right-click and select a node, then select this command to initiate the connection to the
selected node.

You may not be able to connect to the selected node in some cases, such as when the other nod is
connecting to another node.

GetInfo....oceiiiiii Right-click and select a node, then select this command to display the information of the
selected node (such as the ID and call sign) in the pop-up window. When a node that you have
previously connected to, and received its QSL card image, is selected, the QSL card image
also appears.

Window default...........cccceeeneenn. Selecting this command divides the left side of the screen into three equal sized windows.
Add Bookmark list

Right-click and select a node, then select this command to bookmark the selected node. Set

the group window to “Bookmark list” to display the bookmarked node in the list.

Node Reject........cccveviiiiiiiiiiinn. Right-click and select a node, then select this command to register the selected node to the
connection refusal setting list. This rejects connection requests from the selected node.

MyRoom Reject...........ccoevveenen. This item appears when your station opens an open room.

Right-click and select a node, then select this command to add the selected node to the

connection refusal list to your room.

MyRoom member....................... This item appears when station opens a closed room or a GM room.
Right-click and select a node, then select this command to add the selected node to the
member list of your room.

Add GM member.............cc.u..... This item appears when your node operates as a GM node and connects to a GM room.
Right-click and select a node, then select this command to add the selected node to the
member list of the GM room you are currently connecting to.

M Active room window

Active rooms are listed here.
Each item in the list indicates the following information:

® [cons

Icons appear on the left side of each column to indicate the operating mode and connection status of the node.
Open room (Only the Digital Nodes may be connected), no node is connecting to the room

Open room (Only the Digital Nodes may be connected), nodes are connecting to the room

Open room, no node is connecting to the room

Open room, nodes are connecting to the room

Closed room, no node is connecting to the room

Closed room, nodes are connecting to the room

GM room, no node is connecting to the room

GM room, nodes are connecting to the room

2 2o0@rEE

® Information items
The node information consists of 8 items.

Room ID ....ooviiiii e The room user ID (consisting of up to 16 alphanumeric characters). The access code for a
digital operation.

DTMF ... The room DTMF ID (5-digit number). The access code for an analog operation.

AC . The number of activities (the number of nodes connecting to the room)

Roomname.........ccccooiiiiiiinns The room name set by the owner appears.

In the group window, “Call/RmName” appears.

CItY v The room location. If the room is located in Japan, the city, ward, town, and village names
appear. If the room is located outside Japan, the city name appears.

State .oeeeeii The room location. If the room is located in Japan, the prefecture name appears. If the room is
located outside of Japan, the state or province name appears.
Depending on the location, this may be blank.

CouNntry ..o The country name of the room location
Comment......cccoevcviieeiiiiiieeee The room information and Information set by the node owner appears.
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Tip
By clicking the item name on the top of the list, the list can be sorted. When “+” appears, items are sorted in ascending order, and when “-“ appears, items
are sorted in descending order.

® Short-cut command
Placing the mouse cursor inside the window and right-clicking, Lam i one ann woe wanmaeem anan nsims e
displays the command list of frequently used functions, without '
returning to the main menu.

Kitakyushu-city ~ Fukucka  Japan
82 DIGITAL Room Magoya-city Aichi Japan
E U, Q50-Room Odawara-city Kanagawa Japan
s Room Yokehama-city Kanagawa Japan
s RoomiX Mo.2 Yokohama-city Kanagawa Japan

Connect
Get Info
Window default

% 00= Add Bookmark list SZR[Yi. J—¢HC  Hadano-city Kanagawa Japan
= Node Reject |‘ﬂf<[j€ Ajzuwakamatsu... Fukushi.. Japan
@A SRENEE LA CQROOMEL famato-city Kanagawa Japan
ﬁ‘ Alll=—T"—mmme— 20509 000 ALLJACQROOME2 Komae-city Tokyo lapan
% por=—=re 22069 000 ‘+'L'z=—hDWIRES Maniwa-city Okayama Japan
@C4F1——:;A 22043 003 CAFM-JAPAN Kameoka-city Kyoto Japan
@‘ CHE=—T="—7 24730 000 CHIBA DIGITAL NET Sammu-city Chiba Japan

ConNect .....ooeiiiiiiieicece Right-click and select a room, then select this command to initiate the connection to the

selected room.
GetInfo.....ccoiiiii Right-click and select a room, then select this command to display the information of the

selected room (such as the ID and call sign) in the pop-up window. When a room that you
have connected and displayed its QSL card image before, is selected, the QSL image also
appears.

Add Bookmark list..........ccceeeuunnen. Right-click and select a room, then select this command to bookmark the selected room. Set
the group window to “Bookmark list” to display the bookmarked room in the list.

Node Reject.......cccceevviiiiieiinns Right-click and select a room, then select this command to register the selected room to the
connection refusal setting list. This refuses connection from the selected room.

Add GM Room list ........ccceeineennn This item appears when your node operates as a GM node and connects to a GM room.
Right-click and select a room, then select this command to add the selected room to the
member list of the GM room you are currently connecting to.

To confirm the added GM room, display the “GM Room List” window, by clicking [GM] on the bottom
right side of the main screen to display the “GM(Group Monitor) Guide” window, then clicking [GM Room
select].

B Group window
Depending on the selected item from the “Group window” under the “View” menu, one of the following lists appears.

Bookmark list.........ccccoveviiiiinnnnn. Displays nodes/rooms IDs that are bookmarked in advance. Nodes and rooms are listed all
together. Depending on the setting, off-line nodes and closed rooms can also be displayed.
For details on this setting, refer to ““File” menu” (page 74).

Connecting Node list .................. Displays the list of the node(s) that audio is transmitted to, when connecting to a node or room
on the Internet. When connecting to a node, only the node information will be shown, and
when connecting to a room, the information of all the nodes connecting to the room will be
shown.

MyRoom access list.................... The information of all the nodes connecting to your node will be listed.

The icons and items displayed in the list are the same as those in the active node window and active room window (See “Active
node window” (page 67) or “Active room window” (page 68)).

® Short-cut command

Placing the cursor inside the window and right-clicking displays the command list. When “Bookmark list” or “Connecting Node list” is
selected, the same command list as the active node window and active room window will appear (See “Active node window” (page
67) or “Active room window” (page 68)).
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When "MyRoom access list" s displayed, the following unique BCSEe aaa
commands will appear: File(F) View(V) Connect(C) Tool(T) Help(H)
Remove ....Move the cursor over a node to release its +MUserD [ DT.. | Act| Cal/Rm... [City [Stste | Cou..|FregM.. [SQU  [Lat [L.
connection. The same operation can be performed GetInfo
from the “Room-Info” (page 94) under the “View” S E
Refresh Group List
menu.
. Remove
Mute.......... Move the cursor over a node to stop repeating oo

its audio (muting). The same operation can be
performed from the “Room-Info” (page 94) under
the “View” menu.

J] Status indicators
On the upper right side of the main screen, icons indicate the status of your node.

(o e )
| | DuE] =)

® Operating status
Connection status to a node or room on the Internet and operating mode of your node are shown.

Digital mode, not connecting to another node
Digital mode, connecting to another node
Analog mode, not connecting to another node
Analog mode, connecting to another node
GM mode, not connecting to another node
GM mode, connecting to another node

;
i

:
8

® The ID of the connection destination
The user ID information of the node/room you are connecting to will be shown.

® Transmitting status

Shows whether your node transmits signals or not.

During digital operation (DW), or when using two transceivers; one for the voice channel and the other for the preset search channel,
two identical icons will appear. In this case, the upper icon indicates the voice channel status and the lower icon indicates the preset
search channel status.

Not transmitting
Transmitting

Clicking the upper icon stops transmission and the icon will change to the one shown below. Even when using different transceivers
for the voice channel and the preset search channel, just clicking the upper icon stops transmission from both. Also, while connected
to another node or a room, clicking the icon releases the connection and stops transmission.

Pausing transmission

Clicking the upper icon again will resume transmission and display “ON-AIR” again.
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® Receiving status

The signal receiving status of the node and the repeating status of the received signal are shown.

During digital operation (DW), or when using two transceivers; one for the voice channel and the other for the preset search channel,
two identical icons will appear. In this case, the upper icon indicates the voice channel status and the lower icon indicates the preset
search channel status.

eea  Not receiving

Ltocatl  Receiving an analog signal, or receiving an SQL signal which is not in accordance with your node setting (when using
a digital transceiver)

Receiving an SQL signal which is in accordance with the your node setting, but not repeating (when using a digital
transceiver)

Receiving a signal and repeating to a node or room on the Internet (only for the voice channel)

Tip

“ For details on the SQL setting, refer to “Settings for the transceiver” (page 76).

® Device connection status
The connection status of the transceiver(s) to the HRI-200 and to your PC is shown.

An analog transceiver is connected to the HRI-200 properly
If this icon appears even when a digital transceiver is connected, check the connection of the transceiver to the HRI-200
again.
A digital transceiver is connected to the HRI-200 properly
Two digital transceivers are connected to the HRI-200 properly
The HRI-200 is not connected or there is a problem with the connection

If this icon appears, close the WIRES-X software, check the connection, then restart the software.

® DTMF signal detection status
Shows whether the HRI-200 detects the DTMF signal or not. The icon appears only for an analog operation.

DEE]  Not detecting
OTRF Detecting

.

® Transmission timeout timer
While transmitting, the remaining time before transmission automatically stops is shown.

1 to 3 minutes left
20 to 59 seconds left
1 to 19 seconds left

No remaining time (3 minutes has passed)
“0:00” will flash.

Caution

With WIRES-X, individual transmissions must be less than 3 minutes in duration. Be careful not to make a continuous transmission longer than 3 minutes.

J] User monitoring window

Displays the information below the status indicators, of the digital node (mobile or fixed) that is accessing your node.

E= —
Uzer = TE ey tekdaklskdekk (DY)
=

Uplink = NS =
Dowmlink = { )
oom 2( 3

[2n14/0R7NT 14:2R:0T  Chamee Tramsneiver MndeiDizital -
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USEF it Displays the call sign of the sender (digital station) and the signal type (DN/VW/DW) and
Transceiver info.
When repeating audio without analog conversion, “-Direct” will appear, followed by the signal
type for a downlink station.

10 o] 1 ] Displays the call sign and DTMF ID of the uplink node.
This item appears only when connecting using WIRES-X.

DownlinK ......ccoveviiiiiiiieiicce Displays the call sign and DTMF ID of the downlink node.
This item appears only when connecting using WIRES-X.

ROOM ..o Displays the DTMF ID of the repeater room station.
This item appears only when connecting via a room.

POSItioN .....ooiiiieieeeee e Displays the sender’s (digital station) position information (latitude/longitude)
This item appears only when the received signal contains its location information.

Distance........ccocooiiiiiiiiies Distance and direction from my node to digital mobile station (If the Show position data function
is enabled.).

Tip

When your node is in an analog operation, only the digital station information transmitted from the connected destination is shown. The displayed
information is not updated while transmitting a voice message from your node to the connected destination (INTERNET lights up).

l Log window

On the right side of the main screen, the window in the middle shows the WIRES-X software operating status.

2014/07/12 18:33:46 Transceiver Mode:Digital

2014/07/12 18:33:46 Number of sound devices = 3

2014/07/12 18:33:46 Set Voice Mixer Device : Inpuc—2 Output-1

2014/07/12 18:33:46  Mixer input device=Microphone (HRI-200 A(CH1) USB Audic codec
2014/07/12 18:33:46  Mixer output device=Speakers (HRI-200 A(CH1) USB Audio codec
2014/07/12 18:33:46 HRI-200 Rudio device detected.

Depending on the selected item from “Log” under the “View” menu, one of the following items appears.

NOde ..o Displays the operating status of your node (information such as the connection status to other
nodes/rooms and the connection status of other nodes to your node).

Room ..., Displays the operating status of your node (information such as the connection status of other
nodes to your room).

NEWS...ooiiiiiiii e Displays the accessing information to the news data stored on your node PC (such as data
downloading/uploading).

l Chat window

The chat window is located on the right side of the main window. The chat history is shown in the window. There is a text entry field
at the bottom of the window where you can chat with the owner of the node or room you are connecting to.

Chat history window
11
o
H ellat | s |L‘;|
Text entry field
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Tip
Using the chat function, you can send a text message to a node or room you are currently connecting to. When connected to a room, the text message is
sent to all the nodes connecting to that room. This does not function when not connected to a node or room.

® Chat history
In the chat history window, the time and date of transmission/reception, the source host and destination host, and the text messages
are shown; the oldest messages will be deleted.

Tips
* When closing the WIRES-X software, the chat history will be deleted.
» The chat history can be saved. For details, refer to “Log file settings” (page 90).

® Text input
There a text entry field at the bottom. Place the cursor in the field and click to enter text.

® Transmitting text and deleting the chat history
There are buttons for chat window operations on the right of the text entry field.

[SEND] Click to transmit the text that is entered in the text entry field to the connected destination.
[CLR] Click to delete all the chat history (The chat history window will be blank).

J] Function window
The buttons for the useful advanced functions appear at the top of the Function window.

| .
JI [ sene | iR
News SYNG request

ONLINE | [ [num |

® News function
Clicking [News] displays the “News List” window to use the WIRES-X news function.
For details, refer to “Using the news function” (page 55).

©® GM function

Clicking [GM] displays the “GM (Group Monitor) Guide” window. Click the button inside the window to go to each setting screen
which allows you to utilize the GM function.

For details, refer to “Using the GM function” (page 43).

® SYNC function

This function is available only when operating as a GM node and connecting to a GM room.

Clicking [SYNC request] starts synchronizing the member information between mobile stations operating in GM mode.
For details, refer to “Using the SYNC function” (page 46).
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The WIRES-X software has 5 menus which allow you to access a variety of functions.

Menu bar m

G.User ID | +D... | Act | Call/Rm... | City | State

[ Cou...] Freq(M... [ SQL

[ Lt [ L. [ Comment |

“File” menu

[l Exporting/importing the settings

The setting information of WIRES-X can be saved in a file and the saved file can be imported and set all at once. This is useful when
changing the node PC to a new one.

® Exporting the settings

1

2
3

From the “File” menu, select “Export settings”

The window where you can save as a new file will appear.
Select the location where you save the file

Enter the file name, then click [Save]

A file with the extension “.wsv” will be saved.

® Importing the settings

1

2

3

From the “File” menu, select “Import settings”

The window where you select a file will appear.

Open the file storage location and select the file you want to
import

Files with the extension “.wsv” can be imported.

Click [Open]

The file content will be imported to the Windows Registry.

If the serial number in the file (HRI-200 serial number) and the
DTMF ID are not in accordance with the Windows Registry, the
file will not be imported.

Restart the WIRES-X software

xwresx |

IFiIe(F} View(V) Connect(CT) Tool(T) Help(H)

Import settings
Export settings
Set default

Retry activation

Transceiver(T)
Settings(P)
Refresh list

Exit(E)

Call/Rm... | City | State | Cou..| FreqM.. [sQL [ lat [L.

xwresx |

IFiIe(F} View(V) Connect(CT) Tool(T) Help(H)

Import settings
Export settings
Set default

Retry activation

Transceiver(T)
Settings(P)
Refresh list

Exit(E)

Call/Rm... | City | State | Cou..| FreqM.. [sQL [ lat [L.

74
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l Initializing the settings and updating the user information
The setting information of WIRES-X can be initialized and the information registered with the WIRES-X server can be updated.

@ Initializing the settings

1 From the File” menu, select "Set default xR
The confirmation dialog box for initialization will appear. [File(f)] View(y) Connect{C) ToollT) _Help(H)
EnpoReHmGy alllRm... | City | State | Cou..| Freq(M.. | SQL | Lat | L.
Export settings
Set default

Retry activation
Transceiver(T)
Settings(P)
Refresh list

Exit(E)

2 Click [OK]
The setting information of WIRES-X in the Windows Registry will
be overwritten.
Also, the WIRES-X software will finish.

r
Set Default - - -

& A set each value of WIRES-X software can be returned to
the state (Initial state) immediately after setup by
executing this Set default command.

Moreover, the WIRES-X software is shut off automatically
if the Set default command is executed.

May I execute this command ?

OF CANCEL HELP

® Recertifying the user information
1 From the °File” menu, select ‘Retry activation” s |
The confirmation dialog box for recertification will appear. [File(®] View(v) Connect(C) ToolT) Help(H)
Infzar gl al/Rm... | City [ Stste | Cou..[Freqi. [sQu [t [ L.
Export settings
Set default

Retry activation

Transceiver(T)
Settings(P)
Refresh list
Exit{E)
2 Click [OK] (et Activation )
The setting information of WIRES-X in the Windows Registry will ] o ‘
When this Retry activation command 1s executed, the server
be deleted. & registered information of WIRES-X is deleted.
Moreover, the WIRES-X software is shut off automatically
AISO’ ‘the WIRES-X software will f|n|sh if the Retry activation command is executed.

Therefore, when the WIRES-X application is started, it is
necessary to do the user registration by
"WIRES activation" again.

May I execute this command ?

OF | CANCEL | HELP

3 Restart the WIRES-X software
The “WIRES ID Activation” window will appear.
4 Refer to “Getting the WIRES-X server certificate” (page 20) to configure the node settings again

Tip
Follow the procedure above for recertification when a change occurs in the user information (such as the location) registered with the WIRES-X server.
Go to the WIRES-X website (https://www.yaesu.com/jp/en/wires-x/index.php) to apply to change the user information.
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J] Settings for the transceiver

Configure the settings such as the usage of the node transceiver and operating frequency.
il If you connected to the DR-1X/XE, refer to the “HRI-200 Reference Manual for DR-1X/XE”.

1 From the *File” menu, select “Transceiver’ e —
The “Transceiver” window will appear. Uil sy il R0
IpBEETES all/fm.. | City | state | Cou..| FreqiM.. [sQL  [at [L.
Export settings
Set default

Retry activation

Transceiver(T)

Settings(P)
Refresh list
Exit(E)
2 |If needed, change the settings or enter values
3 Click [Apply]
The settings will be saved.
« Clicking [OK] saves the settings and closes the “Transceiver” window.
* Clicking [Cancel] closes the “Transceiver” window without saving the settings.
4 Click [OK]
The “Transceiver” window will close.
r
Transceiver
rVoice CH Preset Search CH
Transceiver |RE:DIGITAL - TX:DIGITAL j Operation mode [OFF 52
Dmal Beceive timing Ilsec 'l
Transceiver DST F/W version Transceiver DST F/W wversion
FIM-400D== [ == | f |
Modulation Digital Operation OFF fl
Frequency 144.000 Mz Frequency 144.000 Mz
[ Narrow Deviation I™ Harrow Deviation
C4FM detect o C4FM detect vl
DE-ID [ili] vI DG-ID o0 -
Znalog SQL NoTone VI Power Low ~
Tone SQL 88.5 -
DCS 023 -
Power Tow -
Offset Mz
Uplink (RX)=144.000MHz
¥ Reverse Downlink (TH)=144.000MHz
v Hide frequecy settings
|
|
l OK | Cancel RApply Help
|
L = — -

Operation mode
Select one of the following 4 WIRES-X modes in accordance with your transceiver configuration.
The default setting is Analog.
 Operates only the voice channel with one digital transceiver (Digital)
Voice CH — [Transceiver] — "RX:DIGITAL - TX:DIGITAL"
Preset Search CH — [Operation mode] — "OFF"
» Operates the voice channel and preset search channel by dual-receiving with one transceiver (Digital Dual Receive)
Voice CH — [Transceiver] — "RX:DIGITAL - TX:DIGITAL"
Preset Search CH --> [Operation mode] --> "Dual Rcv"

Dual Receive Timing setting: The interval time to switch monitoring between the voice channel and preset search channel can be set
from 1 second to 15 seconds in 1 second increments. Normally, set it to 1 second.

When operating in GM mode, this mode cannot be selected.
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» Uses one transceiver for the voice channel and a second transceiver for the preset search channel (Digital Double)

Voice CH — [Transceiver] — "RX:DIGITAL - TX:DIGITAL"
Preset Search CH — [Operation mode] — "ON"
When operating in GM mode, this mode cannot be selected.

 Operates only the voice channel with an analog transceiver (Analog)

Voice CH — [Transceiver] — "RX:FM - TX:FM"
When operating in GM mode, this mode cannot be selected.

Voice CH

® Transceiver
Select the Repeater operation mode from the following:
* Digital (RX:DIGITAL - TX:DIGITAL): C4FM Digital mode
* Analog (RX:FM - TX:FM): FM Analog mode

® Transceiver / DST / F/W version
Displays the data information of the digital transceiver in connection with the HRI-200.

® Modulation
Displays the Voice CH wave format selected for repeater operation.(RX CH and TX CH)
« Digital: Displayed if using digital (C4FM) mode.
» Analog: Displayed if using analog (FM) mode.

® Frequency
Enter the WIRES-X operating frequency (Voice CH frequency) in MHz.
The entered data will be displayed on the ID list.
If the connected transceiver is HRI-200 control mode compatible, the data will be set automatically on the transceiver.

® Narrow deviation

Select if using Narrow deviation operation.
Note

This parameter cannot be set different for the RX and TX channels.

® DG-ID (Digital Group ID) / Analog SQL
Enter the squelch function of the WIRES-X operating frequency (Voice CH frequency).
The entered data will be displayed on the ID list.
If the connected transceiver is HRI-200 control mode compatible, the data will be automatically set on the transceiver.
The following squelch functions are available:
Digital Operation (The default DG-ID setting is 00.)
* DG-ID: Select the DG-ID number 00-99 (functions only in digital mode).
By setting the DG-ID number to "00", the station becomes an open node station, and can be connected from all transceivers with the WIRES-X
DG-ID setting “AUTO". When using a node station in a restricted group, set the DG-ID to a number other than "00", and then set all the group

transceivers to the same DG-ID number.
Analog Operation (The default setting is NoTone.)

* NoTone: Not using CTCSS tone or DCS code squelch.
+ ToneSQL: Using CTCSS tone squelch.
» DCS: Using DCS code squelch.

If using ToneSQL, select the desired tone frequency (67.0 - 254.1 Hz).
If using DCS, select the desired DCS code (023 - 754).

® Power
Set the transmission power of the repeater connected to the Radio 1 terminal.

® Reverse
Enables the transmit frequency offset.
* Reverse (when checked): The uplink (RX CH) input frequency information equals the downlink (TX CH) output frequency
minus the offset frequency. (Default - Offset)
* Normal (not checked): The uplink (RX CH) input frequency information equals the downlink (TX CH) output frequency
plus the offset frequency. (+ Offset)

When using a repeater, the portable terminal transceiver and transmission/reception are reversed. It is therefore necessary to use
the reverse setting (transmission frequency offset reception setting). (Default setting)
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Example 1
Uplink (RX CH) frequency = 434.700 MHz
Downlink (TX CH) frequency = 439.700 MHz
Reverse setting (Default setting) (- Offset)

Uplink (RX) = 434.700 MHz / Downlink (TX) = 439.700 MHz / Offset = -5.000 MHz

List output/search response info = 439.700 MHz - 5.000 MHz
Example 2

Uplink (RX CH) frequency = 439.700 MHz
Downlink (TX CH) frequency = 434.700 MHz
Normal setting (+ Offset)

Uplink (RX) = 439.700 MHz / Downlink (TX) = 434.700 MHz / Offset = +5.000 MHz
List output/search response info = 434.700 MHz + 5.000 MHz

® Hide frequency settings
Hide transmission frequency data. If remove the check mark, operating data, such as frequency will be displayed in the ID list.
It is checked in the default setting.

Preset search channel

Allows you to set the preset search channel operating information. For details, refer to “Setting the preset search channel”
(page 35).

] Updating the active lists

The information displayed in the 3 windows on the left side of the cwresx

main screen can be updated to the latest version. File(F) | View(V) Connect(C) Tool(T) Help(H)
Select “Refresh list” from the “File” menu to read the latest Impert settings Cal/Rm... | City | State | Cou...] Freg(M.. | SQL [ Lat | L.
information from the WIRES-X server and display in the windows. ——

If you repeat this procedure many times at short intervals, the
information may not be changed.

Set default
Retry activation

Transzceiver(T)
Settings(P)
Refresh list

Exit(E)
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| Node information settings
Allows you to set a variety of information from basic information

such as your node ID to detailed information such as transmitting/ File(F) | View(V) Connect(C) Tool(T) Help(H)

receiving operations. lnpoietinG Cal/Rm... | City | State | Cou...| Freq(M... | SQL | Lat | L.
Select “Settings” from the “File” menu to display the “Settings” B

WindOW Set default

In the “Settings” window, from the tree display on the left, click a ey petaten

. . . . . . Transzceiver(T)
desired item to display its setting screen on the right. Settings(P)
Refresh list
Exit{E)
r — - _—
Settings - - —
Settings WIRES ID information
- Personal settings
Serial No. DIMF ID CallSign User ID
ocation settings | e — ==C | == | S User 1D nhangEI
: ~-Round Q50 room settings
£l Property City State Country
L.HRI-200 setup |5h1nagawa—ku ITDkyD |Japan

all settings e
neral settings I

igital ID settings

ake list file [" Confidential ID

t.Log file settings

[~ @SL exchange (SIZE QVGA 320x240bmp)

| -]

Get info. text (MAX.200 characters)

OK | Cancel Help

[OK]: The settings are saved and the “Settings” window closes.
[Cancel]: The “Settings” window closes without saving the settings.

® WIRES ID information
Allows you to set the basic information such as comments displayed in the active lists as well as the node ID and location. For
details, refer to “Basic setting” (page 26).

® Location settings
Allows you to set the latitude/longitude of the node. For details, refer to “Basic setting” (page 26).

® Round QSO room settings
Allows you to set the information such as comments displayed in the active lists as well as your room ID. For details, refer to “Setting
the room” (page 37).
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® HRI-200 setup

o - A E R S e =
Settings - N
Settings HRI-200 setup
Bl Perscnal settings
WIRES ID information -1
Location settings SQL Active High De-emphasis
Round QSO room settings R¥in Select ,_ RE1Z v RX Filter
£l Property = Rudio Mute SW(SQL)
B RT_200 EX12 Input High
e [ 1 e scosream
i.Call sertings BX96 Input High
| e 1 g. i — [~ Pre-emphasis
I neral settinga FIT RActive Low  ~| [T Tz Filter
f Digital ID settings TXout Gain TX12 v
| --Make list file —
i.Log file sectings
I ad o ~DIMF DIMF Call cancel-
Mute mode OFF ha ﬂ A ﬂ ﬂ
DIMF detect Gain Low = ﬂﬂﬂﬂ
fl
! 2l el s <
! 2| ol 4 2
HRI-200 Information | Write |

0K | Cancel | Help

= —— - —

CH.1
Allows you to set the analog circuit operations of CH1 (voice channel).

Normally, changes are not required for the default values.
« When operating a transceiver with 10 Pin mini DIN DATA jack (such as FTM-500DR/DE, FTM-400XDR/XDE/DR/DE, FTM-300DR/DE,
FTM-200DR/DE, FTM-100DR/DE, FTM-6000R/E), to ensure proper operation, be sure not to change the default settings.
« With some FM analog transceivers, the settings may need to be changed.

SQLACHVE .....cciiiiieciicee Set the SQL input jack logic. Normally, set it to High (default setting).
High .... High with signals/Low without signals (default setting)
Low..... Low with signals/High without signals
After starting the WIRES-X software — in case when the “LOCAL” status indicator turns light,
while the squelch of the connected transceiver is closed — change this setting so that the
“LOCAL” turns gray.

RXin Select.......ccccceevviiieieein, Select the received audio input circuit (RX12/RX96) for the RADIO 1 jack of HRI-200.
Normally, set it to RX12 (default setting).
When operating as a digital station, RX96 must not be selected for a proper operation.

RX12 Input.......coooiviiiiiiiiien. Set the input sensitivity of the RX12 received audio input circuit (Low/High). Normally, set it to

High (default setting).
Communications between digital stations are not affected by this setting.

RX96 Input......ccvvvevieiiiiiiieees Set the input sensitivity of the RX96 received audio input circuit (Low/High). Normally, set it to
High (default setting).
Communications between digital stations are not affected by this setting.

PTTACtVE ..o Set the PTT output jack logic. Normally, set it to Low (default setting).
Low.....Low: in transmitting status/High: in receiving status (default setting)
High .... High: in transmitting status/Low: in receiving status
After starting the WIRES-X software — in case when the “ON-AIR” status indicator turns
green, even while signals are not transmitted — change this setting so that the “ON-AIR” turns
gray.

TXout Gain .....oeveeeeeiiieeeeeeee Set the signal level of transmitting audio output (TX12/TX96). Normally, set it to TX12 (default
setting).
Communications between digital stations are not affected by this setting.

De-emphasis .......ccceeevevevenenee... Inserting a check-mark passes received sound into the de-emphasis circuit. Normally, keep

this function unchecked (default setting).
Communications between digital stations are not affected by this setting.
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RX Filter ... Inserting a check-mark passes received sound into the filter circuit. Normally, keep this
function unchecked (default setting).
Communications between digital stations are not affected by this setting.

Audio Mute SW (SQL)................ Inserting a check-mark synchronizes the ON/OFF switch of the received audio input circuit
with the SQL jack signal. Normally, keep this function unchecked (default setting). Normally,
keep this function unchecked (default setting).

MIC BOOST (MAMP) ......c.ccu...e. Inserting a check-mark inserts an amplifier circuit into the received audio input circuit.
Normally, keep this function unchecked (default setting). Normally, keep this function
unchecked (default setting).

This function is effective for an analog operation when the received audio input level from the FM analog
transceiver is extremely low, however, using this function may cause sound distortion. Use the functions
such as the waveform monitor function to prevent the input sound from distorting by adjusting the volume.

Communications between digital stations are not affected by this setting.

Pre-emphasis .......cccccccvevenenen. Inserting a check-mark passes transmitted sound into the pre-emphasis circuit. Normally, keep
this function unchecked (default setting).
Communications between digital stations are not affected by this setting.

TX Filter. oo Inserting a check-mark passes transmitted sound into the filter circuit. Normally, keep this

function unchecked (default setting).
Communications between digital stations are not affected by this setting.

DTMF
Allows you to set the DTMF circuit detecting operations of CH1 (voice channel).
Mute mode........cccceeiiiiiiiiiins When sound contains a DTMF signal, set the functional operation to mute analog sound while
detecting the DTMF signal.
OFF .oeeiie Repeating is continued even when the DTMF signal is detected (default
setting).

Audio mute ...... While detecting the DTMF signal, mute analog sound and repeat (only the
transmitting state (PTT control) will be maintained).
Communications between digital stations are not affected by this setting.

DTMF detect Gain ..........cccoco.e... Set the input gain of the HRI-200 built-in DTMF decoder circuit signal (Low/High). Normally,
set it to Low (default setting).

DTMF Call cansel

Set the DTMF signal to be imported by HRI-200.

Signals of selected buttons will be detected. Signals of unselected buttons will be ignored.
Clicking [Write] displays “O” for the selected buttons, and “X” for the unselected buttons.
Normally, keep all the DTMF signals selected “O” (default setting).

[HRI-200 Information] ................. Click to read out and display the value set on EEPROM of HRI-200.

[Write] Click to write each configured settings on EEPROM of HRI-200.
EEPROM of HRI-200. When writing successfully, the written out value will be read out again
and displayed on the screen.

Caution
Settings configured on the “HRI-200 setup” screen are reflected on HRI-200 by clicking [Write].




WIRES-X Software

® Call settings

- -

i
i

r
Settings

P
e
LB |

- -

Sectings Call settings
£l Perscnal settings

{ L.WIRES ID information
Location settings
Round QSO room settings

[¥ Round QSO Room connection (ON:Permit/OFF:Reject)
[~ RAccept calls while in Round QSO Rooms

& Property [~ Back to Round 080 after disconnect
+-HRI-200 setup

General settings [~ Return to Room
Digital ID settings
i-Make list file B
i.Log file settings

r DTMF #55555 (Return Room cancel) command
(OH:Enable)

0K | Cancel Help

= —— - —

Round QSO Room connection.................... Set the operation when receiving a connection request to a room on the Internet.
ON (with a check-mark).......... Allows the connection to a room when requested
(default setting).

OFF (without a check-mark)... Rejects the connection when requested.
When the “Return to Room” checkbox is checked and a connection room is set,
the connection will be initiated automatically regardless of the “Round QSO Room
connection” setting.
Accept calls while in Round QSO Rooms ...Set the operation when receiving a connection request from another node while
connecting to a room on the Internet.
ON (with a check-mark).......... Severs the connection to the room and initiate the
connection to the node when requested.
OFF (without a check-mark)... Rejects the request (keeps the connection to the
room) (default setting).
If a connection request is received while nodes on the room are communicating, the
request is rejected regardless of this setting.
Back to Round QSO after disconnect.......... Set the operation when the connection is severed from the node after accepting its
connection request while “Accept calls while in Round QSO Rooms” is set to ON.
ON (with a check-mark) Reconnects to the room your node was connected to
before accepting the interrupt connection request.
OFF(without a check-mark)  Does not reconnect to the room (remains in not
connected mode) (default setting).

Return to Room ... Set whether or not to connect to the room specified from “Room ID” every time.
ON (with a check-mark).......... Connects to the specified room every time the
WIRES-X software starts.
OFF (without a check-mark)... Connects to the specified room not every time
(default setting).

The #55555 command can also change this setting (When “DTMF #55555” is set to ON).
To set it back to ON, go to the “Call settings” screen of the WIRES-X software or use the
#55555 command.

The operating conditions are as follows when this function is set to ON.

» Connecting time belt ... 24 hours

* Disconnect detection... 30 seconds (If the disconnection state continues for 30
seconds or longer, connection is initiated to the connection
destination.)
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s Others .....ccovevcveeinen, For the room specified as the ordinary connection
destination, “Unlimited TOT” on the “General settings”
screen of the WIRES-X software will be ignored.

ROOM ID ..o Set the ID (user ID or DTMF ID) of the room you want to connect to every time.
Setting “Return to Room” to ON enables you to enter the ID in this field.

DTMF #55555......coiiiiiiieeeee e Set whether or not to accept the DTMF #55555 command.
ON (with a check-mark).......... Accepts the DTMF #55555 command (valid).

OFF (without a check-mark)... Does not accept the DTMF #55555 command
(invalid) (default setting).

® General settings

[ - - i e S e -
e - L e e -
Settings General settings
2} Peraonal settings
- WIRES ID information
. [~ Unlimited TOT
Location settings =
Round QS0 room settings TOT (TimeOut Timer) 10 —min (5-60)

& Property - Announcement
~HRI-200 setup

i [T Connect remuest message
+-Call settings

General settings

Digital ID settings
i-Make list file

i.Log file settings

M Room IN/OUT

™ Boon logon node info
[~ DTHF#66666

[T DTMF#55555

[T DTHMF * Discomnect

[ Remote control

Password i

Cancel

Help

Unlimited TOT.......cooovviiiieeees Set whether or not to limit the connect time by activating the timeout timer (TOT) when your
node is connected to a node or room.
ON (with a check-mark).......... Deactivates the timer (Does not limit the connect time).
OFF (without a check-mark)... Activates the timer (Limits the connect time) (default setting).
When the “Return to Room” checkbox is checked and a connection room is set, the connection will be

maintained regardless of the “Round QSO Room connection” setting.

TOT e Set the connection duration to specify how long you desire to stay connected to a node/room.
When the set time has passed, the connection will be severed automatically.
However, if voice communication is being performed (The “INTERNET” or green “ON-AIR”
status indicator appears), when the set time has passed, the connection will be maintained
until 20 seconds have passed after the communication finishes.
« This setting is valid when “Unlimited TOT” is set to OFF (the timer is activated).

* When “Return to Room” is ON and your node connects to the specified room, this setting will be
ignored.
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Announcement
« The announcement output function is activated only for a analog operation. This function is not available for a digital operation.
* The same announcement will not be transmitted again for about 20 seconds.

Connect request message.......... Set whether or not to inform when receiving a connection request from another node while
connecting to a node/room on the Internet.
Setting it to ON by inserting a check-mark, the announcement “Connect request from *****” will
be transmitted (***** refers to a node ID).

Room IN/OUT .....oveiieeeiieeeee Set whether or not to inform when other nodes come to or go out from the room you are
currently connecting to.
Setting it to ON by inserting a check-mark, an announcement such as “***** IN” or “***** QUT”
will be transmitted (***** refers to a node ID).

Room logon node info ................ Set whether or not to include the number of nodes connected (the number of activities) in the
announcement when connecting to a room.
ON (with a check-mark).......... Includes the number of activities in the announcement.
Example: “This is JQ1YBG WIRES X. Connected to *****. Three
Nodes.”
OFF (without a check-mark)... Informs only the ID of the room you are connecting to.
Example: “This is JQ1YBG WIRES X. Connected to *****.”

This setting also affects the DTMF #66666 command response and the content when VOICE is
selected from ID.

DTMF #66666............c.cceevveennen. Set the announce operation when receiving the #66666 command.
Setting this to ON (with a check-mark) transmits an ID announcement to the DTMF #66666
command.

DTMF #55555.......cccoiiiiiiiiienn. Set the announce operation when receiving the #66666 command.

Setting this to ON (with a check-mark) transmits a response announcement to the DTMF
#55555 command.

Even when this setting is OFF (without a check-mark), if “DTMF #55555” is set to ON on the “Call settings”
screen of the WIRES-X software, the command operation will be executed.

DTMF * Disconnect .................... Set the response operation when receiving the * DTMF command.
ON (with a check-mark).......... Accepts the * command as the #99999 command and sever the
connection to another station.
OFF (without a check-mark)... Ignores the * command.

The DTMF command is valid only for an analog operation. The DTMF command does not function for
a digital operation.

Remote control ..........c.ccccvveenen. Set whether or not to remotely control the WIRES-X software.
ON (with a check-mark).......... Allows access from the WIRES-X remote monitor software
“WIRESMON-X.exe” (enables remote-control operations).
OFF (without a check-mark)... Prohibits access from the WIRES-X remote monitor software
“WIRESMON-X.exe” (disables remote-control operations).
To use the web monitoring function of the remote monitor software “WIRESMON-X.exe”, setup the
dedicated plug-in separately.
Password.........ccocoeeeviiieeiiiiecnnn. Set the access authentication password from the WIRES-X remote monitor software
“WIRESMON-X.exe”.
Set “Remote control” to ON to enter text in this field.
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® Sound settings
This menu appears only during an analog operation.

,S_ T B o S S e =
ettings T S S e S e
Settings Sound settings
- Personal settings
| L-WIRES ID information [ Connect response
Location settings f* OFF
: +-Round Q50 room settings ~ WAVE FILE I _I
£l Property
L. HRI-200 setup e Text I
| i.Call settings " VOICE Test | 3top |
| General settings
| é---Make list file *+ OFF
| t.Log file settings
 WRVE FILE | _I
i
i CW  Text I
l
|  VOICE Test Stop |
f Interval time 10_:I min {5-60)
|
[ rCalibrate
CW Voice
Speed i) 30 Voice Microaoft Anna - Engliatj
_J—
Volume 50 Speed — ,_0
Pitch J—
: 700 1| va1ume = 90
i
I
! |
l
i
| OK | Cancel Help
fl
— — = —

Connect response

Select the response sound when accepting a connection request or connecting to another node or room.

ID

Select the ID audio format transmitted periodically.

<Universal>
COFF e Does not output sound.
* WAVE FILE......coooiiiiiieice Plays the specified audio file (wav file).
Select this to make [...] on the right selectable. Click this to display the file selection screen
where you can select your desired WAV file.
CCW e Transmits the specified text content in mores code signals.
Enter a response sentence or the ID in the text box. The following symbols and characters can
be used.
Symbols ("$'()+,-./:=? @), space, numbers (0 to 9), alphabetic characters (Ato Z and a
to z)
Only qualified users are permitted to transmit CW data.
*VOICE ... Transmits sound played using VOICE.
For example, if your station is JQ1YBG, messages shown below will be played.
» While initiating a connection or connecting from your node
“This is JQ1YBG WIRES-X. Connected to *****.” (***** refers to the connection destination
ID)
* When connecting to your station from another node
“This is JQ1YBG WIRES-X. Connected from *****.” (***** refers to the connection destination
ID)
* When there is no connection
“This is JQ1YBG WIRES-X. Not connected.”
[Test] oo Click to transmit an audio test message according to your setting.
[StOP] .o, Click to cancel the test transmission.

While connecting to another node or room, test transmission does not function.
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<|D>
Interval time ..., The ID transmission interval can be set from every 5 minutes to every 60 minutes in 1 minute
increments.
At the node operating frequency, be careful not to interfere other stations when setting and operating
your station.
Calibrate

Allows you to set each of the CW sound tone and announcement sound tone.

cw

Speed ..o Set the CW code speed. The unit is WPM (“PARIS”). The higher the value is set, the faster the
code becomes (The default setting is 30 WPM).
WPM (Words per minutes/PARIS) is the CW keying speed unit standardized by the ARRL (American Radio

Relay Reague) to calculate how many 5-letter words are transmitted per 1 minute.

Volume......ooooiiiieiieeeeee Set the CW transmission sound volume. The higher the value is set, the higher the volume
becomes (The default setting is 50).

PitCh.. oo Set the pitch of sound. The frequency unit (Hz) is used. (The default setting is 700 Hz).

Voice

VOICE ...t Allows you to select the sound type.
The available options differ depending on the OS.

Speed ..o Set the sound speed. The higher the value is set, the faster the announcement will be output
(The default setting is 0).

Volume......coooiiieeeeeieeeeeee Set the sound volume. The higher the value is set, the higher the volume becomes (The

default setting is 90).
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® Digital ID settings
This menu appears only during a digital operation.

"S_ I —
SiTe - e ——
Settings Digital ID settings
- Personal settings
~-WIRES ID information
ocation settings rVoice CH
: ~-Round Q50 room settings T ip X
£l Property
L. HRT-200 setup Interval Time 1u_|:j min (1 - 60 ) TEST
all settings
: neral settings
f igital ID settinga Preset Gearch CH
ke liat fil
| -Make list file rm
fl «-Log file settings
i Interval Time 10_:| min [ 1 - 60 | TEST
|
i Uszer Station can receive an ID signal only during the WIRES-X operation.
i
|
i
i
|
|
|
i
i OK | Cancel Help
|
— — — —

Voice CH

Configure the digital ID transmission setting for the voice channel.

Preset Search CH

Configure the digital ID transmission setting for the preset search channel.

<Universal>

IDTX oo Setting this to ON (with a check-mark) transmits the digital ID periodically.

Interval Time .......ccocvvevinciiieenne The digital ID transmission interval can be set from every 1 minute to every 60 minutes in 1
minute increments.
This setting can be configured only when “ID TX” is set to ON.
At the node operating frequency, be careful not to interfere other stations when setting and operating

your station.
[TEST] e Click to transmit a digital ID signal just once for the channel.

While connecting to another node or room, test transmission does not function.
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® Make list file

r
Settings

T s B e S

— -
W S ——

Settings

-~ WIRES ID

Bl Property

- Personal settings

[ information
Location settings
Round QSO room settings

-~ HRI-200 setup
Call settings

: General settings I ;I
f Digital ID settings HTML Header
f Make list file -
f i.Log file setcings
(|

HTHL Footer

Make list file

Group window |Active ID|Room ID|MyRoom logen In|

[~ Enable list out
[T L sryle
HTHML File name

¥ Table layout
[T save CSV format

Notify window title I

Cancel

0K | Help

Group window

From this tab, configure the settings to output the list in the group window as a file.
The content output from this tab will be affected by the display setting in the group window.

Active ID

From this tab, configure the settings to output the list in the active node window as a file.

Room ID

From this tab, configure the settings to output the list in the active room window as a file.

MyRoom logon ID

From this tab, configure the settings to output the list of nodes connecting to your room as a file.
This screen will not appear when your room is not activated.

<Universal>
Enable list out
XML Style

HTML/XML File name

Setting this to ON (with a check-mark) activates the file output function.

Specify the data output format.

ON (with a check-mark) Outputs in XML format (using UTF-8 character).

OFF (without a check-mark)... Outputs in HTML format (tab-separated format or table-layout
format).

This setting can be configured only when “Enable list out” is set to ON.

Enter the file name of the list. Use the extension “.html” for an HTML file, and “.xml” for an XML
file.

The file name can also be specified from the file selection screen displayed by clicking [...] on
the right.

This setting can be configured only when “Enable list out” is set to ON.

Do not use the same file name as other tabs.
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HTML/XML Header..................... Enter information (such as HTML tags or style sheet information for XML) you want to add to
the beginning of your output data.
Example: To call an xsl style sheet for XML

<?xml version="1.0" encoding="UTF-8"?>
<?xml-stylesheet type="text/xsl" href="Active.xsl"?>

To add style sheet information as shown above to the beginning of output data, enter the
information here.
Create an xsl style sheet fie (in case when the example above, “Active.xsl”) and store it in the
same folder as the saved data file to display the information on your web browser using the
created style information. The result displayed using the style sheet differs depending on the
web browser.
With WIRES-X, the following xsl style sheet samples are available for each tab.

Group.xsl (for “Group window”)

Active.xsl (for “Active ID”)

Room.xsl (for “Room ID”)

MyRoom.xsl (for “MyRoom logon 1D")

HTML/XML Footer........ccccceeeneee Enter information (such as HTML tags) you want to add to the end of your output data.
Select the output format for HTML.
ON (with a check-mark).......... Outputs in table-layout format.

OFF (without a check-mark)... Outputs in tab-separated format.
This setting does not function when “XML Style” is set to ON.

Table layout

Save CSV format.........cccceeveeennns Inserting a check-mark (ON) outputs a tab-separated text (csv) file at the same time.
The file name will be the same as the HTML/XML file with the extension “.csv”.
Notify window title...................... The update information of the output data file can be informed to other applications.

Normally, keep this box blank.
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® Log file settings

I'S_ - a S S S e -
ettings — e e een
Settings Log file settings
- Personal settings
{ i.WIRES ID informatien Log file settings
--Location settings
i.Round QS0 room settings [ Node log-file save
£l Property
L. HRT-200 setup I —I
all settings
: General settings
f igital ID settings
| ake 1liat file [~ Hews log-file save
H
, | E
|
|
: [~ Room log-file save
Open log folder |
i
I
|
d
N
|
| 0K | Cancel Help
Node log-file save............ccc...... Inserting a check-mark (ON) saves the whole node operation history.
Click [...] on the right to display the “Save as” window.
News log-file save ...................... Inserting a check-mark (ON) saves access history to the news function.
Click [...] on the right to display the “Save as” window.
The access information to the news for nodes and news for rooms will be saved in the same file.
Room log-file save.........ccc......... Inserting a check-mark (ON) saves the whole room operation history.
Click [...] on the right to display the “Save as” window.
[Open log folder] ........c.ceevvveennnen. Click to display the folder where each log file saves.

J] Finishing the WIRES-X software
From the “File” menu, select “Exit” to close the main screen of the cwrex

WIRES-X software. File(l) ] View(V) Connect(C) Tool(T) Help(H)
EnpoReHmGy Cal/Rm... | City | State | Cou..| FreqM... | SQL | Lat | L.
Export settings
Set default

Retry activation
Transceiver(T)
Settings(P)
Refresh list

Exit(E)

Tips
* You can also finish the WIRES-X software by clicking [X] on the top right side of the main screen.
« If “Enable WIRES-X Auto Start.” has been selected when installing the WIRES-X software, the software will restart immediately after finishing the
software. If you do not want to restart the software, right-click the WIRES-X icon on the Windows task bar, then select “Quit”.
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“View” menu

J] Fonts used in the active lists
Fonts used in the group window, active node window and active room window lists can be selected.

® Changing the font
1 From the *View" menu, select “Font” - “Select” x e

The “Font” window will appear. 50 S v s T )
“M.Us Font(F) 3 Select

v Status Bar(S) Reset

u... | Freqim.. [soL [ Lat [ L.

Connect ID window(T)

Group window 3
Bookmark-Info(B)
MNode-Info(M)

Room-Info(M)

Log 3
Audio adjustment(R)

News

Mabile Users list

Select or enter your desired settings

Click [OK]

The settings will be saved, and the “Font” window will close.

The main screen will appear again, and information in the active lists will appear in the selected font, style and size.

w N

IrF‘:mt - ﬂ
Font: Fort style
[ Courier New] |Regular 0K |
Courier New Cancel
Fixedsys LI
Frankiin Gothic
sbriols
Sample —————————
RaBbYyZz
Sept
Westem vI
Font ..o The clicked font name will appear in the text box on the upper side of the lists. You can also

enter the font name in the text box directly.
Fonts installed on your PC will be displayed in the lists.

Fontstyle....ccooovviiiiiiiiiiiei, The clicked style will appear in the text box on the upper side of the lists.
Selectable fonts differ depending on the font selected from “Font”.

SiZ€oiiiiiii s The clicked number (font size) will appear in the text box on the upper side of the list. The unit
is point. You can also enter the font size in the text box directly.

Sample ....ccoovveiiiie e, The letter samples will appear according to the selected font, style and size.

SCHPt o Select your desired script from the drop-down list.

Available scripts differ depending on the OS of your PC.
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® Resetting the font settings
1 From the “View” menu, select “Font” - “Reset”
The confirmation dialog box will appear.

2 Click [OK]
3 Restart the WIRES-X software
Information in the active lists will appear in the default font.

I Displaying the operating instructions

= wresx

File(F) | View(V) | Connect(C) Tool(T) Help(H]

+M.Us:

v

Font(F) 3
Status Bar(5)

Select
Reset

.. [Freqm.. [soL  [rat[L. [c

Connect ID window(T)

Group window 3
Bookmark-Info(B)
Mode-Info(M)

Room-Info(M)

Log 3
Audio adjustment(R)

News

Mahile Users list

Display the status bar to the bottom of the main screen to display the operating instructions.

DE=m=wr 1B ESE  Toyono-gun
D 1= JEms Ktakatsuragi-g..
Do 1m= e Shimonoseki-cty Yamagu.

Osaka
Nara

Japan 43084.. DSQ:066
Japan 14451.. DSQ:OFF N.. El.. ZZGE+%.A—pt
Japen 4331M.. DSQ001 M. El.

+Room ID [ DT... [ Act [ Room name

[state | Cou... | Comment

20311000

Status bar

WIRES-X BUG? TEST

Hiroshima-ci

[ty
o= 20202 017 APRSSKE Kitakyushu-city ~ Fukuoka Japan 0202 DIGITAL ROOM
[ClE=—— 20382 002 0382DIGITALRoom  Nagoya-city Aichi Japan
[F=e] 20451 000 BAUQSO-Room  Odawara-city  Kanagawa Japan BAU.p.rnf
e 20368 004 39'zRoom Yokohama-city  Kanagawa Japan 13507 fmifh,5
I 29107 000 39'sRoomX No2 Yokohama-city ~ Kanagawa Japan
SESETCIA 29036 000 'O'6ZR-%.}—<HC  Hadano-city Kanagawa Japan 'O'8ZRT|
AT 2140 000 %arAflse Aizuwakamatsu... Fukushi.. Japan
@AcscTmome 20510 031 ALLJACQROOMEL  Yamato-city Kanagawa Japan  yALLACQfféchdz:C(Ey EC.
Amssommmess 20509 000 ALLJACQROOME2  Komae-city Tokyo  Japan  yALLIACQf{f€ch.2z.CCEyE
BIDSEE—TOm 22069 000 ‘+'L'==—hDWIRES Maniwa-city Okayama Japan DSQZZESOA, 7
[ Je=c RSNy 22043 002 CAFM-JAPAN Kameoka-city Kyoto Japan  Eép¢f-
C=mommmeoar 24730 000 CHIBADIGITALNET  Sammu-city Chiba Japan  $y,u,¢QSOf(f€5-Uw,ufi.c.
= 22000 000 CQIAPAN Shinagawa-ku  Tokyo  Japan CQJAPAN Room
G2 Csemmmmem= 20000 000 CQWORLDWIDE Shinagawa-ku  Tokyo ~ Japan CQWORLD WIDE Room
& epe—=ome 29999 000 EMG Room Shinagawa-ku Tokyo Japan  EMG Room
@ == 20694 002 FLOWERCQ/FNET  Vonago-city Tottori  Japan Round QSO Room/Friendly 0.
& FamoR—=0De 20786 000  <3BeT%s* ROOM Munaksts-city ~ Fukuoka Japan 7 E ()

Hiroshi.. Japan

From the “View” menu, insert a check-mark to “Status Bar” to
display the status bar.

Click the “Status Bar” again to remove the check-mark and hide the
status bar.

l Displaying the nodes connecting to a room

Even if you have closed the pop-up window displayed when
connecting to a room, you can display the window again.

From the “View” menu, select “Connect ID window” to display the
pop-up window to show the room operating status.

« The pop-up window will not appear when you do not connect to a
room.

* For details on the pop-up window, refer to “Connecting to a room on
the Internet” (page 30).

« “Connect ID window” will be switched to “Display GM members”
while operating in GM mode.

= owiresx T

File(F) | View(V) | Connect(C) Tool(T) Help(H)

+M.Use

v

Font(F) »

| State

| cou...| Fregm... [sQL et L. [c

Status Bar(5)

Connect ID window(T)

Group window 3
Bookmark-Info(B)
Mode-Info(N)

Room-Info(M)

Log 3
Audio adjustment(R)

News

Mobile Users list

= wresx

File(F) [View(\l'} Connect(C) Teol(T) Help(H)

+M.Use

v

Font(F) 3

| State

[ Coun. [ Fregv. [sQL  Jiat [L. [C

Status Bar(5)

Connect ID window(T)

Group window 3
Bookmark-Info(B)
Mode-Info(M)

Room-Info(M)

Log 3
Audio adjustment(R)

News

Mahile Users list
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l Changing the content displayed in the group window
The information displayed in the group window on the upper left cweesx

side of the main screen can be changed. File(F) [View(V) | Connect(C) Tool(T) Help(H)

From the “View” menu, select “Group window”, then one of the s Font(®) ' [state | Cou..| FreqM.. [SQL | Lst | L.
options: “Bookmark list”, “Connecting Node list’ or “MyRoom access ¥ )| Stokas Bart)
list”. A check-mark will be inserted to the selected item.

Connect ID window(T)

. . « . .y Group window 2 Bookmark list
For details on each item, refer to “Active list” (page 66). e [
Node-Infa(N) v MyRoom access list

Room-Info(M)
Lag 3
Audio adjustment(R)

News

Maobile Users list

J] Setting your node

When operating a node, you can set digital stations (mobile/fixed), e
nodes/rooms on the Internet from which you want to block access File() [ViewiV)] Connect(C) Tool(T) Help(H)

to your node. M.Us FEntls ' [state [ cou.|Freqm. [sor  [tat [L.

When operating your node as a GM node, you can display the |

information of the GM room you are connecting to. Connect ID window([)

“w /7 ” « » . « Group window 3
From the “View” menu, select “Node-Info” to display the “My Node Tt
information” window. Node-Info(N)

Room-Info(M)
Log 3
Audio adjustment(R)

News
Mabile Users list

MyNodeinformation. Wl W e w MyNodeinformation. W L e
Status Tser 1D DIMF ID Status TUser 1D DIME 1D
—= Cpen Nede — I_:: IE [— G Noge — I_:: ==
News setting > ALL 0K
[Reject 1i e

&
Callsign User ID DIMF/Radic 1D B 3 oup name
DIMF 1D Room name
[ select change
rReject 1i
Callsign [usez 0 [omF/Radio 10|

D

[Open node] [GM node]
<Universal>
Status ..oeeveeeeee e Operations style (open/GM) and local news access setting
The local new access setting appears only for an open room operation.
UserID .o Access code of your station during a digital operation
DTMF ID ..oooiiieeeeee Access code of your station during an analog operation

For “Status”, “User ID” and “DTMF ID”, the values set on the “WIRES ID information” screen in the
“Settings” window displayed from the “File” menu - “Settings” (page 26) will appear.
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Reject list

(] R List of digital stations (mobile/fixed) and nodes/rooms blocked from connecting
[Ad] .o Clicking here adds an entry to the list.

[Delete] ..vvveriiiiieeeiiieeeee Clicking here deletes the selected entry from the list.
<GM node>

GM Room

The values set in the “GM Room list” window (page 44) will appear.

ROOM ID ..o The user ID of the GM room you connect to

Group NAME.......covvvveiiieeeiieeeas The GM group name you set

DTMF ID ..o The ID of the GM room you connect to
Roomname..........cccooiiiiiis The GM room name set by the owner

[Select change]......ccccceeeivieennnen. Clicking here displays the “GM Room list” window

® Adding a station you want to block from connecting

1 In the “My Node information” window, click [Add]
The “Input ID” dialog box will appear.
2 Enter the ID of the station you want to block from connecting e
Enter its call sign for a mobile/fixed station or its User ID or DTMF ID Slease inpas Gser 10 of » ode or CallSign of
for a node/room. IR SEHAT % IR 0 3 L
3 Click [OK]
The dialog box will close, and in the “Reject list” area of the ]T| Cancel |
“My Node information” window, information such as the 1D will S
appear.
Tip

Entries can also be added to the access-denied list in the following ways.

« In the active node window, select a node you want to block, right-click on it to display the command list, then select “Node Reject”.

* In the active room window, select a room you want to block, right-click on it to display the command list, then select “Node Reject”.

* From the “View” menu - “Mobile Users list”, display the “Mobile Users list” window and select a mobile or fixed station you want to block, then click
“Node Reject” (page 96).

I Checking the list of nodes connecting to your room

When operating a room, you can set digital stations (mobile/fixed) .

and nodes/rooms on the Internet which you want to permit to File(F) [View(V)| Connect(C) Tool(T) Help(H)
access your room. +M.Us Eoutlb) ' [state | cCou.[Freqoa. [sor  [rat [ L

From the “View” menu, select “Room-Info” to display the “MyRoom
information” window.
For details, refer to “Detailed setting of your room” (page 40). —

v Status Bar(S)

Connect ID window(T)

Group window 3

MNode-Info (M)

Room-Info(M)

Log 3
Audio adjustment(R)

News

Mabile Users list
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l Changing the content displayed in the log window
The information displayed in the log window on the right center of

the main screen can be changed.
From the “View” menu, select “Log”, then one of the options: Moie Fert® > [Stete | Cou..[FreqM.. [SQL [ Lat [ L.
“Node”, “Room” or “News”. A check-mark will be inserted to the || Stetus Bary

selected item. For details on each item, refer to “Log window” (page Zf:u”::z:":d°wm X

72).

Bookmark-Info(B)
Mode-Info(N)
Room-Info(M)

Log v ¥ Node
Audio adjustment(R) Room
News News

Mabile Users list

l Adjusting the input/output sound volume
The volume can be adjusted to an appropriate level in accordance

¢ WIRES-X
with the transceiver connected to HRI-200. File(F) Connect(C) Tool(T) Help(H)
From the “View” menu, select “Audio adjustment” to display the Guser]  Font®) D [Stote | Cou..[FreqM.. [SQL [ Lat [ L.
“Audio adjustments” window. 4 || status Bt
Connect ID window(T)
Group window 3

Bookmark-Info(B)
Mode-Info(N)

Room-Info (M)

Log 3
Audio adjustment(R)

News

Mebile Users list

Audio adjustments . -

Settings

Audio

Mon

Graph select Volume

Help ! Close |

Have - I | OUTDUT (Tx)
| SP LEVEL 4 v|o1s fonsmmes oo
— o 2o D
i
I |A.ny frequency tone j
I E 1000wz (50 - socommy | | T R
DR =1 == ees = = Loopback |
(| - — - MIC LEVEL ﬂ J jOH D!
| DN:Digital Voice Norma
( Tone level: a:ﬂ % (10 - 100%)
i Start
|
i
ll
|
L

For details on the “Audio adjustments” window, refer to “Volume adjustment” (page 28) and “Adjusting analog sound” (page 53).
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l Managing the news data of your station

You can register or delete digital data (news) published to digital

=~ weesx

stations (mobile/fixed) and nodes connecting to your node/room. File(F) [View(V)| Connect(C) Tool(T) Help(H]

You can also confirm the data content. MU Font(F) b [State | Cou...| FreqiM.. [ 5QL | Lat | L.
From the “View” menu, select “News” to display the “News list’ )| SErCy

window. For details, refer to “Using the news function” (page 55). z:’:u”::iz::""wm X

Bookmark-Info(B)
Mode-Info(N)

Room-Info(M)

Log 3
Audio adjustment(R)

News

Mabile Users list

I Checking stations that used your station

A list allows you to view stations (mobile/fixed) that used your node/ S e =

room or accessed your node/room via a node/room on the Internet. File(F) [View(V)| Connect{C) ToolT) Help(H)
The access block setting to your station and your room member s Font(F) v [sote | Coun | Freqin [50L | iot L.
setting can also be configured | S
From the “View” menu, select “Mobile Users list” to display the Z""”e‘*_lzw'”""“"m
“ H . ” . roup window »
Mobile Users list” window. Dol
Depending on your room operation style, some of the displayed Node-Info(N)
content may differ. (oAl
Log 3

Audio adjustment(R)
News
Mobile Users list

Mobile User list - s - -, -

+CallSign Radio ID I Last received time | Recv CH I Last position I
== ==: o 2014503713 174717 V-CHI

Add GM member | Export

MyRoom reject | Tode reject melp || close |||
"

<Information items in the list>

CallSign ... Call sign of your station user

Radio ID......cccvveiieeiieeee e Identify code of your station user

Last received time ...................... Date and time when your station user last connected to your station

Recv CH ...oooiiiiiieieee Channel the signal was received through

V-CH......Via the voice channel

P-CH1....Via the preset search channel (during dual-receiving operation)

P-CH2....Via the preset search channel (the transceiver connected to the RADIO 2 jack)
Net......... Via a node-type connection destination

Room.....Via a room-type connection destination

Last position .........cccecveeencieeennn. Location information included in the signal received
i} If connections made several times, the latest information will overwrite the old information.
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<Open room>

[MyRoom reject] ......cccccvveeeeennnns Clicking here blocks the selected station from connecting to your room.

The blocked stations can be confirmed in the “MyRoom information” window displayed by selecting
“Room-Info” from the “View” menu.

<Closed room>

[MyRoom member]......c.c............ Clicking here adds the selected station to the member list of your room.

Your room members can be confirmed in the “MyRoom information” window displayed by selecting “Room-
Info” from the “View” menu.

<GM room>
[MyRoom member].........ccccc..... Clicking here adds the selected station to the member list of your room.
Your room members can be confirmed in the “MyRoom information” window displayed by selecting “Room-
Info” from the “View” menu.
[Add GM member]..........cceeenneee. Clicking here adds the selected station to the member list of the GM room you are currently
connecting to.
This item is available only when your node operates as a GM node and connects to a GM room.
<Universal>
[Node reject] .....oovvvevvieeiiiiiie. Clicking here blocks the selected station from connecting to your node.
The blocked stations can be confirmed in the “My Node information” window displayed by selecting “Node-
Info” from the “View” menu.
[EXPOrt] ceveeeiiieeeeeee e Saves the displayed station list in TXT format.

Clicking here displays the “Save as” window.

“Connect” menu

l Transmitting a connection request to a node/room on the Internet

A connection can be initiated using WIRES-X. rwm_
Select a node/room from the active list, then select “Connect” from Fiel) View®¥) [Connect(Q)] Tool Help)
the “Connect” menu, a connection will be initiated to the selected +MUserD | Connect(C) te | Cou..| FreqM.. [SQL | Lat | L.
node/room. IR

o ey . . L. Disconnect(D)
You can also initiate a connection by placing your mouse cursor inside

the active list, right-clicking to display the command list, then selecting
“Connect”.

¥ GM Auto connect(F)

l Specifying the connection destination directly

Inputting a node/room ID can initiate a connection.

1 From the *Connect’ menu, select “Connect To DU
The “Input ID” dialog box will appear. file Py iew ()0 NSRSV s (T mm el
MUser D | RonpectiG) te | Cou..| FreqM... | SOL | Lat | L.
Connect To(T)

Disconnect(D)

¥ GM Auto connect(F)

2 In the text entry field, enter the DTMF ID or User ID of the node/

Input ID
room you want to connect to
3 CIICk [OK] zie;:ecgﬁizz‘:g;‘-ie or Room User ID which wants
A connection will be initiated. |
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l Severing the connection

From the “Connect” menu, select “Disconnect” to sever the

N

connection from a node/room on the Internet. File(F) View(V) [ Connect()] ToolT) Help(H)
This item is available only while connecting to a node/room on Y| Connect(C) e | Cou | Fream |50 | iot L
the Internet. Connect To(T)
Disconnect(D)
¥ GM Auto connect(F)

] Connecting to a GM room automatically
From the “Connect” menu, select “GM Auto connect” and insert a

ey |

check-mark, your node will connect to the specified GM room as File(F) View(V) [ Connect(C]] Tool(T) Help(H)
soon as the WIRES-X software starts. MUsstD | Connect(C) Lte | Cou.| FreqM.. [ SQL | Lat | L.
Selecting “GM Auto connect” again removes the check-mark and Comnect fetl)

Disconnect(D)

severs the connection from the GM room.
This item is available only when your node operates as a
GM node and the GM room is specified as the connection
destination in the “GM Room list” window.

v GM Auto connectiF)

Tip

“ For details on how to use the GM (group monitoring) function, refer to “Using the GM function” (page 43).
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“Tool” menu

[ Confirming the Internet connection

This menu allows you to confirm the Internet port status used for
communications with the WIRES-X server.

From the “Tool” menu, select “Port check” to display the “Port
check” window. For details, refer to “Opening the router ports” (page
17).

[ Confirming the plug-in tool

sy |

File(F) View(V) Connect(C) | Tool(T) | Help(H)

+MUserlD |

DT.. | Act [

Port check
Plugin set

'WIRES WebServer

Cou... | FreqM... [sQL [ Lat [ L.

A plug-in tool can be appended to the WIRES-X software and the appended tool can be confirmed from this menu.

1 From the “Tool” menu, click “Plugin set”
The “WIRES plugin menu” window will appear.
In the “Plugin modules” field, tool names will be listed.

2 Click [Add Module]
The window where you select a plug-in file will appear.

3 Select a file with extension “.dII”, then click [Open]

The “WIRES plugin menu” window will appear again and in the
“Plugin modules” field, the tool name will be shown.

sy |

File(F) View(V] Connect(C) | Tool(T) | Help(H)

| Recent Places

Il 4 Libraries

: [ Documents
I & Music

I I Pictures.

Ml B videos

I

& Computer

(M

b & Local Disk ()
i ca data (D7)
(M

€ Network

&% DVD RW Drive (Q:) &

Port check
MUserlD | +D... [ Act [ | cou...[ Freqmm... [saL [ Lat [L.
Plugin set
P -——
WIRES plugin menu | i
Plugin modules
WIRES WebServer . Moale
I
Delete Module| [
I
Property
Version Info
Help oK
r —— e —— -

€ Open e eee © G Sew ==
L — = - == = — -

OU (U e e e T—— W+ Plugin ~ [ 42 ||| Search Plugin o]
Organize v New folder =~ A @
B Favorites Neme Date modified Type Size

B Desktop % WiresWeb.dil 7/12/20141248 PM_ Application extens... 360 KB|
18 Downloads

File name: Wires\eb.dll

- | Wires Plugln (*.dil) A
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4 In the “Plugin modules” field, select a tool you do not use
anymore Prugin sodules
5 Click [Delete Module] BIEES ebsesve:

From the “Plugin modules” field, the selected tool name will
disappear.

[ -——
WIRES plugin menu |

2dd Module

I
Delete Module| f

Property

Versiom Info

L il

I
Help | K

6 Click [OK]

“Help” menu

[ Displaying the online help

From the “Help” menu, select “Help Topics” to display the “WIRES-X
server online help” window.

x weesx
File(F) View(V) Connect(C) Tool(T) IHelp(H}

+MUserlD | DT.. | Act | Call/Rm.. icipiopcs(tf req(M... L.
WIRES Web Site
About(A)...

LT =)
k o

Hide Back Print  Options

Contents | Search I i

Welcome to the WIRES-X

[2] WIRES ID Activation

@ Fle i

OSettings WIRES (Wide-coverage Internet Repeater
O\flew Enhancement System) is an Internet

0 Connect communication system for expanding the
QTooI communication area of amateur radios.
@ Window -
0 Help In WIRES-X, an Internet-connected radio

station (node station) established by an
amateur radio station becomes an access
point for wireless communication and
internet connection. A mobile station using
WIRES-X can communicate with any amateur
radio station worldwide using a node station
that lies within the range of the radio
waves.

WIRES-X supports new C4FM digital
communications and relays the information
without damaging the communication quality

Use this online help in the same way as any other typical on-line Windows-environment help guide.
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J] Short-cut for the WIRES-X website
From the “Help” menu, select “WIRES Web Site” to open your web

ey |

browser and the WIRES-X website (https://www.yaesu.com/jp/en/ File(F) View(v) Connect(C) Tool(T) [Help(H)

wires-x/index.php) will open. +MUserD__ | DT... | Act | Call/Rm... [P el req(M... L.
WIRES Web Site
About(A)...

] WIRES-X software information
The WIRES-X software component information can be confirmed.

v — |

“« » “ ” H “ : ”
From the “Help” menu, select “About” to display the “Information FileF) View(V) Connect(C) Taol(T) [Help(H)]
screen. +MUserlD | DT.. | Act | Call/Rm.. R U= req(M... L.
WIRES Web Site
AboutA)...
i - -
| S En T N N I
g W =Es— = N
—_—
Wide-Coverage Internet Repeater Enhancement System
Digital/Analog
Information
Product Name Veraion | File Description
; WIRES-X.EXE = WIRES-X Application i
I/F-Box Firmware ... T ... WIRES-X I/F box(HRI-200) CEU... I
WIRES-X Setting dialog box D... :
N WIRES-X Command Dynamic Link...
' DialogBox control. DialogBox control Dynamic Li...
N WIRES-X News Mana. WIRES-X News Management Dyna...
I’ WIRES-X Access Ma... ...~ WIRES-X Node Access Manageme...
b WIRES-X Data Mana... _I0I0C WIRES-X Data Management Dyna...
¥AESU Digital tra... 010 C YAESU Digital transceiver co...
(1 ¥AESU Router UBNP... —__._ = Router UENF entry tool
Image convert ol — CnvtENG DLL
WIRES-X WEB Serwe... _T.0°= WIRES-X WEB Server I/F Dynam...
¢
I
||  Copyright(C) 2002-2014 YAESU MUSEN CO.,LTD. Copy to Clipboard
i
. YAESU
I
I
— =
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Uninstalling the WIRE Software
Tip
If “Enable WIRES-X Auto Start.” was selected when installing the WIRES-X software, right-click the WIRES-X icon displayed on the Windows task bar,
then select “Quit” not to reboot the software automatically.

1 Close the WIRES-X software
2 View the supplied CD-R and run the “Install.exe.” file
The “WIRES-X installer” window will appear.

3 Click [WIRES-X Software Setup] T
The “Welcome to the WIRES-X Setup Wizard” window will | |
appear HRI-200 Device Driver Setup |
Driver version - 1.0
WIRES-X Software Setup |
Software version - 1.808[English]
Refer to folder
4 Click [Next] T P
The “Change, repair, or remove installation” window will appear. I

Welcome to the WIRES-X Setup Wizard

The Setup Wizard wil install WWIRES-X on your computer,
Click Next to continue or Cancel to exit the Setup Wizard,

=

5 Click [Remove]

15 WIRES-X Setup [alaza
The “Ready to remove WIRES-X" window will appear. | Change, repair, or remove installation . |
Select the operation you wish to perform.

Change
WIRES-X has no independenty selectable features.

Repairs errors in the most recent installation by fixing missing and corrupt
files, shortcuts, and registry entries.

e —
ReEfaves WIRES-X from your computer,

Back Next Caneel

6 Click [Next]
The “Files in Use” window will appear.

3] WIRES-X Setup

Ready to remove WIRES-X

Click Remove to remove WIRES-X from your computer. Click Back to review or change
any of your installation settings. Click Cancel to exit the wizard.

Back E Remove ’ Cancel
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Uninstalling the WIRES-X Software

7 Select “Close the applications and attempt to restart them” B =
8 Click [OK] e s .

Uninstallation will be initiated.
- ) . . . . The follawing applications are using files that need to be updated by this setup. You can let
« To confirm or change the uninstallation setting, click [Back]. Setup Wizard dose them and attempt to restart them or reboot the machine later.
* To finish the wizard, click [Cancel].
When uninstallation completes, the “Completed the WIRES-X
Setup Wizard” window will appear.

YmLAN Application

© Close the applications and attempt to restart them.

(©) Do not dose applications. A reboot will be required.

o (o=

9 Click [Finish] T P
The “Completed the WIRES-X Setup Wizard” window will close.

When the WIRES-X software is uninstalled successfully, the
[Wires-X] icon will disappear from the Windows desktop. Cickthe Fnish buton t it re Seup Wizard.

Completed the WIRES-X Setup Wizard

= =

10 In the “WIRES-X installer", clck [Close] @
|

HRI-200 Device Driver Setup |

Driver version - 1.0

WIRES-X Software Setup |

Software version - 1.00#(English)

Refer to folder 7 1
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Appendix

Differences from WIiRES-II

® WIRES-X is not compatible with WiRES-II

Since the network system architecture of WiRES-II and WIRES-X are completely different, WIRES-X cannot be used to connect to
WIRES-II nodes. Conversely, you also may not use a WIiRES-II to connect to a WIRES-X node.

Also, when using the remote monitor function, you cannot remotely control a WIRES-X node with the WIRES-II remote monitor
software (WIRESMON.exe). For remotely controlling a WIRES-X node, be sure to use the dedicated remote monitor software
(WIRESMON-X.exe).

® WIRES-X IDs are assigned separately from WIiRES-II

Even if you already have a WIiRES-II ID, you are still required to obtain a new ID for WIRES-X.

With WIRES-X, one node is assigned two ID types, a DTMF ID (5-digit number) and a User ID (up to a 10-character alphanumeric
string). The DTMF ID is used as an access code when performing analog operations, whereas the User ID is used as an access
code during digital operations.

® The WIRES-X software is installable on a PC with the WIiRES-II software already installed
Since WIRES-X uses Internet communication ports different from those used by WIiRES-II.
WIRES-X uses the following communication port types.

UDP ports .... 46100, 46110, 46112, 46114, 46120, 46122
TCP ports .... 46190 (only while using the remote monitor function)

Conversely, WIiRES-II uses the following communication port types.
UDP ports .... 46000, 46001, 49660, 49670, 49680
TCP ports .... 46080 (only while using the remote monitor function)

When using a router for connecting your node PC to the Internet, please refer to “Opening the router ports” (page 17).
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Appendix

DTMF Commad List

The following table shows the DTMF commands supported by WIRES-X and operations of the WIRES-X software when receiving
these commands.

Tip

A communication using DTMF is available only when setting the transceiver for an analog operation.

#55555 Always connect your node to the If the node receives this command when the node is not connected to
specified room another node or room, the function that connects the node to the specified
room will be activated. Receiving this command again will deactivate the
function.

When your node is connected to another node or room or set to transmission
cancellation mode (during “ON-AIR LOCK?”), the WIRES-X software will not
react to this command.

The setting status can be confirmed on the “Call settings” screen in the
“Settings” window displayed from the “File” menu - “Settings”. You can also
change the setting on the screen.

This command can be accepted only when the “DTMF #55555” checkbox is
checked on the “Call settings” screen in the “Settings” window.

jifsl While operating in analog mode, an announcement can be transmitted as a
response to this command. To transmit the response announcement, from the
“File” menu, select “Settings” and display the “Settings” window, then on the
“General settings” screen, insert a check-mark in the “DTMF #55555” checkbox.

#66666 Inquire about the operating status | Announces your call sign and the operating status (“Not connected” or

of your node “Connected to ***** (DTMF ID of the connection destination)”) as a response

to the command.

- The announcement is transmitted as a response to this command only
during an analog operation.
« To transmit the response announcement, from the “File” menu, select
“Settings” and display the “Settings” window, then on the “General settings”
screen, insert a check-mark in the “DTMF #66666” checkbox.
#99999 Sever a connection If the node receives this command when the node is not connected to
* another node or room, the connection will be severed.

To accept the * command, from the “File” menu, select “Settings” and
display the “Settings” window, then on the “General settings” screen, insert a
check-mark in the “DTMF * Disconnect” checkbox.
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Specifications of HRI-200

Appendix

® General

Power source

Consumption current
Operating temperature range
Case dimensions

Unit weight

® Connector
Mini-DIN 10-pin (RADIO 1, RADIO 2)

3.5 mm audio (MONITOR)
USB Type B (USB)

: DC +5.0V £5%, negative ground (bus-powered)

1 Approximately 100 mA £30 mA

: 0°Cto +50°C

: Width 111 x height 25.4 x depth 133 mm (excluding protruding portions)
1 Approximately 340 g

: PTT output/SQL input DC +3.3 V, negative ground

Audio input (receiving) 100 mVrms @10k ohms (RADIO 1)
Audio output (transmitting) 100 mVrms @600 ohms (RADIO 1)
Serial input/output RS-232C level signal

100 mVrms @600 ohms (standard output)

: USB 2.0 (Full Speed), bus-powered

Please direct your inquires to our WIRES website (https://www.yaesu.com/jp/en/wires-x/contact/owner.php).

Enter the necessary fields

AON=-

Click “Contact us” located on the lower-left side of the webpage

Click “Proceed to the confirmation screen”
Confirm the details and then click [Send]

Please be aware that our response time may vary depending on the nature of the inquiry.
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Appendix

YAKKSU

Declaration of Conformity

Type of Equipment: Repeater System I/F BOX

Brand Name: YAESU

Model Number: HRI-200

Manufacturer: YAESU MUSEN CO., LTD.

Address of Manufacturer: Tennozu Parkside Building, 2-5-8 Higashi-Shinagawa,
Shinagawa-ku, Tokyo 140-0002 Japan

This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions; (1) this device may not

cause harmful interference, and (2) this device must accept any interference received, including interference that may cause
undesired operation.

The technical documentation as required by the Conformity Assessment procedures is kept at the following address:

Company:  Yaesu U.S.A.
Address: 6125 Phyllis Drive, Cypress, CA 90630, U.S.A.
Telephone:  (714) 827-7600

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part
15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a
residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed
and used in accordance with the instructions, may cause harmful interference to radio communications. However,
there is no guarantee that interference will not occur in a particular installation.

If this equipment does cause harmful interference to radio or television reception, which can be determined by
turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the
following measures:

O Increase the separation between the equipment and receiver.
O Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
O Consult the dealer or an experienced radio/TV technician for help.

,___________“
F S —

—_—— — — — ——— — ———— —————————————————————— — —

—_— — ——— e ——— —— — e —_— e — e — — — — — — —— —— — — — —— — — ——_——_—— —

—_—

| Changes or modifications to this device not expressly approved by YAESU MUSEN could void the user’s authori-
| zation to operate this device. ]

—_— — ——— e ——— —— — e —_— e — e — — — — — — —— —— — — — —— — — ——_——_—— —

—_—— — — — ——— — ———— ————————————————— .- ———— — —
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Appendix

EU Declaration of Conformity

We, Yaesu Musen Co. Ltd of Tokyo, Japan, hereby declare that this equipment HRI-200 is in full compliance with EU Radio
Equipment Directive 2014/53/EU. The full text of the Declaration of Conformity for this product is available to view at http://www.
yaesu.com/jp/red

ATTENTION - Condition of use
This transceiver operates on frequencies that are regulated. Use of the Transmitter in the Q

EU countries shown in the accompanying table is not permitted without authorization.
Users should consult their local spectrum management authority for licensing conditions
AT | BE | BG | CY | cZ | DE

applicable to this equipment. DK | ES | EE FI [ FR [ EL
HR | HU | IE T | LT | LU
LV | MT [ NL | PL | PT | RO
SK | Sl [ SE|CH]| IS ]
NO | - - - - -

Disposal of Electrical and Electronic Equipment

Products with the symbol (crossed-out wheeled bin) cannot be disposed of as household waste.

Electronic and Electrical Equipment should be recycled at a facility capable of handling these items and their

waste by products.

Please contact a local equipment supplier representative or service center for information about the waste collec-

tion system in your country. I

UKCA Declaration of Conformity

We, Yaesu Musen Co. Ltd of Tokyo, Japan declare our sole responsibility that this equipment complies with essential requirements
of the Radio Equipment Regulations 2017, Electrical Equipment (Safety Regulations 2016), Electromagnetic Compliance
Regulations 2016 and Restrictions of the use of Certain Hazardous Substances in Electrical and Electronic Equipment Regulations
2012 as appropriate.
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YARKSU

YN FIre rFraddio

Copyright 2023
YAESU MUSEN CO., LTD.
All rights reserved.

No portion of this manual may be

reproduced without the permission of
YAESU MUSEN CO., LTD.

YAESU MUSEN CO., LTD.

Omori Bellport Building D-3F

6-26-3 Minami-Oi, Shinagawa-ku, Tokyo, 140-0013, Japan
YAESU USA

6125 Phyllis Drive, Cypress, CA 90630, U.S.A.

YAESU UK

Unit 12, Sun Valley Business Park, Winnall Close
Winchester, Hampshire, SO23 OLB, U.K.

2304-N



	Introduction
	What is WIRES-X?
	How WIRES-X works
	Opening a WIRES-X node station
	Establishing a WIRES-X node station
	Opening and running a WIRES-X node station


	About WIRES-X Connection Kit
	Before use
	Package contents
	Option

	About This Manual

	Preparation
	Registration with the WIRES-X Server (applying to obtain an ID number)
	Installing WIRES-X Software
	Installing a USB device driver for HRI-200
	Installing WIRES-X software


	Connecting Devices
	HRI-200 interface box
	Front panel
	Rear panel

	Connecting HRI-200 to a PC
	Connecting HRI-200 to transceivers

	Preparing an Internet Environment
	Setting the PC and the router
	Why is the setting required?
	Setting an IP address on the PC
	Opening the router ports

	Taking security measures


	How to Use
	Basic Operations
	Starting the WIRES-X software
	Setting the Internet access security
	Getting the WIRES-X server certificate
	WIRES-X software main screen

	Setting the WIRES-X node information
	Configuring the transceiver settings
	Basic setting
	Volume adjustment

	Connecting using WIRES-X
	Connecting to a node on the Internet
	Connecting to a room on the Internet
	Notes on the node operation
	Useful functions

	Closing the WIRES-X software

	Advanced Operations
	Using preset search channel
	What is preset search channel?
	Setting the preset search channel
	Setting the preset search channel

	Opening a room
	What is a room (Round QSO Room)?
	Opening a room
	Setting the room
	Quitting the running of a room
	Important Room Operating Considerations
	Convenient functions

	Using the GM function
	What is the GM function?
	Before operating in the GM mode
	Starting operation as a GM node
	Opening and organizing a GM room on your station
	Quitting the GM operation

	Operating the WIRES-X software remotely
	What you can do with the remote monitor function
	Operating the WIRES-X software remotely
	Before starting remote-control operations
	Operating the WIRES-X software remotely

	Adjusting analog sound
	Adjusting analog sound volume


	Useful Functions
	Using the news function
	What is the news function?
	Organizing your news station
	Viewing news data of a node or room on the Internet
	Viewing the news data of the WIRES-X server

	Displaying a QSL card image
	Displaying QSL card images
	Transmitting the QSL card image of your station



	WIRES-X Software
	Main Screen
	Active list
	Status indicators
	User monitoring window
	Log window
	Chat window
	Function window


	Main Menu
	“File” menu
	Exporting/importing the settings
	Initializing the settings and updating the user information
	Settings for the transceiver
	Updating the active lists
	Node information settings
	Finishing the WIRES-X software

	“View” menu
	Fonts used in the active lists
	Displaying the operating instructions
	Displaying the nodes connecting to a room
	Changing the content displayed in the group window
	Setting your node
	Checking the list of nodes connecting to your room
	Changing the content displayed in the log window
	Adjusting the input/output sound volume
	Managing the news data of your station
	Checking stations that used your station

	“Connect” menu
	Transmitting a connection request to a node/room on the Internet
	Specifying the connection destination directly
	Severing the connection
	Connecting to a GM room automatically

	“Tool” menu
	Confirming the Internet connection
	Confirming the plug-in tool

	“Help” menu
	Displaying the online help
	Short-cut for the WIRES-X website
	WIRES-X software information


	Uninstalling the WIRES-X Software

	Appendix
	Differences from WiRES-II
	DTMF Commad List
	Specifications of HRI-200
	Inquiries
	EU Declaration of Conformity



